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Chapter 1: Remark Web 

Survey Overview 
Remark Web Survey is a web form design program that allows you to create web forms without needing 

to know HTML or programming. The software runs on your own PC and web server, giving you complete 

control over the creation, distribution and collection of data for your web forms. 

Using the Remark Web Survey software can be broken down into the following procedures: 

 Creating a Remark Web Survey web form from scratch, or converting a Remark Office 

OMR/Remark Classic OMR template into a Remark Web Survey web form. 

 Modifying the web form until it meets desired needs. 

 Publishing the web form on your web server. 

 Collecting the data. 

 Analyzing the data in Remark Quick Stats, or optionally exporting the data to the analysis 

package of your choice. 

Remark Web Survey Components 
The Remark Web Survey software has three components: a Designer component, a Server component and 

Remark Quick Stats, an analysis component. The Designer component is used to create the web forms, 

while the Server component is a set of CGI scripts and Perl modules used to receive web form responses 

and administer web forms. This user’s guide focuses on the Designer and Server components. Remark 

Quick Stats is covered in a separate user’s guide located in Start|Programs|Remark Web Survey 

5|Documentation. 

Designer Component Overview 
Once the Remark Web Survey Designer component is installed, you may begin creating web forms. You 

prepare the web forms in the Designer component so that they can be published on your web server. 

When creating web forms in the Designer component, we refer to the interface as the “design window.” 

The Designer component contains three areas for displaying a web form.  

Tree View 

The left side of the design window provides a tree view that displays the various parts of a web form in a 

tree structure (pages, sections, questions, images, lines). These parts of the tree are called elements. It is in 

this window where form elements are added, deleted and modified.  



 

2 

 

HTML Display 

The right side of the design window displays the web form as it appears in a web browser. As changes are 

made to the form using the tree view in the design window, the HTML Display updates to show the 

changes. 

Data Viewer 

The Data Viewer contains a spreadsheet style grid for displaying the data collected from the web form. 

You can automatically download data from your web server or open a data file from this window. Remark 

Web Survey can then analyze the data or you may export it to the analysis package of your choice. 

Server Component Overview 
A web server is a computer that is used to provide HTML files to a web browser. Remark Web Survey runs 

on your own web server, which is set up independently. Once a web form is created in the Designer 

component, the web form is published to the web server with the Gravic-supplied server CGI scripts, 

which comprise the Server component. The Server component provides a control panel where you can set 

certain attributes on your web server, such as where to store web forms, as well as view, download or 

remove data.  

Data Collection 

The data collected from web forms are saved directly on your web server in a proprietary format (.rwd). 

This data file can then be downloaded and exported to other formats within Remark Web Survey. The 

data file contains one row of data for each web form that is submitted. Each time a web form is 

completed and submitted by a respondent, a row (record) is added to the data file. The data can then be 

downloaded for the purpose of viewing and analyzing the results. When downloading data, you are given 

the option to download the entire data set, to download only the new submissions since the last 

download or to download incomplete submissions. Data on the web server can be deleted at any time in 

order to begin a new data file.  

General Information 
For clarification purposes, menu items and names of items taken directly from the software interface are 

in bold throughout the user’s guide whenever they are used in an instructional context. In addition, there 

are tips throughout the guide to assist you in with using the software. These tips are highlighted in gray. 

We encourage you to perform the tutorial that you can find under the Help icon in the software to get an 

overview of how the software works and what it can do for you. 
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What is Included with your Software 
Each purchase of Remark Web Survey includes the following: 

 One copy of the software via download (or on CD if requested) 

 The following user’s guides in PDF format, available from the Windows Start menu: 

o Remark Web Survey 5 user’s guide 

o Remark Quick Stats user’s guide  

o Remark Web Survey 5 Supported File Formats user’s guide 

 60 days of free technical support from the date of purchase  

Remark Office OMR and Remark Classic 

OMR 
One of Remark Web Survey’s unique features is its ability to work in conjunction with Remark Office OMR 

and Remark Classic OMR. These software packages are forms processing applications that transform 

information from paper-based forms into data using scanners. Remark Office OMR and Remark Classic 

OMR recognize filled in optical marks, such as bubbles and checkboxes, as well as barcodes. The software 

uses template files to obtain information about a form, including the areas of the form to be recognized 

and the output that should be obtained from that form. The completed forms are then processed with a 

scanner according to the template file. Data are collected from the forms and displayed in a spreadsheet 

style grid. Once the data are collected and reviewed for possible exceptions, the data can be exported to a 

database, survey design or statistical package, or the Remark software can be used to tabulate or grade 

the results.  

The Remark Web Survey software can convert Remark Office OMR and Remark Classic OMR templates 

into Remark Web Survey forms so that the equivalent paper-based form can be published on a website, 

allowing you to collect the same data from two sources. After the data have been collected, they can be 

combined in any Remark product and analyzed. See Appendix A for more detailed information about 

using multiple Remark products together. 
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Technical Support 
Remark Web Survey includes a user’s guide and online help. There is a knowledgebase on the Gravic 

website where you can find the answers to frequently asked questions. In addition, there is a tutorial 

available from the Help menu , which we strongly recommend you perform before using the 

software for your web forms. Most questions can be answered by consulting these reference materials.  

If a problem with Remark Web Survey arises that cannot be solved using the materials above, customers 

may contact Gravic’s technical support. 

 Note: Gravic makes support available only to registered users of the Remark Web Survey 

software who hold a valid support agreement. If you are past your 60 days of free technical 

support (starts from date of purchase), and need information about purchasing a support 

agreement, please visit our website. 

Before contacting technical support, please gather the following information: 

 The version and serial number of the Remark Web Survey software (you can find this 

information by opening a web form and then looking at the HTML Display portion of the 

window while the web form name is selected in the tree, at the bottom of the Remark Web 

Survey designer window, or in the software’s program options, accessed from the Application 

Button .  

 The steps required to reproduce the problem. 

 The type of web server on which the scripts are installed, if applicable. 

 If the issue is related to the Server component (e.g., the administration of web forms or set up 

of the Server component), access to the Remark Web Survey Control Panel (rwsad5.pl script) 

in order to view the diagnostics information provided. 

 

Gravic’s technical support team provides product support to customers with valid support agreements via 

email, phone, website and fax.  

 

 

 

 

 

 

 

http://www.gravic.com/remark/support
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Chapter 2: Installing the 

Software 
This chapter provides the necessary instructions for installing Remark Web Survey. The software consists 

of two components: the Designer component and the Server component. The Designer component runs 

on Windows XP or later (see below). It is installed on a Windows-based PC and is used to create web 

forms. The Server component is comprised of Perl scripts/modules and an html folder for collecting data 

and administering forms, which are installed on the web server. Installing the software involves the 

following steps (each step is outlined in detail in this chapter): 

1. Verify system requirements 

2. Install the Designer component 

3. Install the Server component scripts 

4. Set/verify permissions on the server scripts 

5. Set location for configuration files (optional) 

6. Test script installation 

7. Set up default form directory for storage of web forms 

8. Setup user accounts 

9. Set up server information in Designer component 

System Requirements 

Minimum System Requirements- Designer Component 
The following section outlines the minimum system configuration for running the Remark Web Survey 

Designer component. The designer portion of the software can be installed on a Windows-based PC 

meeting the following requirements.  

 Personal Computer with 2 GHz or faster processor  

 Windows 32-bit and 64-bit operating systems: Windows 10, 8.1, Windows 7 SP1, Windows 

Vista SP2 (Note: SP stands for “Service Pack”)  

 The Remark Web Survey Designer runs on a Windows Server operating system if you use it 

like a desktop system, but please note the software is not a client/server application and is 

not supported in a virtual or server-based environment  
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 Internet Explorer 8 or later (used for viewing forms as they are created in the Designer 

component)  

 Internet Explorer does not need to be your default web browser; it need only be installed and 

configured for use on the system  

 2 GB RAM  

 1 GB free fixed disk space  

 CD-ROM drive (for installation purposes if purchasing on CD)  

 Screen/monitor resolution of 1024x768 or higher and at least 32-bit color  

 Mouse or other pointing device  

 Internet connection required for automatic form publishing and data downloads  

 Microsoft Outlook 2007 or higher if you wish to use the email feature. 

 Adobe Acrobat reader to view documentation 

Minimum System Requirements- Server Component  
The following section outlines the minimum system configuration for running the Remark Web Survey 

Server component on Windows and Unix/Linux based web servers. 

 A Unix, Linux or Windows based web server capable of running Perl CGI scripts. 

 Perl 5.12 or later. (See www.perl.com or www.activestate.com for information on obtaining a 

copy of Perl).  

 A qualified website administrator with root/admin access to the web server and an 

understanding of installing Perl scripts. Because Remark Web Survey runs on your own web 

server, it is important to have a person knowledgeable about web servers available to install 

the server component. 

Installing the Designer Component  
To use Remark Web Survey, you must first install the Designer component on a fixed drive containing a 

minimum of 1 GB of free disk space. The CD-ROM or download contains the Remark Web Survey 

installation program.   

To fully take advantage of Remark Web Survey’s features, you need to have Microsoft Internet Explorer 8 

or later installed on your computer. Remark Web Survey utilizes Internet Explorer to provide an HTML 

Display window as you design web forms. This HTML Display window allows you to view your web form as 

you are creating it, just as it would appear in a web browser. If you do not currently have Microsoft 

Internet Explorer 8 or later installed, you need to install this program before installing Remark Web 

Survey. Note that respondents submitting your web forms are not limited to using Internet Explorer nor 

does it have to be your default web browser. 

 

 

http://www.perl.com/
http://www.activestate.com/
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To install the Remark Web Survey Designer component 

If you downloaded the software: 

1. Double click the file you downloaded. 

2. Follow the on-screen instructions to display the Remark Web Survey Installation window. 

 Note: The .NET 2.0 and 3.5 Frameworks are required to install Remark Web Survey. If you do 

not have them installed on your system, you are prompted to install them. Once the .NET 

Framework installations complete, the Remark Web Survey installation resumes normally. 

3. Follow the on-screen instructions to complete the installation. You are prompted for a serial 

number and authentication code. You can find this information in the email that you received 

when you purchased the software. 

4. Some operating systems may ask whether you wish to install the software for all users or only the 

person currently logged into the computer. In most cases, and especially if multiple people use 

this computer and need to use Remark Web Survey on this computer, you should choose the 

option for "all users." 

5. When the installation completes, click the Finish button to close the installation program.  

  

Please retain the download in case you need to reinstall the software in the future. Once the download 

completes, you may run the software.  

  

If you purchased the software on a CD-ROM: 

The Remark Web Survey CD-ROM contains an auto play feature so that when it is inserted into your CD-

ROM drive, the installation begins automatically. This feature is only available if your CD-ROM drive's auto 

play feature is enabled. If the software installation does not automatically start, use the following 

instructions to install the software. 

  

1. Insert the installation CD-ROM into your CD-ROM drive. 

2. Select Start on the taskbar and then click Control Panel. 

 Note: Accessing the control panel may vary slightly based on the version of Windows you are 

running. 

3. Double click Programs (or Add or Remove Programs, depending on your operating system). 

4. Click Install and then follow the on-screen instructions to display the Remark Web Survey 

Installation window. 

 Note: The .NET 2.0 and 3.5 Frameworks are required to install Remark Web Survey. If you do 

not have them installed on your system, you are prompted to install them. Once the .NET 

Framework installations complete, the Remark Web Survey installation resumes normally. 

5. Follow the on-screen instructions to complete the installation. You are prompted for a serial 

number and authentication code. You can find this information on a sticker on the CD case that 

came with your software. 
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6. Some operating systems may ask whether you wish to install the software for all users or only the 

person currently logged into the computer. In most cases, and especially if multiple people use 

this computer and need to use Remark Web Survey on this computer, you should choose the 

option for "all users." 

7. When the installation completes, click the Finish button to close the installation program.  

Once the download completes, you may run the software. 

Running Remark Web Survey  
Use the following procedures to start and exit Remark Web Survey: 

 

To start Remark Web Survey  

 If you chose to install a shortcut on your desktop during installation, double click this shortcut. 

Otherwise, select Start from the taskbar. 

 Highlight Programs, highlight Remark Web Survey 5 and then click Remark Web Survey 5 

again.  

 Note: Accessing the installed programs may vary slightly based on the version of 
Windows you are running. 

The About Remark Web Survey window displays. This informational window remains for a few seconds 

while the program loads. When complete, the Welcome window displays.  

The first time you run the software, it checks to see that the program options have been updated to 

include pertinent web server information, including the paths to the Server component scripts and email 

server. The scripts are necessary to administer web forms. Without this information, you are not able to 

successfully publish web forms or download data. We strongly recommend entering all of the web server 

information into the Designer component’s program options before beginning to create web forms. You 

need to obtain this information from the web administrator who installed the Server component. 
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Installing the Server Component 
The following files make up the Remark Web Survey Server component. The script files are written in Perl, 

which is a popular scripting language for CGI scripts. 

 

Script Name Function 

rwsad5.pl (administration script) Used to administer web forms, which includes installing 

forms, downloading data and resetting data. Also known 

as the Admin Control Panel. 

rws5.pl (data collection script) Used to collect the data each time a web form is 

submitted. 

rwstest5.pl (test script) Used to provide diagnostic information about the web 

server running Remark Web Survey. 

rwsimg5.pl (image script) Used to serve the web form’s images onto the HTML 

pages. 

rwsutils5.pm (utilities script) Contains the functions that the rwsad5.pl and rws5.pl 

scripts use. 

rwsem5.pm (encryption script) Used for encryption of passwords on password protected 

forms. 

rwsxml5.pm (XML parser) Used for parsing information. 

rwsdir5.cfg Used to change the default location of script configuration 

files that are stored on the web server. 

html Folder that resides on the web server and contains 

supporting HTML files for the Control Panel. 

 

 Warning: The rwstest5.pl script is only used for diagnostic purposes. It should not 
be installed permanently on your web server, as this poses a security risk should 
someone unintended be able to access it. Only install the rwstest5.pl script when 
troubleshooting the Server component or working with Gravic support to resolve 
support issues. Remove the file from your web server once the issues are resolved. 

During the installation of the Designer component, the Server component scripts are installed to a Scripts 

folder in the Remark Web Survey installation folder (e.g., C:\Program Files (x86)\Gravic\Remark Web 

Survey 5\Scripts). Your website administrator needs access to these scripts in order to install them to the 

web server. Because each web server is different, it is very important that someone with knowledge of your 

web server installs the Server component scripts on the web server. 

Installing the scripts involves uploading them to your web server’s CGI directory. A CGI directory is a 

standard directory on a web server that holds scripts. Scripts are used to execute commands on the web 

server. In the case of Remark Web Survey, scripts are used to administer web forms and collect data from 
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those same forms. Common names for CGI directories are cgi-bin, cgi-local and scripts. However, you are 

not limited to these naming conventions. The CGI directory should always be in a secure location on your 

web server that is not publicly accessible.  

Before installing the Remark Web Survey scripts on your web server, you need to install the Perl scripting 

language version 5.12 or later. We recommend installing the latest stable version of Perl (you often find a 

stable release version and a beta version). Note that Perl is a free download from www.perl.com or 

www.activestate.com. When installing Perl, install the entire package, including optional modules. 

Once you have set up the CGI directory on your website and installed Perl, you may continue with the 

installation of the scripts.  

The directions provided in this user’s guide apply to in-house web servers as well as hosted solutions. If 

you use an Internet Service Provider (ISP) to host your website, they must have Perl installed and 

configured, as indicated in our minimum system requirements, and you must have a CGI directory for 

placement of the Remark Web Survey scripts. You need to upload the scripts to your CGI directory. You 

may need to get your hosting company involved in order to set up the scripts properly for your web 

server’s configuration. 

 Tip: It is recommended that you perform all of the installation steps before users 
begin creating web forms. 

 Important Note: Web servers can be configured in different ways, and IIS and 
Linux/Unix change periodically. These instructions are current as of the time of the 
writing of this user’s guide. Please note that specifications may change over time. 
The instructions below should be used as a guideline, keeping in mind that your 
setup may vary slightly. 

Upgrading from Previous Versions of Remark Web 

Survey 
If you are upgrading from a previous version of Remark Web Survey, you may put the scripts in a new 

folder or in the folder with the existing scripts. The benefit of using the existing folder is that you know 

the proper permissions are set. If you use the same folder as previous versions, use caution when placing 

the scripts. Do not overwrite any existing scripts. You may need to migrate web forms over to the new 

version over time. Do not remove old scripts until you have completely migrated over all web forms to the 

new version. 

In addition, Remark Web Survey 4 and 5 use an HTML subfolder, which contains files used by the Remark 

Web Survey Control Panel. The HTML folder must reside in the same directory as the scripts. The HTML 

folders for the two versions should be separate. When Remark Web Survey 5 is installed, the scripts 

unpack to the scripts folder of the installation directory (e.g., C:\Program Files (x86)\Gravic\Remark Web 

Survey 5\Scripts) using the recommended format for the web server: html\5. We suggest maintaining the 

html\5 folder structure on the web server within the scripts/CGI directory to keep the two sets of HTML 

files separate.  

 

 Special Note: If you are already running version 5.0 or 5.1 and need to install the 
latest version, you *must* update the server scripts as well. You cannot use a newer 
designer with older scripts. You need to coordinate the Designer and Server installs 
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so that the products are in sync. You must also republish any active forms once the 
updated scripts are installed. 

Installing the Scripts on Windows Based Web Servers 

(IIS) 
IIS comes in different versions that have slight nuances. The basic instructions are provided below. To 

install the scripts on Internet Information Services, you need to first upload the scripts to the web server 

and then set up appropriate permissions so that the scripts execute correctly. These steps vary slightly 

depending on your version of IIS and are detailed in the following sections. 

 

To install the scripts on the web server 

Create the Web Server Scripts Folder  

 Create a folder to hold the Remark Web Survey scripts in the C:\Inetpub folder on the web server. 

This folder is typically called scripts. Move or copy the Remark Web Survey scripts from the 

Remark Web Survey Designer component installation folder (C:\Program Files 

(x86)\Gravic\Remark Web Survey 5\Scripts) into the C:\Inetpub\scripts folder.  

 Once this step is finished right click your scripts folder and click Properties.  

 On the Scripts Properties window select the Security Tab. Click the Edit button.  

 This opens the Permission for Scripts window (where Scripts is the name of the folder that holds 

your scripts). Click the Add button.  

 The Select Users, Computers, Service Accounts, or Groups window appears. You need to add 

the IUSR account to the list of Group/User names so that you can apply permissions correctly.  

 Change the 'From this location' text box from the name of your domain to the name of your 

computer. Click the Locations button. Select your computer name. Click OK.  

 Type IUSR into the large text area box. (This is under the text that says: Enter the object names 

to select (examples)).  

 Then click the Check Names button. IUSR becomes underlined. Click OK.  

 9. After you click OK, IUSR is an option in the Group or user names list. Click IUSR and then click 

the Edit button. This opens the Permissions for Scripts window. Give the IUSR all but full control. 

Click Apply, and OK.  
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Create the Virtual Directory in IIS  

 Close the properties, and load IIS from the 

Administrative Tools: Start Button| Control Panel | 

Administrative Tools. Select Internet Information 

Services (IIS) Manager from the window that opens.  

 Your first step is to create a Virtual Directory. In 

doing so you resolve the physical location of your 

Remark Web Survey Perl scripts (C:\InetPub\scripts) 

to a link you can browse to in a browser. Right click 

the Default Web Site, and select Add New Virtual 

Directory.  

 The Add Virtual Directory window appears. Type in 

scripts, or whatever you want to call the directory (this is typically the same name as the physical 

folder you created to house the scripts).  

 Select the location of your scripts folder. (C:\inetpub\scripts or wherever they reside.)  

 Click the ellipses (…) to select the path. Click OK. You now have created the Virtual Directory.  

 

Create the Application Pool  

 Right click Application Pools, and then select Add Application Pool.  

 Enter RWS5 Scripts for the Name and leave the 

rest of the default options. Click OK.  

 Next you need to set this application pool as the 

default for the website. Look all the way to the 

right under Browse Web Site and click Advanced 

Settings.  

 In Advanced settings the first option is 

Application Pool. Click where it says RWS5 

Scripts in bold. It opens a small window with a 

drop down; select the RWS5 Scripts (or name of 

Application Pool that you just created)  

 Click OK, and then OK again.  

 

Add the Perl CGI Extensions  

The final Step is adding Perl CGI Extensions. Note: Perl needs to be installed on the Web Server for 

this to work. Perl can be downloaded from www.perl.com or  www.activestate.com. 

 

http://www.perl.com/
http://www.activestate.com/
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 Double click the Handler Mapping icon in IIS.  

 Look to the far right side of this window and click 

Add Script Map.  

 You need to add .PL and .CGI. You then add the 

"%s" %s to the end of the path by typing it in after 

you choose the location of perl.exe. Perl is typically 

installed in C:\Perl or C:\Perl64.  

 Click the Request Restrictions button and click the 

Verbs tab in the window that opens. Select 'One of 

the following Verbs:' option button and type 

GET,HEAD,POST.  

 Click OK, and Save changes if you are prompted. You should now be able to access the Remark 

Web Survey Admin Control Panel. 

 

Test Your Setup  

 Browse out to the following in your web browser.  

http://nameofserver/scripts/rwsad5.pl  

 

The administrative script should appear, asking you to change your password. The default password is 

rws, which you should immediately change to the password of your choosing.  

If the administrative script does not appear, revisit the previous steps to ensure everything was set up 

correctly. If you cannot resolve the issue and have a support contract with Gravic, you can email us with 

the URL of your test script and we will assist with troubleshooting. After completing these steps, you 

should be able to run the Remark Web Survey scripts.  

Installing the Scripts on Unix/Linux Based Web Servers 
To install the scripts on Unix/Linux web servers, you must have root admin rights to the server. First 

upload the scripts and then set the appropriate permissions. 

 Open the rwsad5.pl, rws5.pl and rwsimg5.pl scripts in a text editor such as Notepad (one at a 

time). 

 If the location of the Perl compiler on your web server differs from the default location pre-

entered in the scripts, modify the first line of each script to point to the location of the Perl 

compiler on your web server (e.g., #!/usr/bin/perl). 

 Save and close the scripts. Do not change the file extension from .pl when saving the files. 

 Note: You may change the Perl scripts to a .cgi extension if your web server 
associates this extension with Perl instead of .pl. However, do not change any other 
part of the script name. 

 Upload the scripts and Perl modules (rwsad5.pl, rws5.pl, rwsimg5.pl, rwsem5.pm, rwsxml5.pm and 

rwsutils5.pm), and the html folder to the CGI directory on your web server in ASCII format (not 

binary). Or place the files on the web server if you have access to it internally. 
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 Note: The logo.png file in the html folder should be uploaded in Binary format if 
using an FTP program. 

 Note: The config directory, which is controlled by the rwsdir5.cfg file, must have 
permission to create and delete files. This topic is covered in detail in the next 
section.  

 Set the appropriate file permissions for the scripts. The scripts require read, write and execute 

permissions by the file owner, and read and execute permissions for both the group and world 

levels. Often you can set these permissions using an FTP program, or you can set them through 

the Unix “chmod” command (e.g., “chmod 0755 rwsad5.pl rws5.pl rwsimg5.pl”). 

 Set the appropriate user for the scripts. The scripts should be owned by the same username set 

up to execute scripts on your web server. In common setups, this is already the case, but it may 

be necessary to use the Unix “chown” command to change the file ownership (e.g., “chown userid 

rwsad5.pl rws5.pl rwsimg5.pl”). 

 Set the appropriate group for the scripts. The scripts group should be the same group name set 

up to execute scripts on your web server. In common setups, this is already the case, but it may 

be necessary to use the Unix “chgrp” command to change the file’s group (e.g., “chgrp groupid 

rwsad5.pl rws5.pl rwsimg5.pl”). 

 Note: It is the website administrator’s responsibility to secure the directory in 
which the Server component scripts are installed against unwanted access.  

Configuration Files 
The Remark Web Survey scripts store information in separate configuration files in order to ensure proper 

security. The rwsad5.pl script (administration script) writes information to a file called rwsad5.cfg. This file 

contains stored information about your admin defaults and each installed web form. In addition, the user 

information is stored in two files called rws5.cfg and rwsem5.cfg. These configuration files are stored in 

the CGI directory of your website by default. However, we recommend changing this location for 

maximum security. Keep in mind that the new config directory should be a non-public directory. Note that 

when you select a directory to use for the storage of config files, the scripts must have permission to 

create and delete files as well as read and write access to this directory.   

The location of the configuration files is stored in a file called rwsdir5.cfg. It is best to modify the 

configuration file that is located in the local Remark Web Survey installation directory and then upload it 

to your web server. 

 Tip: If you forget the password for the Administrator account, you can delete the 
rwsem5.cfg file from the scripts directory. This restores the Remark Web Survey 
Control Panel to its original installation state, allowing you to set up a new 
password for the Administrator account. Use the default password of rws when 
prompted to select a password for the Administrator account. 

 

To modify the location of the configuration files (optional) 

 Locate the rwsdir5.cfg configuration file in the Scripts folder of your Remark Web Survey Designer 

software installation directory (e.g., C:\Program Files\Gravic\Remark Web Survey 5\Scripts). 

 Open the rwsdir5.cfg file in a text editor such as Notepad. 
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 Enter the location of the directory in which you would like the configuration files stored. Be sure 

to include the trailing slash (e.g., C:\Inetpub\config\ or /web/www/config/).  

 Save the file. When saving the file, be sure to maintain its .cfg extension. 

 Upload or place the modified file in the CGI directory of your web server (the same directory in 

which the scripts are installed). 

The rwsad5.cfg and rws5.cfg files are now created in the new directory. 

Verifying the Script Installation 
Once the scripts are installed on the server, you should test 

them to make sure they are working properly. 

 

 Open a web browser and enter the location of the 

administration script as the address (e.g., 

http://www.example.com/cgi-bin/rwsad5.pl). This is the 

Remark Web Survey Control Panel. 

 The Remark Web Survey Remark Web Survey 5 

Control Panel Setup window appears. You use this 

window to set up the password for the default user, 

Administrator. Enter the default password in the 

Password box: rws.  

 Choose a new password and enter it in the New 

Password box.  

 Re-enter the new password in the Confirm Password 

box for confirmation. 

 Click the Change button to change the password.  

 You receive a message that the password was 

successfully changed, indicating that the administration script is functioning properly. Click the 

OK button to return to the login screen and then login with your new administrator account. The 

initial login is for the “administrator.” You can also create other access accounts. For the purposes 

of verifying script information, login with the user name “Administrator” and the password you set 

in Step 3 above. 

If you receive any other messages, the scripts are not installed properly. Please verify that you have set the 

proper permissions for the scripts and the CGI directory. Ensure that the scripts were uploaded to the web 

server in ASCII format and that you inserted the path to the Perl compiler in the first line of each script (for 

Unix/Linux servers only). See the next section for more information about using Remark Web Survey’s 

diagnostic test script for troubleshooting. 
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Remark Web Survey Diagnostics 
If you encounter problems when installing/running the Remark Web Survey Server scripts, you can run the 

diagnostics in the Remark Web Survey Control Panel and/or the diagnostic test script called rwstest5.pl. 

These diagnostics provide pertinent information about your web server setup, the Perl installation and the 

script information.  

 

To run the Control Panel diagnostics 

 Open the Remark Web Survey Control Panel in a 

web browser (rwsad5.pl) by entering its URL in the 

address bar of the browser. 

 Log in using the Administrator account (or another 

account with administrator privileges). 

 Select the Diagnostics tab. 

 Review the information provided about the scripts in 

the first section. Any errors/problems found are 

highlighted for you. You can also test email 

functionality using the SMTP test area toward the 

bottom of the script. If you need assistance 

interpreting the information provided, we 

recommend you contact Gravic support, providing the URL to your rwsad5.pl script along with a 

login so we can review the results. 

 

To run the Remark Web Survey test script 

 Open the Remark Web Survey Control Panel in a web browser (rwsad5.pl) by entering its URL in 

the address bar of the browser. 

 Log in using the Administrator account (or another account with administrator privileges). 

 Select the Diagnostics tab. 

 Scroll to the bottom and click the button titled Access Test Script. 

 If Perl is installed and configured correctly, the script should execute and display a wealth of 

information about your web server and the Remark Web Survey scripts. Go to the end of the 

script to locate the Problem Report. In addition, any problem areas are highlighted in red 

throughout the script. 

 Tip: An alternate way to run the test script is after installing the Remark Web 
Survey Server component, enter the URL to the rwstest5.pl script in a web browser 
(e.g., http://www.example.com/cgi-bin/rwstest5.pl). The test script (rwstest5.pl) 
must be installed with the other scripts in your CGI directory to perform this 
troubleshooting. 

 Note: If you need to contact the Gravic technical support group to troubleshoot 
Server component issues, please have the Remark Web Survey test script installed 
and be prepared to provide the URL to support personnel if it is publicly available, 
or alternatively the test script output if the URL is not publicly available. 
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Changing the Script Names 
Some web servers require scripts to have a CGI extension (.cgi) instead of Perl’s standard .pl extension. If 

this is a requirement of your web server, rename the scripts with a .cgi extension before posting them to 

your web server. Do not change any portion of the name prior to the .pl extension. 

 Caution: Do not change any files that have .pm extensions.  

Setting Up the Default Form Directory 
Every time a web form is published to the web server, a folder is placed in the Default form directory. 

This folder contains the HTML, images, multimedia files, passwords, data, log and configuration files for 

the web form. The benefit to this approach is that each web form has its own folder for storage of all files 

related to that web form. For example, if the default form directory is C:\Inetpub\forms, each time a web 

form is published, a new folder is created in the C:\Inetpub\forms folder. In this example, if a web form is 

called “satisfaction_survey” a folder called satisfaction_survey is created in the forms folder. The 

satisfaction_survey folder contains the HTML pages of the web form, any related image files, multimedia 

files, password information, configuration file, the data and log files and, as the form is submitted, the 

unique IDs of each respondent.  

You should set up the default form directory before beginning to create and administer web forms. Note 

that the data (rws5.pl) script needs to be able to write data to this directory each time a form is submitted. 

Therefore, the default form directory should be set up with permissions that allow the data script to read, 

create, write and delete information. (Note: For IIS, the data script typically runs under the Internet Guest 

Account or IUSR) 

 Caution: The Default form directory should be a non-public directory for 
optimum security. The Remark Web Survey scripts must be able to read and write 
information to and from this directory. If you do not set up a Default form 
directory, the CGI directory is used instead. 

 

To set up the Default form directory 

 Log in to the Remark Web Survey Control Panel 

(rwsad5.pl) using a web browser and an account 

with administrator privileges. 

 In the Server Setup window, in the box titled 

Default form directory, enter the path of the folder 

where you would like all web forms to be published. 

You have full control over the path you choose. It 

can be any location on your web server as long as 

the Remark Web Survey scripts can read, write, 

modify and delete files in this folder. 

 Click the Update button to save the new Default 

form directory. 

The web server is now ready to begin accepting published web forms. 
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Configuring User Accounts 
Remark Web Survey 5 allows you to set up three different Server component account types: 

 Administrator: This account has full control over the Server component (can change settings, 

publish forms, download data, view logs, view statistics, edit users, etc.). The default account 

is the Administrator account and there can only be one account named Administrator. You 

may, however, create different user accounts with administrator privileges.  

 Standard User: This account only allows the user to view Remark Live Stats and web form data 

when they login to the Remark Web Survey Control Panel (rwsad5.pl script). In addition you 

can choose whether to allow automatic form publishing and data downloading from the 

Designer component for this account. If automatic form publishing and data downloading are 

enabled, they can use these features for any web form within the Designer component. In 

addition, if automatic data downloading is enabled, the user is able to download data from 

the Control Panel. 

 Restricted User: This account only allows the user to view Remark Live Stats information and 

web form data for specific forms when they login to the Remark Web Survey Control Panel 

(rwsad5.pl script). In addition you can choose whether to allow automatic form publishing and 

data downloading from the Designer component for the specified forms for this account. If 

automatic form publishing is enabled, the user can publish any web form from the Designer 

component. If automatic data downloading is enabled, the user can only download data from 

the Designer component for the forms specified in their user account. The user can also 

download data from the Control Panel for the specified forms. Note that after a new web 

form is published, an administrator needs to add that web form to the list of available web 

forms for the restricted user. 

 

To set up a new user 

 Log in to the Remark Web Survey Control Panel (rwsad5.pl) using a web browser and an 

administrator account. 

 Select the Users tab. 

 Click the Add User button.  

 Enter the desired Username and Password for the 

new user.  

 Determine the level of permissions you want to grant 

to the user (see description above): Administrator, 

Standard User, Restricted User.  

 Once you choose a permission level, determine 

whether you want the user to be able to automatically 

publish web forms and download data from the 

Designer component. Mark the Allow automatic 

publishing from the Designer component and/or 

Allow automatic data downloading from the 
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Designer component checkboxes to grant this permission. If users do not have these 

permissions, they have to rely on another user to publish web forms and download data. 

 Click the OK button to add the new user. 

 Note: Once users are added their username becomes lower case text when you 
view it in the Control Panel. This is to create compatibility with both Windows and 
Unix/Linux web servers. When users login, the username is not case sensitive. 
However, the password is case sensitive. 

To edit a user 

 Log in to the Remark Web Survey Control Panel 

(rwsad5.pl) using a web browser and an administrator 

account. 

 Select the Users tab. 

 Select a user from the Users drop-down list. 

 Click the Edit User button. 

 [Optional] If you wish to change the user’s password, 

mark the checkbox for Change Password. Then enter 

a new password in the New Password box. 

 [Optional] If you wish to change the user’s level of 

permissions, select the appropriate level: (see description above): Administrator, Standard User, 

Restricted User. 

 [Optional] If you wish to change the user’s permissions for publishing web forms and 

downloading data from the Designer component, check or uncheck the Allow automatic 

publishing from the Designer component and/or Allow automatic data downloading from 

the Designer component checkboxes. If users do not have these permissions, they have to rely 

on another user to publish web forms and download data. 

 Click the OK button to save the changes. 

Setting up Server Information in the Designer 

Component 
Once the Server component is functional, you should enter the Admin and Data Script URLs in the 

program options of the Remark Web Survey Designer component. Once these URLs are entered, any new 

web forms that are created automatically include the proper URLs for form administration. This ensures 

proper form publishing and data downloading. If you plan to use the email functionality of the software, it 

is also recommended that you set up the email server settings in the Designer component. 

 Note: If this information is not entered into the Designer component, the first time 
the software is run, you are prompted to enter the information. Please obtain the 
relevant information from your website administrator (or the person who installed 
the scripts). 
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To enter the script URLs in the Designer Component 

 In the Remark Web Survey Designer component, select 

the Application Button and then click the Web 

Survey Options button.  

 Under Server details, enter the Admin script URL and 

the Data script URL. Both URLs must be fully qualified 

URLs. A fully qualified URL includes the http:// or https:// 

syntax (e.g., http://www.example.com/cgi-bin/rwsad5.pl).  

 

To set up email settings in the Designer Component 

In Remark Web Survey, emails can be used for three different functions: 1) the built-in email client that is 

used to send web form invitations and reminders, 2) submission notification emails that are sent every 

time a web form is completed by a respondent, or 3) session pause page reminders to resume a web form 

once it is started and stopped. You can use an SMTP server or a Sendmail server to send emails from 

Remark Web Survey. These two types of setup are simply different methods of sending email.  

 Note: The built-in email client for sending invitations and reminders only works 
with an SMTP mail server.  

If your web server is configured to use a local Sendmail server, Remark Web Survey can utilize the 

Sendmail server for sending submission emails or for sending session pause page email reminders to 

respondents who have paused a form in progress.  

Setting up and configuring email servers is independent of Remark Web Survey. Once you have 

determined the type of email method to use and verified your server is working, you can configure 

Remark Web Survey to use it. 

 Continuing from Step 2 above, click the link titled Email settings. 

 Enter the Admin email address. This email address is often the webmaster of the website, but 

can be any email address of your choosing. 

 Under Email method and settings, first select the Web 

Server tab. The Web Server settings are used to set up 

email transfers that originate on the web server, such as 

pause page reminder emails and respondent submission 

emails. 

 Choose the type of email configuration you are using: 

SMTP server or Sendmail. 

 If using SMTP, enter the SMTP server and the SMTP 

port. The SMTP port is usually 25 but may vary with your 

email server. If authentication is required, enter the 

Username and Password. 

 If using Sendmail, enter the Server path (e.g., 

/usr/sbin/sendmail). 
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 Next, configure the local email settings. Under Email method and settings, select the Local 

Machine tab. The Local Machine settings are used to set 

up email transfers that originate from the Remark Web 

Survey software, such as email invitations and reminders. 

Sendmail is not available for Local Machine settings. 

 Enter the SMTP server and the SMTP port. The SMTP 

port is usually 25 but may vary with your email server.  

 [Optional] If desired, use a secure connection by marking 

the checkbox for Enable a secured (SSL) connection. 

SSL encrypts data as it is transmitted. Your SMTP server 

must be configured to use SSL in order for this feature to 

work. 

 [Optional] If you need to use authentication, you can 

enter credentials or use those of the user. Mark the Use 

the default credentials of the currently logged in user 

checkbox to utilize the user’s credentials (e.g., the person logged in when sending the emails from 

the Remark Web Survey Designer component). Otherwise, continue to the next step to enter 

specific credentials. 

 [Optional] If authentication is required, enter the Username and Password. 

 Select the Throttle rate. The throttle rate adds a delay while sending emails. The default setting is 

500ms, meaning that one email is sent every 500 ms (in other words, two emails are sent per 

second). Throttling emails keeps the SMTP server from being overloaded when sending large 

numbers of emails. 

 Click the OK button to save the options. 

Email Server Authentication 

Remark Web Survey can interact with email servers that have authentication policies. The following 

information explains the various types of authentication supported in Remark Web Survey and the 

requirements needed. 

 Important Note: Any of these types of authentication only work with mail servers 
set up properly to support them. You must set up an SMTP server to accept the 
desired authentication before that authentication works with it. Setting up email 
servers and authentication is outside the realm of Remark Web Survey and is not 
supported by Gravic personnel. 

CRAM-MD5 

CRAM-MD5 authentication is an authentication algorithm using a challenge-based MD5 encryption. The 

mail server issues a ticket when contacted, and the relay uses the ticket to encrypt the password using an 

MD5 encryption. Then the relay encodes the username and encrypted password into a base64 

hexadecimal format.  

This form of authentication requires the Digest:MD5 Perl module and the MIME:Base64 Perl module, both 

standard in Perl 5.8 and later. 
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Login 

Login authentication is an authentication algorithm that uses base64 encoding. The mail server prompts 

for both the username and the password, and they are sent to the server encoded in a base64 

hexadecimal format. 

This form of authentication requires the MIME:Base64 Perl module, standard in Perl 5.8 and later. 

Plain 

Plain authentication is also an authentication algorithm that uses base64 encoding. The username and 

password are combined and encoded in a base64 hexadecimal format and then are sent to the mail 

server. 

This form of authentication requires the MIME:Base64 Perl module, standard in Perl 5.8 and later. 

Uninstalling the Software 
If you need to uninstall the software for any reason, use the Windows Control Panel| Programs function. 

 

To uninstall Remark Web Survey 

 Select the Start menu, click Settings and then click Control Panel. 

 Note: Accessing the control panel may vary slightly based on the version of 
Windows you are running. 

 Select the Programs option. 

 Select Remark Web Survey 5 from the list and then click Remove or Uninstall. 

 Follow the on-screen instructions to complete the software removal.  

 Note: When uninstalling the software, all program and default files are removed. 
Files that you have created remain on the system. However, it is recommended that 
you backup any forms, data files, reports, etc., that you wish to keep prior to 
uninstalling the software. 

If you wish to uninstall the Server component, you may manually remove the scripts and forms from the 

web server. Note that once web form files are removed from the server, they are permanently removed. 

 

 

 

 

 

 

 

 

 



Chapter 3: Navigating 

Remark Web Survey  

Understanding Remark Web Survey 

Windows  
The Remark Web Survey Designer 

component interface consists of a split 

window with a tree view on the left side and 

an HTML Preview on the right side. The tree 

view displays the elements of the web form 

and is used to make modifications to the 

web form. The HTML Preview window 

displays the form as it appears in a web 

browser.  

The HTML Preview panel can be toggled 

with a Data Viewer panel. The Data Viewer 

panel displays a spreadsheet style grid used 

to view and analyze the collected data. This 

chapter covers the tree view and HTML 

Preview windows; the Data Viewer tab is 

covered in Chapter 10: Collecting Data. 

The bottom of the window displays the 

Admin Control Panel Access bar. This area is 

used to login to the administration script 

(rwsad5.pl) in order to publish web forms 

and download data. 

 

 

 

 

 

 

 

HTML Preview 

Tree View 

Admin Control Panel Access 

Data Viewer 
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Using the Application Button 
The Application Button is the round button in the uppermost left hand corner of the Remark Web Survey 

designer: . It contains the Application Menu, which consists of commonly used functions in the 

software. The following functions are available by clicking the Application Button: 

 

Function Description 

New Starts a new web form. You may have multiple web forms open at one time. 

Open Opens an existing web form or data, depending on whether you are currently 

viewing the HTML Preview or Data Viewer window. 

Save Saves the active web form or data, depending on whether you are currently 

viewing the HTML Preview or Data Viewer window. If the file already exists, it is 

automatically overwritten with what you see on the screen. 

Save As Saves the active web form or data, depending on whether you are currently 

viewing the HTML Preview or Data Viewer window, by opening a Save dialog. 

You may choose a file name and a location in which to save the file. 

Print Prints the active web form. 

Publish Uploads the active web form to the web server. 

Download  Downloads the active web form’s data from the web server. 

Close  Closes the active web form or data, depending on whether you are currently 

viewing the HTML Preview or Data Viewer window. 

Using the Ribbon 
The Ribbon is the bar across the top of the Remark Web Survey designer that contains menu options. The 

Ribbon is segmented into tabs, where controls are grouped together based on functionality. Click the tab 

at the top of the Ribbon to access related functions.  

You can minimize and maximize the Ribbon by right clicking within it and then choosing the appropriate 

item. When the Ribbon is maximized (the default), meaning you can see all of the icons, choose Minimize 

the Ribbon to hide it. When the Ribbon is minimized, you only see the icons when you click a menu item. 

The icons minimize again when you perform another action. When the Ribbon is minimized, first click a 
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menu item to expand the ribbon temporarily. Then right click within the Ribbon and select Maximize the 

Ribbon. 

The following Ribbon options are available: 

 Note: The following tables contain brief descriptions of each item as it relates to 
the Ribbon. Full feature descriptions are found in subsequent chapters of this 
user’s guide. 

 

Tab Group Function Description 

Home Clipboard Paste Pastes the contents of the Windows 

clipboard after the current selection. 

  Cut Cuts the current selection to the 

Windows clipboard. 

  Copy Copies the current selection to the 

Windows clipboard. 

 Editing Delete Deletes the selected item. 

  Find Searches the active web form’s data for 

a word or phrase. 

  Replace Searches the active web form’s data for 

a word or phrase and then replaces it 

with another word or phrase. 

  Select Selects the active item. 

  Insert Grid Row Inserts a new grid row in the Data 

Viewer. 

  Delete Grid Row Deletes the selected grid row(s) in the 

Data Viewer. 

  Auto Column 

Width 

Resizes the columns in the Data Viewer 

so that they fit the text within the cells. 

This feature allows for better 

readability of the text within the data 

cells. 

 Show HTML Preview Displays the HTML Preview section of 

the window. The HTML Preview 

displays the web form as it appears in 

a web browser. 

  Data Viewer Displays the Data Viewer section of the 

window. The Data Viewer grid displays 

opened or downloaded data for each 

web form. 
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Tab Group Function Description 

 Formatting Styles Applies a style sheet to the active web 

form. Click the main style sheet button 

to apply the last selected style sheet. If 

you have multiple style sheets 

designed, click the down arrow on the 

style sheet button to choose from a list 

of style sheets. To create a new style 

sheet, click the Dialog Box Launcher in 

the right bottom corner of the 

Formatting section of the Ribbon to 

open the Style Sheet Editor. The dialog 

box launcher looks like this: . 

  Move to Next 

Column 

Moves the selected item one column 

to the right. The section must have 

multiple columns for this feature to 

take effect. This is a shortcut for 

moving elements from column to 

column. 

  Move to Previous 

Column 

Moves the selected item one column 

to the left. The section must have 

multiple columns for this feature to 

take effect. This is a shortcut for 

moving elements from column to 

column. 

Insert Divisions Page Inserts a new page on a web form. Use 

the drop-down arrow to select a page 

type. If you do not click the arrow, a 

Standard page is inserted. The page is 

inserted at the bottom of the 

expanded node in the tree view. 

  Section Inserts a section on a web form. The 

section is inserted at the bottom of the 

expanded node in the tree view. 

Sections hold all of the other elements 

on the web form (questions, answers, 

labels, buttons, multimedia, lines and 

images). 

 Visuals Label Inserts a label on the web form. A label 

is used to display user-created text. 
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Tab Group Function Description 

  Horizontal Line Inserts a horizontal line on the web 

form. 

  Image Inserts an image on the web form. 

Images can be in the JPG, GIF or PNG 

formats. 

  Multimedia Inserts video and audio files on the 

web form. Supported formats include: 

MPG, MPEG, AVI, WMV, MOV, WAV, 

MP3, RAM, RM.  

 Interaction Question Inserts a question on the web form. 

Question types include Textbox/Text 

Area, Checkbox (for multiple 

responses), Option Button (for single 

response questions) and Drop-Down 

Box (for multiple or single response 

questions). 

Click the down arrow on the Question 

button to insert a Question Table. 

Question Tables group like questions 

together in table format. 

  Answer Inserts an Answer choice on the web 

form. 

  Button Inserts a button on the web form. 

Buttons can be text or image based. 

The button types are: Submit/Next, 

Back, Reset and Session Pause. 

 

Note: Holding down the Shift key and then clicking any element to insert inserts the element before 

the currently selected element. For example, if you have two questions on your form and have the 

second question highlighted, you can hold down Shift, go to the Insert tab and choose Line and the 

line is inserted before the second question. 

 

View Show Admin Control  

Panel Access 

Displays the Admin Control Panel 

Access bar at the bottom of the 

window. This panel allows you to login 

to the web server and perform web 

server functions, such as publishing 

forms and downloading data. 



   

28 

 

Tab Group Function Description 

  Show HTML 

Layout Borders 

Mark the Show HTML Layout Borders 

option to display light gray marks in 

the HTML Viewer that represent the 

HTML table borders. As web forms are 

built, the elements are placed into 

tables behind the scenes. These 

borders are not visible in your 

published web form. Their purpose is 

to show you where elements are 

positioned on the web form. This 

feature is particularly useful if you are 

placing items in a section with multiple 

columns across the page. 

 Elements Properties Displays the properties for the active 

element. 

 Tree 

Representation 

Display Question 

Text 

Displays the questions in the tree view 

using the question text. If your 

question text is long, you may wish to 

view the elements by field name. 

  Display Field 

Name 

Displays the questions in the tree view 

using the field names. 

Web Browser Refresh Refreshes the HTML Preview panel of 

the design window so that you can see 

changes. Note that unless the Auto 

Update HTML option is not selected, 

the HTML Preview typically updates 

automatically. 

  Stop Stops the current refresh action on the 

HTML Preview panel of the design 

window. 

  Auto Update 

HTML 

When selected, the HTML Preview 

window automatically updates to 

display changes made to the web form. 

If not selected, you need to manually 

refresh the HTML window using the 

Refresh button. 
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Tab Group Function Description 

  Scroll Element into 

View 

When selected, upon clicking an 

element in the tree view, the HTML 

Preview automatically scrolls so that 

you can see the element that you have 

clicked. In addition, when clicking an 

item in the HTML Preview, the tree 

view automatically scrolls to the same 

element. Finally, double clicking an 

item in the HTML Preview scrolls to the 

element in the tree view and opens the 

properties window for that element. 

 Launch Browser Preview The software displays a list of web 

browsers you have installed on your 

system (Internet Explorer, Firefox, 

Chrome, Opera and Safari). When you 

click the Browser Preview option, your 

default browser opens with the 

currently selected page loaded. If you 

click the down arrow on the Browser 

Preview window, any other web 

browsers installed on the system are 

available. You can then instantly see 

how the web page appears to 

respondents in each web browser and 

make adjustments if necessary. Note 

that there is no script functionality in 

the browser preview, so you can only 

view one page at a time. 

  Control Panel Opens the Remark Web Survey Control 

Panel (rwsad5.pl script) in a web 

browser. The Control Panel is used to 

set up server side functionality and 

administer web forms. 
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Tab Group Function Description 

  Mobile Device 

Preview 

Allows you to preview a web form on a 

mobile device so that you can ensure 

browser compatibility. The mobile 

device must have a web browser 

capable of viewing and submitting web 

forms. You may select a device from 

the list or create a custom preview by 

clicking Custom, adjusting the size 

using the slider bars and then selecting 

Preview Device. Use this preview to 

ensure that your web form displays 

properly on the targeted device. You 

may need to adjust the width of the 

web form to accommodate mobile 

devices. Note: Most mobile browsers 

auto-size to the contents of the 

window. This preview does not taking 

auto-sizing into account. 

Tools Analysis Easy Survey Launches Remark Quick Stats, running 

an Easy Survey tabulation. 

  Survey Wizard Launches the Survey Wizard for 

customized survey tabulation. 

  Easy Grade Launches Remark Quick Stats, running 

an Easy Grade operation. 

  Grade Wizard Launches the Grade Wizard for 

customized test grading. 

 Validation Spelling Launches the Spell Checker feature, 

which allows you to proof the web 

form for spelling mistakes. 

  Database 

Connections 

When using the Database Link feature 

to connect to an external database and 

pull information, click the Database 

Connections button to ensure the 

connection is still active. The software 

reports any issues with connecting to 

any specified databases throughout 

the web form. 
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Tab Group Function Description 

  Branching Click the Branching icon to have 

Remark Web Survey validate all of the 

branch patterns on your web form. If 

errors are found, a report is provided. 

In addition, click the down arrow on 

the Branching icon to launch the 

Branch Visualizer. This window shows 

you all of the branch patterns on the 

form so that you can ensure you have 

set up your branch patterns accurately. 

 Respondents Respondent 

Detection 

Launches the Respondent Detection 

window where you can view who has 

and has not submitted your web form 

(if using a Login page). 

  Send Invitations Launches Remark Web Survey’s built-in 

email client, where you can send email 

invitations and reminders to participate 

in your web form. 

 Data Sync with 

Database 

Allows you to locate the appropriate 

database for a question that uses the 

Database Link feature. This feature is 

useful when you set up Database Link 

but then later move the linked 

database to a different location and 

Remark Web Survey can no longer link 

to it automatically. 

Quick Access Toolbar 
The Quick Access Toolbar provides easy access to features that you commonly use. You can add items to 

the toolbar to streamline use of the software. The Quick Access Toolbar is located at the top of the 

Remark Web Survey window, next to the Application Button and above the Ribbon tabs. 

 

To customize the Quick Access Toolbar 

 Click the down arrow on the Quick Access Toolbar. 

 Click Customize Quick Access Toolbar…. 

 In the Choose commands from drop-down list, select the group from which you want to add a 

command. 

 Select the desired item from the list and then click the Add button. 



   

32 

 

 When you have added all of the desired commands, click the OK button. The Quick Access 

Toolbar is now updated with your selected commands. 

Using the Tree View 
The Remark Web Survey software provides a design window for creating web forms. The web forms you 

create in the design window are broken down into elements. These elements are represented in the left 

side of the design window in a tree structure, often called a tree view. The tree view contains four basic 

collections: the form collection, the page collection, the section collection and the question collection. A 

collection is a group of items that are related. Each collection consists of its own specific elements. The 

collections can be described as follows: 

Collection Description 

Form Various page types are found in the form collection. The page types are 

divided into Standard Pages (basic web form pages) and Special Pages, 

which include login pages, web form complete pages, confirmation pages, 

session pause pages, popup info pages and server error pages.  

Page The page collection contains the section collections, which hold the 

remaining elements on the web form. 

Section The section collection contains the question collections, as well as label 

elements, line elements, multimedia and image elements. Buttons are also 

stored in sections. 

Question The question collection contains the answer elements, or the answers to 

each question on the web form. 

 

Each collection and its respective elements are represented by what is called a node. A node is a single 

form element, such as a page, section, question or answer. Each type of element is described in full detail 

in later chapters of this user’s guide.  

The design window is where you make changes to your web form. You can insert, delete, cut, copy, paste, 

drag, view, change or format elements. The elements are coded by symbols depicting the type of element: 

page, section, label, question, answer, image, multimedia or line.  

There are several sample web forms included with the Remark Web Survey software. Gravic, Inc. 

recommends that you open a sample web form before you start creating web forms so that you can 

better understand the design window. Single page forms can be opened in the Standard or Professional 

version of the software. Multi-page forms can only be opened in the Professional version of the software. 
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To open a sample form 

 If not already running, start Remark Web Survey. 

 Select the Application Button and click Open, or click . Note that Remark Web Survey 

lists any recently used forms as soon as your mouse goes over Open. 

 In the Look in list, select the Program Files (x86)\Remark Web Survey 5\Sample Forms folder 

(or choose the path in which Remark Web Survey is installed if it differs from the example above). 

 Select one of the sample files. 

 Click the Open button to open the web form. 

Beginning a New Web Form 
There are two ways to begin creating a new web form: 

 Upon starting the software, display the Welcome 

window (this option is controlled in the software 

preferences, which are accessible by selecting the 

Application button, , then Web Survey Options 

and then Show the welcome window at startup). In 

the Welcome window, mark the first option for 

Create a new web form and then click the OK 

button. Depending on your settings, Remark Web 

Survey starts up with a new web form created, ready 

for you to start adding elements or with the New Web 

Form window (see next page) . 

 If Remark Web Survey is already running, click the 

Application button, , and then click New. 

Depending on your program preferences, a new web 

form appears right away, or a New Web Form 

window appears. If the New Web Form window does 

not appear, you can skip to the next section to learn 

how to start adding elements. If the New Web Form 

window does appear, you can set up parameters for 

your web form before it is created. The following options are available: 
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Option Description 

Web form name Enter a unique name for the web form in the Web form name 

box. Names cannot include spaces or special characters: 

&,:/\?*><%|. Try to keep web form names short, as they are 

part of the URL that you send to respondents when you invite 

them to participate in your web form. 

Number of Standard pages Enter the number of Standard pages you plan to include in the 

web form. Standard pages hold the questions, images and 

other elements of your web form. Type a number in the box or 

use the arrows to move up and down sequentially. (See 

Chapter 4 for detailed information about Standard pages.) 

Include a login page Mark the Include a login page checkbox to add a Login page 

that allows you to set up password protection on the web 

form. (See Chapter 4 for detailed information about Login 

pages.) 

Include a session pause page Mark the Include a session pause page checkbox to add a 

Session Pause page that allows respondents to pause a live 

web form and resume it at a later time without losing any 

data. (See Chapter 4 for detailed information about Session 

Pause pages.) 

Include a response confirmation 

page 

Mark the Include a response confirmation page checkbox to 

add a Response Confirmation page that allows respondents to 

view or print all of their responses prior to submitting the web 

form. (See Chapter 4 for detailed information about Response 

Confirmation pages.) 

Style Use the Style drop-down list to select a style for the web form. 

Styles are set up using the Style Properties window (see 

Chapter 7 for detailed information about creating styles). 

Show this window when creating a 

new web form 

Mark the Show this window when creating a new web form 

checkbox to always have this window appear when you select 

the Application button and then choose New. If this checkbox 

is not selected, when a new web form is created, the software 

automatically creates the necessary tree view structures with 

one Standard page, one Web Form Complete page, and the 

default style, and you can then begin adding elements to the 

web form. 

 

 Note: To control whether you see the New Web Form window, select the 
Application button, click Web Survey Options and then mark the checkbox for 
Show new web form window when creating a new web form. 
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Inserting and Viewing Elements 
Each element included in the web form is visible in the tree view structure. Sections are sub-nodes of 

page nodes, questions are sub-nodes of section nodes and answers are sub-nodes of question nodes. If 

there is a white expand icon located to the left of an element, this designates that there are additional 

levels under that particular node. If there is a black collapse icon next to an element, this designates that 

the node has been expanded as far as it can go. You can click the expand icon to open (enlarge) an item 

and click the collapse icon to close (shrink) an item. 

When you want to insert an element onto your web form, go to the Insert tab in the Ribbon and then 

select the item you wish to insert. The item is inserted below the currently selected item. If you are on a 

Section node, the element is inserted at the bottom of the section. Alternatively, you may right click an 

element in the tree and choose Insert or Insert Before to insert elements. 

You may double click any node to view its properties. Alternatively, right click a node and then select 

Properties. Finally, you may highlight a node and then go to the View tab in the Ribbon and select 

Properties. 

 Note: Each element type (e.g., question, answer, image, etc.) is covered in detail in 
Chapter 5.) 

Viewing the Form 
The design window provides an HTML Preview for seeing your web form as it appears in a web browser. 

In order for the HTML Preview window to be visible, you must have Microsoft Internet Explorer 8 or later 

installed, as outlined in the minimum system requirements (see Section 2.1 for further details). As changes 

are made using the tree view, the HTML Preview updates automatically (you may also click the Refresh 

button on the Ribbon bar). If you prefer not to have the HTML Preview update automatically (e.g., if you 

are working with a very large form), you may turn it off on the Web tab in the Ribbon. 

 

To access the HTML Preview 

 With a web form open, go to the status bar, 

located in the bottom right corner of Remark 

Web Survey, which is called View Controls. 

 Click the  button, HTML Preview. 

Alternatively, go to the Ribbon and select 

Home. Click the HTML Preview Ribbon button 

. 

The data viewer window changes to the HTML 

Preview. 
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Viewing the Data 
The design window provides a Data Viewer to view opened or downloaded data. The Data Viewer displays 

the data in a spreadsheet-style grid, where each column represents a question on your web form and 

each row represents one respondent’s responses to your web form. The column headers are taken from 

the field names defined for each question when the questions are created.  

 Note: When the Data Viewer contains data you may not edit elements in the tree 
view. 

 

To access the Data Viewer 

 With a web form open, go to the bottom right 

corner of the status bar, which is called View 

Controls.  

 Click the  button, Data Viewer. 

Alternatively, go to the Ribbon and select the 

Home tab. Click the Data Viewer button, . 

The HTML Preview window changes to the Data 

Viewer. 

Tooltip Text and Descriptions 
Most windows in Remark Web Survey employ tooltip text and 

descriptions. If you hover your mouse over an item, tooltip text 

appears. Or, in some windows, look at the bottom panel of the 

window to see a description of what you have selected (e.g., the Style 

Properties window). Additionally, some textboxes include explanatory 

watermark text to show you the type of information you are expected 

to enter. Finally, use the Web Form Details pane in the design 

window to see details about active items. The Web Form Details area is 

located underneath the tree view. The Web Form Details pane also 

shows you general details about your web form, such as the link to 

take the form and a link to copy the form URL to the Windows 

clipboard (this link is useful if you want to paste the URL into an email, 

for example). When a question is selected the Web form details area 

provides pertinent property information so that you do not have to 

open the Properties window to see basic information. You can 

optionally close the Web Form Details window by clicking the double 

arrow in the upper right corner of the window. When the arrows are 



   

37 

 

pointing down, you can collapse the window. When the arrows are pointing up, you can expand the 

window. 

Admin Control Panel Access 
The Admin Control Panel Access bar is where you login to the web server to publish web forms and 

download data.  

 

If it is not visible, you can view it by either clicking the expandable splitter  at the bottom of 

the design window or by clicking the View tab in the Ribbon and checking the box titled Admin Control 

Panel Access under the Show options. 

In order to login to the administration script (rwsad5.pl), you need to have its URL entered in the web 

form’s properties. It is advisable to have this information entered into the software’s program options so 

that you do not have to keep entering it for every new web form (see Chapter 2). You also need a 

username and password for the rwsad5.pl script (also referred to as the Remark Web Survey Control 

Panel) that allows you to publish web forms and/or download data. Your webmaster or the person who 

installed the Remark Web Survey scripts should be able to provide this information to you. The Admin 

Control Panel is covered in greater contextual detail in Chapter 9. 

Printing the Form 
You may print web forms from the Designer component. Printing forms can be useful for proofreading or 

distributing to others for review prior to publishing. You can either send forms directly to a printer or print 

to a PDF file if you have a PDF print driver installed on your computer.  

 Note: If you are using Remark Web Survey in conjunction with Remark Office 
OMR/Remark Classic OMR and plan to scan paper forms in addition to publishing 
them online, printed web forms from Remark Web Survey are not suitable for 
scanning. The equivalent paper form must be created in another package (e.g., a 
word processing package). If you already have a printed version of the form and 
have created a Remark Office OMR or Remark Classic OMR template, you may 
convert the template to a web form in Remark Web Survey. 

 

To print a web form to a printer 

 If not already open, open the web form in Remark Web Survey by selecting the Application 

Button , then click Open, or click . 

 Select the Application Button and then choose Print from the menu. 

 Choose Print Active (active page only) or Print Entire Web Form. 
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 Make the necessary selections from your printer window. 

 

To print a web form to PDF 

Printing to PDF tends to produce a better layout than sending it directly to the printer, and there are 

many free PDF print drivers available. If a PDF option is listed in your Printer window, then you have a PDF 

driver installed and my print the web form to it. If you do not have a PDF option in your Printer window, 

you can click the option to Search for PDF print drivers in Remark Web Survey. 

 If not already open, open the web form in Remark Web Survey by selecting the Application 

Button , then click Open, or click . 

 Select the Application Button and then choose Print from the menu. 

 Choose Print Active (active page only) or Print Entire Web Form. 

 Choose a PDF printer from the list of available printers. If you do not have a PDF printer listed, 

return to the previous step and choose Search for PDF print drivers. This action performs a 

Google search for PDF print drivers in your default web browser. You may then choose a driver to 

install. Once the driver is installed, you can return to this step and choose the PDF option as your 

printer. 

 Click the OK button to save the document as a PDF file. 

Open your PDF application and print the form (note that some PDF applications open 

automatically when the file is saved). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 4: Remark Web 

Survey Form Elements 

Overview 
When you design a web form in Remark Web Survey, you start at the form level, add pages, add sections 

and then add elements, such as questions, answers, labels, images, multimedia and lines.  

The highest level of a Remark Web Survey web form is the web form level. This level is called the form 

collection. The form collection consists of several properties related to the overall web form as well as all 

of the pages on the web form. 

Web Form Properties 
At the web form level, there are many properties that can be set that pertain to how the overall web form 

functions. Many features are optional, but allow you to customize the functionality of your web form. 

The web form properties can be accessed in any one of three ways: 

 Double click the node that reads Web Form – Form Name. 

 Right click the node that reads Web Form – Form Name and choose Properties from the 

menu. 

 Click the node that reads Web Form – Form Name and choose Properties from the View 

tab in the Ribbon. 

The web form properties are outlined in the following table: 

 

Tab Heading Name Description 

General Basic Settings Web form 

name 

A name for the web form. Names cannot 

include spaces or special characters: 

&,:/\?*><%|@. Try to keep web form names 

short, as they are part of the URL that you 

send to respondents when you invite them to 

participate in your web form. 
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Tab Heading Name Description 

  Admin script 

URL 

The URL (path) to the Remark Web Survey 

Administration Script (rwsad5.pl). This script is 

posted on the web server and is necessary for 

web form administration. Your webmaster or 

the person who installed the scripts should be 

able to provide this URL to you. This script is 

also referred to as the Control Panel when it is 

accessed in a web browser. The Admin script 

URL must be a fully qualified URL (e.g., 

http://www.example.com/cgi-bin/rwsad5.pl). 

  Data script 

URL 

The URL (path) to the Remark Web Survey 

Data Script (rws5.pl). This script is posted on 

the web server and is necessary for web form 

data collection. Your webmaster or the person 

who installed the scripts should be able to 

provide this URL to you. The Data script URL 

must be a fully qualified URL (e.g., 

http://www.example.com/cgi-bin/rws5.pl). 

  Data file name A name for the data file that is stored on the 

web server for a web form. Note that the data 

files for each web form are stored in separate 

folders for every published web form. 

Therefore, customizing the file name is 

optional. The default data file name is 

MyData. 

  Log file name A name for the log file that is stored on the 

web server for a web form. Log files track 

respondent information, such as time and 

date of web form submission, IP address, 

login information, etc. Note that the log files 

for each web form are stored in separate 

folders for every published web form. 

Therefore, customizing the file name is 

optional. The default log file name is MyLog. 
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Tab Heading Name Description 

 HTML Display HTML display 

language 

The language in which the HTML is displayed 

on your published web forms. The language 

selected here is specified in the HTML source 

code of web forms that you create (this is 

called a “lang” tag in HTML). Please note that 

whether the language’s characters display 

correctly is dependent upon the character set 

specified on the respondents’ computer. 

  Display 

progress 

indicators on 

pages  

When selected, a progress indicator appears 

on each page of the web form to show 

respondents how much of the web form they 

have completed at any given time. Note that 

progress indicators cannot be used when you 

are using the page randomization feature.  

  Progress 

indicator 

settings 

The Progress indicator settings link allows 

you to customize the look and positioning of 

the progress indicator. 

  Display 

progress 

caption 

Displays a caption for the progress indicator 

(e.g., “50% complete”). 

 Progress 

indicator 

settings 

window 

Horizontal 

alignment 

Displays the progress indicator on each page 

in left, center or right alignment. 

  Vertical 

alignment 

Displays the progress bar at the bottom or 

top of each web form page. 

  Progress 

forecolor 

Select a color for the forecolor (front) of the 

progress indicator. 

  Progress 

backcolor 

Select a color for the backcolor (background) 

of the progress indicator. 

 Submission 

notifications 

Send email 

notifications 

on respondent 

submissions 

Mark the Send email notifications on 

respondent submissions checkbox to set up 

email notifications every time the web form is 

submitted on the website. The recipient(s) 

listed receive an email message containing the 

responses for each web form submission. 
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Tab Heading Name Description 

  Email settings Click the Email settings link to enter email 

settings for web form submission 

notifications. 

 Email settings 

window 

Admin email 

address 

Enter the web form administrator email 

address (e.g., webmaster@example.com). This 

email address is listed as a point of contact if 

a respondent receives an error when filling in 

your web form. 

  Recipient 

addresses 

Respondent submissions are sent to the email 

addresses entered in Recipient addresses. 

Separate multiple email addresses with a semi 

colon (;). 

  Advanced 

Notification 

Criteria 

Click the Advanced Notification Criteria link 

to set up email alerts based on how specific 

questions are answered.  

 Web Server  Use SMTP 

method to 

transport 

email 

messages 

The Web Server settings are used to set up 

email transfers that originate on the web 

server, such as pause page reminder emails 

and respondent submission emails. Mark the 

Use SMTP method to transport email 

messages option to use Simple Mail 

Transport Protocol (SMTP) for sending 

notification emails. You need to have a valid 

SMTP server set up outside of Remark Web 

Survey. Once the SMTP server is functioning, 

the SMTP server information can be set up in 

the Remark Web Survey program options by 

your website administrator (see Chapter 2 for 

further details). Please note that your website 

administrator can advise you on what email 

method you are to use. 

  SMTP Server Enter the SMTP server address (e.g., 

mail.example.com). 

  SMTP Port Enter the SMTP port that email transfers use 

(typically port 25). 

  Username If using authentication, enter a valid 

username. 
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Tab Heading Name Description 

  Password If using authentication, enter a valid password 

for the username specified. 

  Use Sendmail 

method to 

transfer email 

messages 

Mark the Use Sendmail method to transfer 

email messages option to use Sendmail for 

sending notification emails. Sendmail is an 

open source email transfer agent. You need to 

have Sendmail set up outside of Remark Web 

Survey to use this feature. Once the Sendmail 

functionality is working, the Sendmail 

information can be set up in the Remark Web 

Survey program options by your website 

administrator (see Chapter 2 for further 

details). Please note that your website 

administrator can advise you on what email 

method you are to use. 

  Server path Enter the Sendmail Server path (e.g., 

/usr/sbin/sendmail).  

 Local 

Machine 

Use SMTP 

method to 

transport 

email 

messages 

The Local Machine settings are used to set up 

email transfers that originate from the Remark 

Web Survey software, including email 

invitations and reminders. Sendmail is not 

available for Local Machine settings. Mark the 

Use SMTP method to transport email 

messages option to use Simple Mail 

Transport Protocol (SMTP) for sending 

notification emails. You need to have a valid 

SMTP server set up outside of Remark Web 

Survey. Once the SMTP server is functioning, 

the SMTP server information can be set up in 

the Remark Web Survey program options by 

your website administrator (see Chapter 2 for 

further details). Please note that your website 

administrator can advise you on what email 

method you are to use and the proper 

settings. 

  SMTP Server Enter the SMTP server address (e.g., 

mail.example.com). 

  SMTP Port Enter the SMTP port that email transfers use 

(typically port 25). 
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Tab Heading Name Description 

  Enable a 

secured (SSL) 

connection 

Mark the Enable a secured (SSL) connection 

checkbox to transmit information over Secure 

Sockets Layer (SSL), which provides security 

and data integrity for communications. 

  Use the 

default 

credentials of 

the currently 

logged in user 

If you need to use authentication, you can 

enter credentials or use those of the user. 

Mark the Use the default credentials of the 

currently logged in user checkbox to utilize 

the user’s credentials (e.g., the person logged 

in when sending the emails from the Remark 

Web Survey Designer component). Otherwise, 

continue below to enter specific credentials. 

  Username If using authentication, enter a valid 

Username. 

  Password If using authentication, enter a valid Password 

for the username specified. 

  Throttle Rate The Throttle rate adds a delay while sending 

emails. The default setting is 500ms, meaning 

that one email is sent every 500 ms (in other 

words, two emails are sent per second). 

Throttling emails keeps the SMTP server from 

being overloaded when sending large 

numbers of emails. 

  Timeout This setting allows you to control how long to 

keep the SMTP session open. You should use 

the default setting (300,000 milliseconds) 

unless you receive a timeout error when 

sending emails from within Remark Web 

Survey. 

  Synchronize 

Settings 

Synchronizes the local server settings with 

what was defined for local server settings in 

the Remark Web Survey program options. The 

program settings override the web form 

settings. This is a quick way to pull down the 

settings from the program options. 
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Tab Heading Name Description 

Access & 

Availability 

Session 

timeouts and 

web form 

availability 

Enforce 

session 

timeouts for 

password 

protected web 

forms when 

idle for 

Use the Enforce session timeouts for 

password protected web forms when idle 

for option to enforce a timeout when a 

respondent is inactive for a specified period of 

time. Enter the time in the drop-down list. This 

feature only applies to password-protected 

forms (those using Login pages). After the 

specified time elapses with no activity, the 

respondent is prompted to login to the web 

form again in order to continue filling out the 

web form.  

   Specify the 

web form’s 

availability 

window 

(access time 

frame) 

Use the Specify the web form’s availability 

window (access time frame) option to 

specify the dates and times when the web 

form is active. If respondents attempt to 

access the web form outside of the specified 

time period, they receive an appropriate error 

message.  

  Start time Enter the date and time when the web form 

becomes active. 

  End time Enter the date and time when the web form 

becomes inactive. Respondents are not able 

to access the web form after this date and 

time. 

 Respondent 

settings 

Limit the 

accepted 

number of 

respondent 

submissions to 

Set a maximum number of responses allowed 

for a web form. Once the maximum is 

reached, respondents are no longer able to 

access the web form and receive an 

appropriate error message.  

  Remove 

respondent’s 

incomplete 

data from 

server after 

Specify the number of hours or days that you 

are allowed before incomplete web form 

submissions are removed from the server. An 

incomplete web form submission could be 

due to someone starting the web form and 

never completing it or someone pausing the 

web form and not returning to complete it.  
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Tab Heading Name Description 

  Base interval 

value on the 

number of 

hours that 

incomplete 

data resides 

on the server 

Mark the Base interval value on the number 

of hours that incomplete data resides on 

the server option to use hours as the 

measure for removing incomplete web form 

submissions. 

  Base interval 

value on the 

number of 

days that 

incomplete 

data resides 

on the server 

Mark the Base interval value on the number 

of days that incomplete data resides on the 

server option to use days as the measure for 

removing incomplete web form submissions. 

Additional Data Display and 

tabulation 

settings 

Display date 

submitted 

with field 

name 

Mark the Display date submitted with field 

name option to include the submission date 

when downloading data. You may accept the 

default field name of Date or enter your own. 

If you wish to include this information in your 

analysis, mark the Tabulate checkbox. 

  Display time 

submitted 

with field 

name 

Mark the Display time submitted with field 

name option to include the submission time 

when downloading data. You may accept the 

default field name of Time or enter your own. 

If you wish to include this information in your 

analysis, mark the Tabulate checkbox. 

  Display 

respondent’s 

IP address 

with field 

name 

Mark the Display respondent’s IP address 

with field name option to include the 

respondent’s IP address when downloading 

data. You may accept the default field name 

of IP Address or enter your own. If you wish to 

include this information in your analysis, mark 

the Tabulate checkbox. 
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Tab Heading Name Description 

  Display 

respondent’s 

UID with field 

name 

Mark the Display respondent’s UID with 

field name option to include the respondent’s 

UID when downloading data. The UID (unique 

identifier) is used by Remark Web Survey to 

track respondents’ submissions (e.g., so that 

they may pause and resume the web form). 

You may accept the default field name of 

Respondent ID or enter your own. If you wish 

to include this information in your analysis, 

mark the Tabulate checkbox. 

  Display web 

form duration 

with field 

name 

Mark the Display web form duration with 

field name option to include the length of 

time it took each respondent to complete the 

entire web form. Please note that this time is 

from first login to completion. It does not 

remove any time in which the survey was 

paused. You may accept the default field 

name of Duration or enter your own. If you 

wish to include this information in your 

analysis, mark the Tabulate checkbox. A 

report detailing the number of submissions in 

a particular time interval is available in Remark 

Live Stats in the Remark Web Survey Control 

Panel (see Chapter 11). 

  Track the 

respondent’s 

IP address 

By default, Remark Web Survey logs each 

respondent’s IP address in the server log. 

Once logged, you have the option to display it 

in the data grid. If you do not wish to track 

the respondent’s IP address, turn off the Track 

respondent’s IP address checkbox. This 

allows for complete survey anonymity.  
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Advanced Notification Criteria 
The Advanced Notification Criteria feature has two primary purposes: 

1. To allow you to generate an email to a recipient based on how a question is answered. 

2. To allow respondents to have their web form responses emailed directly to them. 

Allowing responses to specific questions or sets of questions to be emailed directly to specific 

respondents allows instant notification of important information. Please note that this feature can work in 

one of two ways:  

1. Web Form Level. The specified notifications only happens once the entire web form is submitted. 

Responses can be changed and the notification is not triggered until the entire web form has 

been completed.  

2. Page Level. If someone answers the question as identified in the notification, when the 

respondent submits the page, the email notification is sent to the appropriate email address. If 

the respondent clicks the back button or at some other point revisits this question and changes it, 

the email recipient does not know this fact. The notification may be triggered again (depending 

on whether the criteria was met for the notification). 

 Note: Advanced notifications rely on an external email server. There are two places 
to set up details about your email server: Web Server and Local Server. Advanced 
Notification emails use the email properties for the Web Server.  

 

To use Advanced Notifications to send emails based on how questions are answered 

 To set up Advanced Notifications at the Web Form Level, double click the top node in the tree 

view (Web Form – YourFormName), click Email settings and then click Advanced Notification 

Criteria. To set up Advanced Notifications at the page level, double click any Standard page in 

the tree view and then click the Advanced Notification Criteria link to view the Notification 

Criteria Builder window. 

 Tip: Setting up Advanced Notification Criteria is very similar to setting up Question 
Branching. You may wish to read Chapter 8, which describes Question Branching in 
detail. 

The Notification Criteria Builder window consists of the following properties: 

 

Property Description 

Text Click the Text button to display the question text for each 

question on the web form instead of field names (applies to the 

Question column of the branching grid). This setting depends on 

your personal preference as to how you would like the questions 

displayed when selecting them from the Question drop-down list. 

If this setting is not selected, the questions are listed by field 

name in the Question drop-down list. 
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Property Description 

Field Name Click the Field Name button to display the field name for each 

question on the web form instead of question text (applies to the 

Question column of the branching grid). This setting depends on 

your personal preference as to how you would like the questions 

displayed when selecting them from the Question drop-down list. 

If this setting is not selected, the questions are listed by question 

text in the Question drop-down list.  

Insert Statement Click the Insert Statement button to insert a new statement 

within the email notification grid. This feature is useful if you need 

to place a statement within other statements that you have 

already defined. Select an insertion point by clicking in a row first 

and when you click Insert Statement, the grid adds a row above 

your current selection point. It initially inserts the row as part of 

the selected statement. The Rule Numbers for the statements 

update themselves automatically as you begin to enter the 

criteria for the statement. You only need to use the Insert 

Statement function to add statements between other statements. 

If you are simply building a notification pattern from start to 

finish, use the rows of the email notification grid in sequence on 

the screen. 

Delete Statement Click the Delete Statement button to remove a statement within 

the email notification grid. Select an insertion point by clicking in 

a row first and when you click Delete Statement, the grid 

removes the selected statement(s). 

Group Statements Use the Group Statement option to group parts of the email 

notification pattern together. This feature is useful when setting 

up multiple criteria and notifications on one page. It allows you to 

further customize the criteria that determine the notification by 

grouping like statements together into one action. 

Ungroup Statements Use the Ungroup Statements option to ungroup parts of the 

notification criteria. Ungrouping statements can be accomplished 

once you have grouped statements, as described above. You can 

use the ungroup option to make changes. 

Question Displays the questions on the entire form. Use the Question list 

to select a question on which to base the email notification. How 

this question is answered triggers the email notification. 
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Property Description 

 Operator Displays the available operators for the notification, which include 

= (equal to), <> (not equal to), > (greater than), < (less than), >= 

(greater than or equal to) and <= (less than or equal to). Select 

the item to which your notification applies.  

Response Displays the response choices from the selected question. Select 

the Response choice that triggers the email notification or enter 

the appropriate text for a textbox/text area question. For 

example, if your choices are Strongly Agree, Agree, Disagree and 

Strongly Disagree, and choosing Strongly Disagree triggers the 

email notification, choose Strongly Disagree from this list. Or, if it 

is a textbox style question, enter the text exactly as you expect 

your respondents to enter text in order to trigger the next action. 

Action Allows you to select the next action. Use Email to set up the 

email notification when the particular response choice is selected. 

You enter the email address in the Recipient box (see below). Use 

And to continue to set up notification patterns whereby the next 

pattern in the sequence must also be true in order to trigger the 

notification. Use Or to continue to set up branch patterns 

whereby the next pattern in the sequence may also be true in 

order to trigger the notification. 

Recipient(s) Enter the email address to which you want the notification sent 

when the criteria specified is met. You may enter multiple email 

addresses separated by a semi-colon (;).  

Reset Resets the current notification pattern, allowing you to start over. 

Note that all statements are removed when you click the Reset 

button. 

 

Notice that there is a Criteria translation box below the notification setup area that displays your 

notification patterns as you build them. You cannot edit the text in this window, but you may use it to 

double check your logic when setting up your notifications.  

 If desired, select whether to view the questions 

in the Questions column of the notification grid 

by Text (question text) or Field Name.  

 In the Questions column, select the first 

question on which to base the notification. 

 

 Note: You may resize the columns in 
this grid as you see fit. 
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 In the Operator column, select the appropriate operator for the branch pattern (e.g., Q1 = Yes or 

Q1 <= 5). 

 In the Response column, select or enter the question’s response on which to base the email 

notification. 

 In the Action column, select the next action. If you want to add more parameters to the 

notification, select And or Or, depending on whether the next criterion must be true (AND) or can 

be true (OR) in addition to the previous criterion. If you have completed the setup and are ready 

to specify the recipient’s email address, select Email. 

 If you have selected Email in the Action column, enter the appropriate email address or 

addresses. If using multiple email addresses, separate each one with a semi-colon (;). If you have 

selected And or Or in the Action column, leave the Target column blank.  

 If you have completed setup of the notification by entering the email addresses, click the OK 

button to save your changes. If you need to add more statements, continue to Step 10. 

 [Optional] Continue to add notification statements as needed. Notice that based on the operators 

used and other criteria, the row headers in the grid update with Rule numbers. The Rule numbers 

provide you with a quick way to see patterns in your notification criteria. 

 [Optional] If desired, use the Group Statements and Ungroup Statements buttons to refine the 

notification patterns. For example, if two parts of the pattern belong together, you may select 

them in the grid and then click the Group Statements button. Click and drag the row headers to 

select items to group together. When statements are grouped, Remark Web Survey evaluates 

them together before going on to the next notification sequence. 

 Click the OK button to save your changes. 

 When the web form is published and respondents begin entering answers to the questions that 

are part of the notification setup, the emails are generated to the appropriate recipients based on 

how the questions are answered. 

 

To use Advanced Notifications to send emails to a respondent 

 Create a question on the form where respondents can type in their email address. 

 To set up Advanced Notifications at the Web Form Level, double click the top node in the tree 

view (Web Form – YourFormName), click Email settings and then click Advanced Notification 

Criteria. To set up Advanced Notifications at the page level, double click any Standard page in 

the tree view and then click the Advanced Notification Criteria link to view the Notification 

Criteria Builder window. 

 Tip: Setting up Advanced Notification Criteria is very similar to setting up Question 
Branching. You may wish to read Chapter 8, which describes Question Branching in 
detail. 

The Advanced Notification Criteria window appears.  
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 Locate the line that reads Email responses to 

the addresses supplied in question at the 

bottom of the window. 

 Use the drop-down list to select the question 

that you set up in Step 1 above. This is the 

question in which respondents type their email 

address so that they can receive an email 

containing all of their responses. 

 Click the OK button to save your changes. 

 

Once the web form is published, respondents are able to enter an email address (or multiple 

addresses separated by a semi-colon (;)) and have all of their responses emailed to them once they 

submit the entire web form or a single page’s responses if you have set up the notification on a page 

by page basis. 

Access & Availability Settings 
The Access & Availability settings were mentioned in the general table of web form level properties but 

are worthy of further discussion. The Access & Availability tab of the web form properties window allows 

you to control web form availability and respondent limitations. The following sets of instructions cover 

the features in the Access & Availability window. 

 

To enforce session timeouts 

When using a password protected web form, you can enforce a session timeout, whereby the web form is 

no longer available without reentering a valid password after a certain amount of idle time. The default 

idle time is ten minutes, but you may adjust this as you see fit. If respondents are inactive for the idle time, 

when they try to submit the current page, they are required to log in again. Any previously submitted data 

is reloaded. 

 Access the web form properties. 

 Click the Access & Availability tab. 

 Mark the checkbox for Enforce session timeouts for 

password protected web forms when idle for. 

 Set an idle time in the drop-down box. This time is in 

minutes. 

 Click the OK button to save the changes. 

 

To specify an availability window  

1. Each web form you publish can have an availability 

window, which is the time when the web form is active. Once the availability window expires, the 

web form is no longer accessible to respondents. If respondents attempt to access the web form 

outside of the specified time period, they receive an appropriate error message. If the web form 

availability window expires while a respondent is submitting responses or has the web form 
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paused, they are not be able to submit the web form. We suggest that you inform respondents 

that the entire web form must be completed within the specified timeframe. Note that incomplete 

submissions are still available for download when downloading data. 

 Access the web form properties. 

 Click the Access & Availability tab. 

 Mark the checkbox for Specify the web form’s 

availability window. 

 Enter a Start time and an End time. Use the drop-

down arrow to view a calendar where you can 

select a date. You can type the time in the 

appropriate location. This time is in minutes. 

 Click the OK button to save the changes. 

 

To limit the number of respondents  

 You may limit the number of respondents who can submit a web form. Once the designated 

number of successful submissions is reached, the web form is no longer accessible to respondents 

and they receive an appropriate error message. 

 Access the web form properties. 

 Click the Access & Availability tab. 

 Mark the checkbox for Limit the accepted number 

of respondent submissions to. 

 Enter the number of accepted submissions in the box. 

You can either type a number or use the up and down 

arrows to select a number. 

 Click the OK button to save the changes. 

 

To remove incomplete data 

 You may remove incomplete web form submissions (data) after a certain amount of time. As 

respondents submit pages of a web form, data is stored in the respondents’ UID file on the web 

server, which is a small text file. Once the entire web form is submitted, the UID file is 

automatically removed from the web server. An incomplete submission typically comes from a 

respondent who either starts a web form but never completes it, or who pauses the web form 

after submitting a portion of the data but never returns to complete the web form. Be cautious 

when removing incomplete submissions; once they are removed, the data is permanently deleted. 

If you allow respondents to pause the web form, be sure to advise them of how long they have to 

come back and complete the web form before their data is lost. The scripts check for incomplete 

submissions to remove whenever interaction with the data script (rws5.pl) and web form occurs. 
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 Note: Remark Web Survey is capable of downloading incomplete data 
submissions. If you remove incomplete data from the web server, you are not able 
to use this feature. 

 Access the web form properties. 

 Click the Access & Availability tab. 

 Mark the checkbox for Remove respondent’s 

incomplete data from server after. 

 Enter the number of days or hours in the box. You 

can either type a number or use the up and down 

arrows to select a number. 

 Choose whether the number you entered in Step 4 

is days or hours by selecting the appropriate radio 

button: Hours: Base interval value on the number 

of hours that incomplete data resides on the server, 

or Days: Base interval value on the number of days 

that incomplete data resides on the server. 

 Click the OK button to save the changes. 

Web Form Pages 
Remark Web Survey allows you to create seven types of web form pages (form elements) when designing 

a web form.  

 

Name Description 

Standard Page Web form page containing sections, which in turn contain elements, such as 

questions, answers, images, multimedia and labels. At least one Standard 

page is required per web form. Standard pages are those pages that allow 

you to ask questions of your respondents. 

Popup Info Page Web form popup page containing static information that needs to be 

presented to the respondent. This page does not have questions on it to be 

submitted by the respondent; it is for informational purposes only. You can 

set up a label hyperlink to a Popup Info page. Popup Info pages are 

optional. 

Login Page Web form page containing an area for respondents to enter a password to 

access and submit the form. Login pages are optional. 
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Name Description 

Web Form Complete 

Page 

Success page that is displayed when the respondent submits the web form 

(e.g., a thank you page). At least one Web Form Complete page is required 

per web form (you can have more than one and use question branching to 

direct respondents to different Web Form Complete pages). You can build 

the Web Form Complete page in Remark Web Survey or point it to an 

existing page on your website. 

Response Confirmation 

Page 

Web form page displaying all of the submitter’s (respondent’s) responses to 

each question. Responses can be changed by clicking the desired question. 

This page can be printed so that the respondent has a copy of his or her 

responses. Response Confirmation pages are optional.  

Session Pause Page Web form page that allows respondents to pause the web form so that they 

may complete it at another time. Respondents can enter an email address 

and an email reminder is sent, providing a link to go back to the web form. 

Session Pause pages are optional.  

Server Error Page Web form page that returns customized error messages to respondents 

when a server side problem arises (e.g., the password entered is invalid). 

Server Error pages are optional. If not used, Remark Web Survey utilizes 

default error messages that are built into the software when errors occur. 

 

Pages are grouped into two containers in the tree view: Standard Pages and Special Pages. The Standard 

Pages container holds only standard pages. The Special Pages container holds the remaining pages. These 

groupings make it easier to navigate the tree view. 

The following sections describe the properties of the page types in detail.  

Standard Pages 
Standard pages are the basic pages of a web form. They hold the sections of questions being asked, along 

with images, lines, multimedia and labels, if desired. Standard pages are the most common type of page 

found in a web form. You must have at least one Standard page in any web form. The following table lists 

the properties of Standard pages: 

 

Section Property Description 

Basic settings Title Enter the title that appears on the title bar when 

displayed in a web browser. 

Header and Footer Display the web 

form header on the 

page 

Mark the Display the web form header on the page 

checkbox to display the header you have defined on the 

selected web page(s). Headers are created 

independently of pages and can be applied to any page. 
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Section Property Description 

 Display the web 

form footer on the 

page 

Mark the Display the web form footer on the page 

checkbox to display the footer you have defined on the 

selected web page(s). Footers are created independently 

of pages and can be applied to any page. 

 Branching setup  Sets up branches on the page so that if a specific 

response is selected, the respondent is directed to 

another page (also known as skip patterns). See Chapter 

8 for a complete description of branching. 

 Advanced 

Notification Criteria  

Click the Advanced Email Notifications link to set up 

email alerts based on how specific questions are 

answered.  

Format Format Use the Format button to format the style of the web 

page. Formatting is covered in detail in Chapter 7. 

 

To insert a standard page in a web form 

 From the Ribbon, select the Insert tab and then 

click Page. (Note you may also insert pages by 

right clicking the tree view and then clicking 

Insert or Insert Before.) 

 Enter settings as desired, as described 

previously.  

 Click the OK button. The Standard page is 

added to the Standard Pages container 

automatically. You may now start adding 

sections (optional) and other elements to the 

web form. 

 Tip: When you want to change properties for all Standard pages at one time, you 
may select the entire Standard Pages container and then adjust the properties (e.g., 
right click the Standard Pages container node and then click Properties). This 
action changes applicable settings for all Standard pages. 

Popup Info Pages 
A Popup Info page contains static information that you want to present to your respondents. It appears in 

a separate window, often referred to as a popup window. The respondents’ browser typically controls the 

size of this window. You may place information on this page that is necessary for your respondents to 

read in order to properly fill in your form. For example, if you were conducting a survey on a specific 

product, you could use a Popup Info page to show an image of the product along with a description. The 

respondents could use this information to answer questions about the product.  
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Utilizing Popup Info pages is a two-step process. First you have to create the Popup Info page containing 

the static information you want respondents to see. Once you have created a Popup Info page, you can 

link to it by adding a label to the web form. In the label properties window, mark the option for Hyperlink 

and then choose the desired Popup Info page from the drop-down list. When respondents click the label, 

they see the Popup Info page. 

The following table lists the properties of Popup Info pages: 

 

Section Property Description 

Basic settings Title Enter the title that appears on the title bar when 

displayed in a web browser. 

Header and Footer Display the web 

form header on the 

page 

Mark the Display the web form header on the page 

checkbox to display the header you have defined on the 

selected web page(s). Headers are created 

independently of pages and can be applied to any page. 

 Display the web 

form footer on the 

page 

Mark the Display the web form footer on the page 

checkbox to display the footer you have defined on the 

selected web page(s). Footers are created independently 

of pages and can be applied to any page. 

Browser 

redirection 

Redirect browser to Mark the Redirect browser to checkbox to use an 

existing web page as your Popup Info page. The 

respondents’ web browser displays this page when the 

Popup Info page is launched. (Optional) 

Format Format Use the Format button to format the style of the web 

page. Formatting is covered in detail in Chapter 7. 

 

 

 

To insert a Popup Info page in a web form 

 From the Ribbon, select the Insert tab, then 

click the down arrow on Page to reveal a list of 

special pages. (Note you may also insert pages 

by right clicking the tree view and then clicking 

Insert or Insert Before.)  

 Select Popup Info. 

 Enter settings as desired, as described 

previously. 

 Click the OK button. The Popup Info page is 

added to the Special Pages container 

automatically.  
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 Add a label on a different web form page (where you want to link to your Popup Info page), mark 

the checkbox for Hyperlink in the Label Properties window and then choose the Popup Info 

page as your hyperlink. 

Response Confirmation Pages  
Response Confirmation pages provide respondents with a listing of all of their answers to the questions 

on the web form. The Response Confirmation page appears as the last page of the web form (prior to the 

Web Form Complete page) so that respondents can review the information and then go back and make 

changes if desired (a back button is provided by default on the Response Confirmation page for this 

purpose). Respondents can also click a link next to each question on the Response Confirmation page to 

go to that question in the web form and adjust their response. The Response Confirmation page can also 

be printed (using the web browser’s print options) so that respondents have a record of their responses.  

When respondents navigate to the Response Confirmation page of the web form, they see each question 

listed and then beneath the question, the answer choice they selected. The HTML Display portion of the 

answer choice is displayed to the respondent. There is also a Change Response link next to the question 

that the respondent can click to go directly to the desired question in the web form. Note that if your web 

form utilizes complex branching, respondents may have to navigate through multiple web form pages 

before returning to the Response Confirmation page (depending on the answer they choose). 

When building Response Confirmation pages, you may not add additional questions and answers, but you 

may add other elements to the page such as lines, labels, images and multimedia. You may wish to add a 

label explaining to respondents what the Response Confirmation page is used for and how to adjust 

responses. 

The following table lists the properties of Response Confirmation pages:  

 

Section Property Description 

Basic settings Title Enter the title that appears on the title bar when 

displayed in a web browser. 

Header and Footer Display the web 

form header on the 

page 

Mark the Display the web form header on the page 

checkbox to display the header you have defined on 

the selected web page(s). Headers are created 

independently of pages and can be applied to any 

page. 

 Display the web 

form footer on the 

page 

Mark the Display the web form footer on the page 

checkbox to display the footer you have defined on the 

selected web page(s). Footers are created 

independently of pages and can be applied to any 

page. 



   

59 

 

Section Property Description 

 Branching setup  Sets up branches on the page so that if a specific 

response is selected, the respondent is directed to 

another page (also known as skip patterns). Branching 

is useful on a Response Confirmation page when 

displaying various Web Form Complete Pages based 

on responses to previous questions. See Chapter 8 for 

a complete description of branching. 

Format Format Use the Format button to format the style of the web 

page. Formatting is covered in detail in Chapter 7. 

 

To insert a Response Confirmation page in a web form 

 From the Ribbon, select the Insert tab and then click the down arrow on Page to reveal a list of 

special pages. (Note you may also insert pages by right clicking the tree view and then clicking 

Insert or Insert Before.) 

 Select Response Confirmation. 

 Enter settings as desired, as described previously.  

 [Optional] Click the Format button to adjust the 

text formatting (see Chapter 7 for further details 

about formatting). 

 Note: Rich text formatting is not 
available for Response Confirmation page 
question and answer placeholders. 

 Click the OK button. The Response Confirmation 

page is added to the Special Pages container 

automatically. 

A Question Placeholder and an Answer Placeholder are inserted into the Response Confirmation page 

automatically. The Question and Answer Placeholders represent the formatting of the question listing. 

They are displayed with the text “question placeholder” 

and “answer placeholder” as you build the web form. 

When the web form is published and respondents are 

viewing the Response Confirmation page, the placeholder 

text is replaced with the actual question and answer text 

from the web form. When you open the properties for 

either item, you see some descriptive text under Label 

text. You may not change the text of the placeholders; 

however, you may format the attributes of the 

placeholders by adjusting the format options. The 

formatting you choose appears on the real Response 

Confirmation page as respondents submit your form. 
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Session Pause Pages  
A Session Pause page provides respondents with the capability of stopping in the middle of a web form 

and then continuing from the same point at a later time. This feature is especially useful for long web 

forms. When respondents want to pause the web form, they click a pause button. A page is then 

displayed that they can either bookmark for later return or they can enter their email address. When using 

the email function, an email reminder is sent to them with a hyperlink that takes them back to the web 

form to complete it at the time of their choice. When respondents return to the web form by clicking the 

hyperlink or bookmark, they go back to the same page from which they left. All previously submitted 

responses are still stored in the data file. You may limit the amount of time respondents have to return to 

the web form through the removal of incomplete form submissions after a certain amount of time has 

passed (be sure to advise them of the available time to submit the web form in your pause page and/or 

email text).  

Using the option to email a link to the respondent relies upon the email server setting in the web form 

properties. Session Pause page email reminders use the mail server settings for the web server. These 

settings are covered later in this chapter. 

 Note: If you are not providing the ability to email a return link to the survey, you 
should add a label to the Session Pause page with explicit instructions on how to 
bookmark the page for later return. 

The following table lists the properties of Session Pause pages: 

 

Section Property Description 

Basic settings Title Enter the title that appears on the title bar when displayed 

in a web browser. 

 Include credentials 

in the web form 

link of reminder 

emails 

When using a Login page you can optionally include 

respondents’ username and/or password in the web form 

invitation link. In this case, you can also include those 

credentials in the Session Pause page reminder email link 

that is sent to respondents when they pause the web form 

by marking the checkbox for Include credentials in the 

web form link of reminder emails. When pausing forms, 

respondents receive a reminder email that includes a link 

to resume the web form and their username and/or 

password are included in the link so that they are 

automatically logged into the web form. This feature is 

useful if you do not want respondents to have to 

remember login information. 

Header and Footer Display the web 

form header on the 

page 

Mark the Display the web form header on the page 

checkbox to display the header you have defined on the 

selected web page(s). Headers are created independently 

of pages and can be applied to any page. 
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Section Property Description 

 Display the web 

form footer on the 

page 

Mark the Display the web form footer on the page 

checkbox to display the footer you have defined on the 

selected web page(s). Footers are created independently 

of pages and can be applied to any page. 

Format Format Use the Format button to format the style of the web 

page. Formatting is covered in detail in Chapter 7. 

 

To insert a Session Pause page in a web form 

 From the Ribbon, select the Insert tab and then click the down arrow on Page to reveal a list of 

special pages. (Note you may also insert pages by 

right clicking the tree view and then clicking 

Insert or Insert Before.)  

 Select Session Pause. 

 If necessary, click the Email settings link to enter 

the administrator email address and mail server 

information. This information is automatically 

inserted if you have entered it into the Remark 

Web Survey program options (accessible from 

the Application Button). If you have not entered 

this information in the program options, you 

need to enter it on the Session Pause page properties. 

 Note: Email settings should be obtained from your network or website 
administrator.  

 Enter settings as desired, as described previously.  

 Click the OK button.  

 An email question element is automatically added to the Session Pause page. If you wish to 

format it, double click the node that reads Please enter your email address and format as 

desired. 

The Session Pause page is added to the Special Pages container automatically. Be sure to add at least 

one pause button to your web form so that respondents can access your Session Pause page. 

 

To customize the reminder email 

When a respondent pauses the web form, if you have set up email settings on the pause page, a reminder 

email is sent. You may customize the email that is generated by entering your return email address, a 

subject line and the body text of the email message. Please note that the email reminder is sent to 

recipients in plain text format so rich text formatting options are disabled in this window. 

 Double click the Please enter your email address node in the tree view to view its properties. 

(This question element is added to all Session Pause pages automatically.) 
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 At the bottom of the window, click the Reminder 

email settings link.  

 Enter a valid From email address and a Subject line. 

 If desired, modify the body of the email message. 

The link to the web form is automatically added to 

the body of the message when the email is 

generated. 

When using Session Pause pages with email, ensure that 

you have set up email functionality (as outlined in Step 3 in 

the previous instructions) in the program options or in the 

web form’s properties (see Chapter 2. for further information about email setup). 

 

To hide the email address question 

If you prefer not to use the email functionality of the Session Pause page, you may instead ask your 

respondents to bookmark the page. It is suggested that you add a label to the Session Pause page with 

instructions for bookmarking the page. In this case, you need to hide the email address element. 

 Double click the node that reads Please enter your email address.  

 Go to the Attributes section. 

 Mark the checkbox for Hide question from 

respondent. 

 Click the OK button. The email address element is 

visible as you design the web form, but is hidden 

from respondents when they are submitting the 

web form. Be sure to tell respondents to bookmark 

the page if you choose not to use the email 

element. 

 Note: We advise hiding the email question 
element as opposed to deleting it because 
if you delete the email address question, 
you cannot re-insert it. If you wish to allow email reminders after deleting the email 
question element, you need to delete and recreate the Session Pause page.  

To remove incomplete form submissions 

You may remove incomplete web form submissions after a certain amount of time has passed. For 

example, if respondents begin the web form, pause and then never complete it, you can remove their 

incomplete data and ability to re-login to the web form. 
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 Note: Remark Web Survey Professional is capable of downloading incomplete data 
submissions. If you remove incomplete data from the web server, you are not able 
to use this feature. 

 Double click the top node in the tree view with the 

web form title. 

 Select the Access & Availability tab.  

 Mark the checkbox for Remove respondent’s 

incomplete data from the web server after. 

 Enter the desired number of days or hours, and then 

choose whether to base the interval on hours or days 

that the incomplete data resides on the web server. 

 Click the OK button. 

Once the time limit is exceeded, any incomplete data is 

removed from the server. Any time the web form is accessed or 

pages are submitted, the software performs a check to see if incomplete submissions need to be 

removed. 

Web Form Complete Pages 
A Web Form Complete page is the last page your respondents see when they submit a web form. You can 

think of a Web Form Complete page as a “thank you” page. It lets respondents know that they have 

completed the form successfully. You may have more than one Web Form Complete page if desired. For 

example, if your form uses question branching, you may want respondents to end up at different Web 

Form Complete pages based on how specific questions are answered. Every web form must have at least 

one Web Form Complete page. You have the option of either designing the page within Remark Web 

Survey, or redirecting your respondents to another web page created outside of Remark Web Survey that 

exists on your website. When you create a new web form, a Web Form Complete page is automatically 

added to the web form along with a section.  

The following table summarizes the Web Form Complete page options: 

 

Section Property Description 

Basic settings Title Enter the title that appears on the title bar when 

displayed in a web browser. 

Header and Footer Display the web 

form header on the 

page 

Mark the Display the web form header on the page 

checkbox to display the header you have defined on 

the selected web page(s). Headers are created 

independently of pages and can be applied to any 

page. 



   

64 

 

Section Property Description 

 Display the web 

form footer on the 

page 

Mark the Display the web form footer on the page 

checkbox to display the footer you have defined on the 

selected web page(s). Footers are created 

independently of pages and can be applied to any 

page. 

Browser 

redirection 

Redirect browser to [Optional] Mark the Redirect browser to checkbox to 

use an existing web page as your Web Form Complete 

page (designed outside of Remark Web Survey and 

published online). The respondents’ web browser 

displays this web page when the Web Form Complete 

page is launched. 

Format Format Use the Format button to format the style of the web 

page. Formatting is covered in detail in Chapter 7. 

 

To insert a Web Form Complete page in a web form 

 From the Ribbon, select the Insert tab and then 

select the down arrow on Page to reveal a list of 

special pages. (Note you may also insert pages 

by right clicking the tree view and then clicking 

Insert or Insert Before.) 

 Select Web Form Complete. 

 Enter settings as desired, as described previously.  

 Click the OK button. The Web Form Complete 

page is added to the Special Pages container 

automatically. You may optionally add elements 

(labels, images, etc.) under the Section portion of 

the Web Form Complete page (see Chapter 5 for more information about adding other elements). 

Login Pages 
Remark Web Survey allows you to password protect any web form that you create. Requiring a password 

to submit a web form allows you to control who has access to your web form. Respondents are not able 

to view a password protected web form until they successfully enter a valid password. Passwords also 

allow you to limit the number of times respondents can submit a web form. You control how many times 

any given password can be used. When the limit is reached, respondents receive a “password expired” 

error message when attempting to access the web form. Password lists can be automatically generated, 

imported from an existing database or manually entered into the software. In addition, you may input a 

corresponding username, name and/or email address and use that information to track which 
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respondents have completed your web form (see Chapter 10 for detailed information about Respondent 

Detection).  

To utilize password protection, you add a Login page to a web form. The Login page provides a place for 

respondents to enter passwords in order to access and submit the web form. Once a Login page is 

inserted, a password question element box is automatically inserted (do not delete the password box; if it 

is deleted, you need to remove and reinsert the entire Login page). The password question element is a 

textbox that allows respondents to type in their passwords. You may format the password question 

element however you desire by using the question’s format options. To format the password element, 

double click its node in the tree view and then click the Format button.  

The following table summarizes the Login page options: 

 

Section Property Description 

Basic settings Title Enter the title that appears on the title bar when 

displayed in a web browser. 

 Display a username 

field for an 

additional level of 

security access 

Mark the Display a username field for an additional 

level of security access checkbox to add a username 

textbox to the login page. You enter a valid list of 

usernames in the Password Builder. Respondents have 

to enter a valid username and password to access the 

web form. 

Header and Footer Display the web 

form header on the 

page 

Mark the Display the web form header on the page 

checkbox to display the header you have defined on the 

selected web page(s). Headers are created 

independently of pages and can be applied to any page. 

 Display the web 

form footer on the 

page 

Mark the Display the web form footer on the page 

checkbox to display the footer you have defined on the 

selected web page(s). Footers are created independently 

of pages and can be applied to any page. 

 Password list builder Click the Password list builder link to enter a valid list 

of passwords required to access the web form. 

Format Format Use the Format button to format the style of the web 

page. Formatting is covered in detail in Chapter 7. 
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To insert a Login page in a web form 

 From the Ribbon, select the Insert tab and then 

click the down arrow on Page to reveal a list of 

special pages. (Note you may also insert pages 

by right clicking the tree view and then clicking 

Insert or Insert Before.) 

 Select Login. 

 Enter settings as desired, as described previously. 

You must also enter a valid list of passwords and the 

number of acceptable uses on the Login page. Use the 

Password List Builder to set up valid passwords for the web form. You may import a list of passwords 

from an existing database or enter them into the Remark Web Survey software.  

 Click the Password list builder link to enter valid passwords. 

 

The following table summarizes the available Password Builder options: 

 

Property Description 

Username Field Use the Username column to manually enter a list of 

usernames. The keyboard shortcut for Paste (Ctrl + V) 

also works in this grid, allowing you to paste a list of 

passwords from the Windows clipboard. The Username 

column only appears of the option for Display a 

username field for an additional level of security 

access is marked on the Login page’s properties. 

Password Field Use the Password column to manually type a password 

list. The keyboard shortcut for Paste (Ctrl + V) also works 

in this grid, allowing you to paste a list of passwords from 

the Windows clipboard. 

Respondent Name Field Use the Respondent Name column to manually type the 

respondents’ names. The keyboard shortcut for Paste (Ctrl 

+ V) also works in this grid, allowing you to paste a list of 

names from the Windows clipboard. 

Email Address Field Use the Email Address column to manually type an email 

address list for your respondents. The keyboard shortcut 

for Paste (Ctrl + V) also works in this grid, allowing you to 

paste a list of email addresses from the Windows 

clipboard. 
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Property Description 

Maximum number of accepted 

submissions using a single password 

before it is expired 

Specifies the number of times each password can be 

used. Select 0 for unlimited usage. When limiting the 

number of submissions per password, once the limit is 

reached, respondents receive an “expired password” 

message if they attempt to use an expired password. 

Maximum number of passwords per file 

when publishing 

By placing the passwords in multiple files, your 

respondents have a faster experience validating 

passwords and pipes. Remark Web Survey suggests 

whether you use a higher or lower number than the 

default number of passwords per file (500) based on the 

number of passwords and/or pipes you have on the Login 

page. Please note that server setup may vary from server 

to server, and even if you are in the recommended range, 

if you find that the respondent login performance is slow, 

you can try reducing the maximum number of passwords 

per file even further. For optimal performance, it is 

recommended that you keep the number of possible 

respondents and login page pipe combinations under 

3,500. The number of possible combinations is derived by 

multiplying the # of respondents by the # of login page 

pipes. If there are no login page pipes, the number of 

possibilities is equal to the number of respondents. 

Database Connection Settings Allows you to select a database containing a list of 

passwords for the form. If you import the information 

from a database, you do not have to manually enter 

passwords, usernames, names and email addresses. You 

can also clear a previous connection using the Clear 

connection link. 

Database Displays the database file name after one is set up. 

Type Choose a type of database from the drop-down list. Then 

click the Open folder to select the database containing 

the password list. 

DSN If using an ODBC connection, choose the DSN from the 

DSN drop-down list. Mark whether it is Directory based 

or DSN based. ODBC DSN is a pointer that tells the 

system how to connect to a specific database. It combines 

the database location with the specific driver information 

and connection details.  

Username If your database requires a login, enter the Username. 
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Property Description 

Password If your database requires a login, enter the Password. 

Connection string Displays the connection string that is working behind the 

scenes to connect to your selected database. 

Test Connection You may optionally click the Test Connection button to 

test whether you can connect to this database. 

Table Select the table in the database that contains the 

passwords. 

Name field Select the field in the database that contains the 

respondents’ names. (Optional) 

Name 2 field Select the field in the database that contains the 

respondents’ names. (You can optionally separate first 

and last name.) (Optional) 

Username field Select the field in the database that contains the 

respondents’ usernames. (Optional) 

Password field Select the field in the database that contains the 

respondents’ passwords. 

Email Address field Select the field in the database that contains the 

respondents’ email addresses. (Optional) 

Import data Click the Import data link to complete the import. 

 

 Note: The password, name, username and email address fields are used to track 
which respondents have submitted your web form. When the data are 
downloaded, Remark Web Survey can provide a Respondent Detection report, 
which displays a list of who has and has not submitted your web form based on 
these fields. You can then use this list to send an email reminder to respondents 
who have not yet submitted your web form using Remark Web Survey’s Send 
Invitations function. Enter password information manually or by clicking Database 
connection settings to import a list of passwords, as described in the previous 
table. 

 [Optional] If you prefer, random passwords can be assigned to existing names, usernames and/or 

email addresses. This feature is useful if you have a list of recipients in an external file but do not 

have a password for each one. To use the Random feature, you must first enter the names, 

usernames and/or email addresses of the recipients, as explained in the previous table. Then click 

the Random button. 

a) Select the length of passwords, whether to include symbols in the password (otherwise 

passwords are a combination of letters and numbers only) and whether to overwrite any 

existing passwords (if there are any). 
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b) Click the OK button to generate the passwords. 

 Click the OK button. The Login page is added to the 

Special Pages container automatically. 

 Special Note: If you want to enter a range of 
passwords in sequential order, enter the first 
password in the first cell of the password grid. 
Click on the right cell border until you see a 
crosshair and then drag down the column until 
you reach the number of rows you wish to fill. 
When you release the mouse button, the 
software automatically fills the passwords in 
sequential order. For example, if you type 1 in the 
first box and then drag downward to encapsulate 
100 cells, you have a password range of 1-100. 

Server Error Pages 
Server Error pages provide customized error messages when an error occurs during a web form 

submission. Server errors are those that occur on the web server during processing. If you do not add a 

Server Error Page to your form, default messages are displayed if an error is encountered. The following 

table summarizes the Server Error Page options: 

 

Section Property Description 

Basic settings Title Enter the title that appears on the title bar when 

displayed in a web browser. 

Header and Footer Display the web 

form header on the 

page 

Mark the Display the web form header on the page 

checkbox to display the header you have defined on the 

selected web page(s). Headers are created 

independently of pages and can be applied to any page. 

 Display the web 

form footer on the 

page 

Mark the Display the web form footer on the page 

checkbox to display the footer you have defined on the 

selected web page(s). Footers are created independently 

of pages and can be applied to any page. 

 Message Links Click any of the available message links to customize the 

error message respondents see. The messages that can 

be customized include: Invalid Password, Password 

expired, File access error, Web form unavailable and 

Maximum submission capacity. 

Format Format Use the Format button to format the style of the web 

page. Formatting is covered in detail in Chapter 7. 
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To insert a Server Error page in a web form 

 From the Ribbon, select the Insert tab and then 

click the down arrow on Page to reveal a list of 

special pages. (Note you may also insert pages by 

right clicking the tree view and then clicking 

Insert or Insert Before.) 

 Select Server Error. 

 Enter settings as desired, as described previously. 

The possible messages you can customize 

include: 

 

Message Description 

Invalid Password 

message 

Customize the error message that appears when respondents use an invalid 

password to access a web form. 

Password expired 

message 

Customize the error message that appears when respondents use an expired 

password to access a web form. 

File access error 

message 

Customize the error message that appears when respondents try to access 

web form pages to which they do not have access (e.g., they mistype URL for 

your web form). 

Web form unavailable 

message 

Customize the error message that appears when respondents attempt to 

access a web form outside of its availability window.  

Maximum submission 

capacity message 

Customize the error message that appears when respondents attempt to 

access a web form that has already reached the maximum number of 

submissions. 

 

 Click the OK button. The Server Error page is added to the Special Pages container automatically.  

Editing Existing Form Pages 
There may be times when you need to edit a page that already exists in the web form. There are three 

ways to edit existing page properties: 

 Double click the page node. 

 Right click the page node and select Properties. 

 Click the page node, go to the View tab in the Ribbon and select Properties. 

Once you are in the Properties window, you can make the appropriate changes and then click the OK 

button to save your changes. To understand what is on each individual page type, please see the previous 

sections. 



Chapter 5: Remark Web 

Survey Page Elements 

Overview 
Chapter 4 covered web form elements, including form properties and pages. Once you have pages on a 

web form, you need to add other elements. The elements are inserted onto page sections. The use of 

sections allows you to customize the layout of web forms. This chapter covers the following elements: 

 Sections 

 Labels 

 Images 

 Lines 

 Multimedia Questions 

 Answers 

 Buttons 

 Headers/Footers  

 Note: The following sections cover inserting various page elements on a web form. 
Once elements are inserted, they can be modified. The properties that are available 
for editing are the same as those you see when inserting an element. 

Sections 
Sections are containers that hold the page elements (questions, images, labels, etc.) of your web form. The 

following items can be inserted into sections: 

 

Name Included Elements 

Label Inserts a text label (e.g., web form directions) 

Image Inserts an image 

Line Inserts a horizontal line 

Multimedia Inserts a multimedia file, such as a video or audio clip  

Question Inserts questions: option button, checkbox, drop-down box (single or multiple 

responses), textbox/text area 

Buttons Inserts Submit/Next, Back, Reset and Session Pause buttons 

 

By default, when you create a new page, two sections are added to the page. The first section is where 

you can start adding elements from the table above. The second section automatically contains web form 
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buttons. The buttons displayed are dependent upon the type of page you are inserting, but can also be 

modified.  

Each section contains a number of columns. The columns are used to assist with web form layout. If you 

put all of the elements in one column (the default setting), that column spans the width of the page. 

However, if you separate a section into multiple columns, elements can be placed in specific column 

locations. Think of the sections as a table. The table has rows and columns within it and you can place 

items in specific columns. The Remark Web Survey designer displays a light gray table in the HTML Viewer 

to assist you with layout. These lines are not visible in your published web forms, but can help you place 

elements in the various rows and columns on the page. (The lines are made visible through the Show 

HTML Layout Borders checkbox on the View tab of the Ribbon.) 

One common use of section columns is to put questions in separate columns on the page so that they 

span across the page in addition to down the page. You can have two columns of questions, for example, 

instead of only having one column that goes all the way down the page. 

 

To insert a section 

 With a page highlighted, click the Insert tab on the Ribbon and then choose Section. (Note you 

may also insert elements by right clicking the tree view 

and then clicking Insert or Insert Before.) 

 If desired, enter a Section title for the section (the 

Section title does not display on the published web 

form, but is there to help you identify sections more 

easily as you design web forms).  

 Set the Number of columns for the section. One 

column is typically fine unless you plan to position 

elements in various columns on the form going across 

the page. 

 The Section content area is for information purposes 

only.  

 [Optional] Click the Format button to add and format lines in between the columns. By default, 

there is no visible vertical line separator between columns in a section. You can add vertical lines 

for aesthetic purposes if desired. Once in the Style Properties, set the Column Border Visible 

property to True, choose a color under Column Border Color and then choose the width of the 

line, in pixels, under Column Border Width.  

 Click the OK button. 

You may now begin adding other elements to the web form. 

The following sections describe each of the element types in detail.  
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Label Elements 
A label element consists of free text that you place on a web form. For example, a label element can be 

used for a web form title or for providing instructions for filling out a web form. Labels are limited to 

10,000 characters. You can customize the following attributes of a label element: 

 

Section Item Function 

Description Details Label text Use the Label text area to enter the text for the label. 

Labels are limited to 10,000 characters. 

 Enable rich text 

formatting 

Mark the Enable rich text formatting checkbox to display 

the label in rich text format. Rich text format allows for 

more style variety as compared to plain text, including 

changing font sizes, styles and colors. These attributes can 

be changed for entire labels or individual characters within 

the label. See Chapter 7 for further details about rich text 

formatting. Any rich text formatting you apply overrides 

the general style properties for the element. 

 Column  Select the column in which you want the label. The 

number of columns available is dependent on the Column 

setting in the section to which the label belongs. 

 Insert answer 

pipe 

Click the Insert answer pipe link to set up answer piping. 

Answer piping displays information gathered from a 

question on a previous page of the form within the label. 

For example, if you ask for the respondent’s name, and his 

name is John, you can then “pipe” the name into the label 

to make your form appear more personalized (e.g., “Thank 

you, John, for taking the time to submit this survey.”).  
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Section Item Function 

Behavior Hyperlink Mark the Hyperlink checkbox to turn the label text into a 

hyperlink. A hyperlink takes the respondent to another 

question on the web form or to a different web page. 

When using a web page, enter a fully qualified URL (e.g., 

http://www.example.com). You should not use a hyperlink 

in place of question branching if you want to direct 

respondents to other questions based on how they answer 

a question. A hyperlink is more useful to display general 

information you want your respondents to see. Keep in 

mind that if you are not using rich text formatting, you can 

also right click anywhere within your label and insert 

hyperlink text if you do not want the entire label to be a 

hyperlink. 

Note: If you add a label to a Web Form Complete or 

Popup Info page, and you mark it to behave as a 

hyperlink, you also have the option to specify whether to 

open the hyperlink in a new window. 

 Format  Use the Format button to format the look of the label. 

Formatting is covered in detail in Chapter 7. 

 

To insert a label 

 Select an insertion point in the tree view. 

 From the Ribbon, select the Insert tab and then click 

Label. The Label Properties window appears. (Note 

you may also insert elements by right clicking the 

tree view and then clicking Insert or Insert Before.) 

 Fill in the desired Label text. 

 Note: When typing label text, you can insert 
hyperlinks by selecting text, right clicking 
and choose Insert Hyperlink from the 
menu. You can also insert HTML tags if you are not using Rich Text. You should 
only insert your own HTML tags if you have a firm grasp on the HTML language. 
Gravic technical support personnel cannot support user-created HTML tags.  

 If desired, utilize the other properties within the Label Properties window, as described in the 

previous table. 

 Click the OK button to save the label.  

The label is added to the tree view and is visible in the HTML Preview window. 

http://www.example.com/
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Line Elements 
A line element is a horizontal break that can be inserted on a page wherever it is appropriate. When you 

insert a line, there are no properties to set. However, you can access the line’s properties to adjust its style 

properties by double clicking the line element once it has been added. Formatting is covered in detail in 

Chapter 7.  

 

To insert a line 

 Select an insertion point in the tree view. 

 From the Ribbon, select the Insert tab and then click Line. 

(Note you may also insert elements by right clicking the tree 

view and then clicking Insert or Insert Before.) The line is 

automatically added to the tree view and is visible in the 

HTML Preview window.  

 [Optional] If you wish to format the line, double click it within 

the tree view and then click the Format button. 

Image Elements 
An image element is a graphic that is placed onto a web form in a designated area. Images can be in the 

GIF (Graphics Interchange Format), JPG/JPEG (Joint Photographic Experts Group) or PNG (Portable 

Network Graphics) formats. 

An image element can be added to the page anywhere that is appropriate. A copy of the image is 

published to your web server with the rest of the form content. Therefore, there is no need to specify 

where the image is located on your web server.  

The following table lists a summary of the image attributes that can be set: 

 

Section Item Function 

Description Details Image path Click Select image to locate the image you wish to add to 

your web form. 

 Alternate text Use the Alternate text item to enter text that is displayed 

when the mouse is placed over the image on your web 

form and while the image is loading. Alternate text is 

useful if you want to create Section 508 compliant web 

forms. Screen readers read the alternate text. 

 Column  Select the Column in which you want the image. The 

number of columns available is dependent on the Column 

setting in the section to which the image belongs. 
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Section Item Function 

Original Dimensions Width  Use the Width setting to resize the image. Enter the 

number of pixels wide you want the image to be in the 

Width box. Note that changing the size does not alter the 

original image; it only resizes it in Remark Web Survey. 

 Height Use the Height setting to resize the image. Enter the 

number of pixels high you want the image to be in the 

Height box. Note that changing the size does not alter the 

original image; it only resizes it in Remark Web Survey. 

 Maintain aspect 

ratio 

Mark the Maintain aspect ratio checkbox to 

automatically size the image proportionately as you set 

either the Width or Height settings. The other setting 

automatically updates so that your image does not 

become distorted. Note that changing the size does not 

alter the original image; it only resizes it in Remark Web 

Survey. 

Behavior Hyperlink Mark the Hyperlink checkbox to turn the image into a 

hyperlink. A hyperlink takes the respondent to another 

question on the form or to a different web page when 

clicked. When using a web page, enter a fully qualified 

URL (e.g., http://www.example.com).  

 Open external 

hyperlinks in a 

new window 

Mark the Open external hyperlinks in a new window 

checkbox to have hyperlinks open in a separate (new) 

window when clicked. This option applies to images that 

are on Popup Info and Web Form Complete pages only. 

 Format  Use the Format button to format the image. Formatting is 

covered in detail in Chapter 7. 

 

To insert an image 

 Select an insertion point in the tree view.  

 From the Ribbon, select the Insert tab and then click 

Image. The Image Properties window appears. (Note 

you may also insert elements by right clicking the tree 

view and then clicking Insert or Insert Before.) 

 Use the Select image link to locate the image you wish 

to insert into your web form. 

 If desired, enter Alternate text. Alternate text is useful 

for Section 508 compliance; screen readers use this text 

to read information about the image. 

http://www.example.com/
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 If desired, utilize the other properties within the Image Properties window, as described in the 

previous table. 

 Click the OK button to save the image.  

The image is added to the tree view and is visible in the HTML Preview window. 

Multimedia Elements 
Multimedia includes video and audio files that you embed into your web forms for respondents to view. 

For example, suppose you are conducting a survey about a possible new product and want to show 

respondents a potential advertisement for the new product and then ask questions about it. Respondents 

can play the video clip (or audio clip) directly from the web form. Supported multimedia formats include: 

Moving Picture Experts Group (mpeg, mpg, mp3), Audio Video Interleave (avi), QuickTime (mov), 

Waveform (wav), Real Audio (ram, rm). 

 Note: Remark Web Survey does not provide functionality to create multimedia 
files. These files must be created outside of Remark Web Survey. You may then 
either embed them into the web form or provide a link (URL) to them on an 
existing website. 

You should understand the requirements of the format and player that you are using. In addition, your 

respondents must have the appropriate viewer and supporting files on their system in order to view the 

media. You may wish to put instructions on the web form indicating what respondents need to properly 

view your multimedia file. Note that different browsers have varying capabilities and requirements when it 

comes to displaying multimedia files. We strongly suggest you test your web form with the browsers you 

expect to be able to support (e.g., the browsers you expect your respondents to use).  

The following table lists a summary of the multimedia attributes that can be set: 

 

Section Item Function 

Description Details Select media 

from the system 

Click system to locate the multimedia file you wish to add 

to your web form. 

 Specify a web 

address 

Click web address to enter a hyperlink to your multimedia 

file. The file must reside on an existing website. Please use 

caution when using URLs to link to files; if the file is moved, 

the hyperlink stops working. When using a web page 

hyperlink, enter a fully qualified URL (e.g., 

http://www.example.com/myfile.avi). 

 Source The Source lists the name of the file you have selected. If 

the name is too long to fit in the window, hover your 

mouse over the name to see the entire name. Source is not 

editable; go back to Select media from the system to 

choose a new file if needed. 
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Section Item Function 

 File Size The File Size lists the size of the selected multimedia file. 

Note that large files may take longer to load for the 

respondent. File Size is for informational purposes only. 

 Define a custom 

media player size 

Mark the Define a custom media player size to enter 

specific dimensions for the media player that plays your 

video or audio file. Please note that the default dimensions 

are determined by the resolution of the media file, and that 

the media player then determines the size needed to play 

your file. Use caution when altering the size manually, as 

the video may not display as expected. 

Original Dimensions Width  Use the Width setting to resize the media player. Enter the 

number of pixels wide you want the player to be in the 

Width box. Note that changing the size does not alter the 

original multimedia file; it only resizes it in Remark Web 

Survey. 

 Height Use the Height setting to resize the media player. Enter the 

number of pixels high you want the player to be in the 

Height box. Note that changing the size does not alter the 

original multimedia file; it only resizes it in Remark Web 

Survey. 

 Maintain aspect 

ratio 

Mark the Maintain aspect ratio checkbox to automatically 

size the media player proportionately as you set either the 

Width or Height settings. The other setting is automatically 

updated so that the media player does not become 

distorted. Note that changing the size does not alter the 

original multimedia file; it only resizes it in Remark Web 

Survey. 

 Standby text Use the Standby text box to enter text that displays while 

the multimedia file is loading. For example: “Please wait 

while the video loads. This operation may take a few 

minutes.” 

 Column  Select the Column in which you want the multimedia file 

displayed. The number of columns available is dependent 

on the Column setting in the section to which the 

multimedia file belongs. 
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Section Item Function 

Behavior Automatically 

start media (auto 

play) 

Mark the Automatically start media checkbox to have the 

multimedia file begin as soon as the web page is loaded. 

The respondent does not have to interact with the 

multimedia file, such as having to click the Play button to 

begin play. 

 Repeat media 

(loop) 

Mark the Repeat media checkbox to have the multimedia 

file continuously play for as long as the web page is on-

screen. 

 Format  Use the Format button to format the image. Formatting is 

covered in detail in Chapter 7. 

 

To insert a multimedia file 

 Select an insertion point in the tree view.  

 From the Ribbon, select the Insert tab and then click Multimedia. The Multimedia Properties 

window appears. (Note you may also insert elements by right clicking the tree view and then 

clicking Insert or Insert Before.) 

 Use the system link to locate the multimedia you wish to insert into your web form. Alternatively, 

use the web address link to enter a URL to a 

multimedia file on an existing website. If you are 

entering a URL, Remark Web Survey attempts to 

validate the link immediately. 

 If desired, enter Standby text. Standby text displays 

while the media player is loading so that your 

respondents know to wait. 

 If desired, utilize the other properties within the 

Multimedia Properties window, as described in the 

previous table. 

 Click the OK button to save the multimedia file.  

The multimedia file is added to the tree view and is visible in 

the HTML Preview window. 

 Tip: Displaying or hiding the multimedia player’s controls can be set using the 
Format button in the Multimedia Properties window. For some browsers you may 
need to make the size of the player slightly larger in order to completely see the 
player’s controls. 
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Question and Answer Elements 
Question elements represent the questions on a web form. There are four general types of question 

elements: option buttons (also known as radio buttons), checkboxes, drop-down boxes and single and 

multiple line textboxes/text areas.  

Option Buttons 

An option button is a small circle that can be selected or cleared: . When selected it contains a dot. 

Option buttons are used for multiple choice questions where the respondent is only permitted to choose 

one response. 

Checkboxes 

A checkbox is a small square that can be selected or deselected: . When selected it contains a check 

mark (). Checkboxes are used for multiple-choice questions that allow the respondent to choose more 

than one response for a single question. The responses can be output to one data cell or individual data 

cells. 

Textboxes/Text Areas 

A textbox is used for questions that allow the respondent to type an answer: . 

Textboxes are appropriate for open-ended types of questions, or for collecting information about 

respondents, such as names and addresses. You may select the size of the textbox and whether to limit 

the length of a respondent’s response. A single line write in area is called a textbox. A multiple line write in 

area is called a text area. 

Drop-Down Boxes 

A drop-down box is a list in which pre-defined answer choices can be selected: . Drop-down boxes 

can be used for questions that allow single or multiple responses. A drop-down single box only allows the 

respondent to select one item. A drop-down multiple box allows the respondent to choose more than 

one item by holding down the Shift or Ctrl key and clicking the desired responses. 

Question Element Properties 
When setting the properties for a question, there are five areas to be configured: General, Answers, 

Attributes, Analysis and Database Link. The following tables summarize the question element properties: 

General: 

The General window allows you to set general properties related to the question. 
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Property Function 

Question type Use the Question type drop-down list to change the type of 

question selected: Textbox/Text Area, Checkbox, Option Button or 

Drop-Down Box. 

Allow multiple selections Mark the Allow multiple selections checkbox when using a Drop-

Down Box question type to allow respondents to select more than 

one answer from the pre-defined list. Respondents are able to hold 

down the Ctrl key while they click answers in the list in order to 

select them. 

Data type Use Data type to select a data type for the question: text or 

numeric. When exporting data to other programs, data is formatted 

according to the data type selected. 

Field name Use Field name to create a field name for the question, which is 

used as a column header in the data grid. Field names are also 

useful if you plan to combine data with Remark Office OMR or 

Remark Classic OMR; use the same field names in both products. 

When planning to export data, be sure to follow your export 

format’s guidelines for field naming conventions. In addition, if you 

are planning to save data to an existing database file, be sure to 

match your field names in Remark Web Survey to those in the 

existing database. 

Question text Use Question text to enter the text respondents see for the 

particular question. Question text also appears on select reports 

when you analyze your data. Question text is limited to 10,000 

characters. 

Display as rich text Mark the Display as rich text checkbox to display the question text 

in Rich Text format. Rich text provides more formatting options 

than plain text (e.g., font sizes, types and colors). Rich text 

formatting overrides any other formatting options set for the 

element. See Chapter 7 for further details. 

Insert answer pipe Click the Insert answer pipe link to set up answer piping. Answer 

piping displays information gathered from a different question on 

the web form within the question text. For example, if you ask for 

the respondent’s name, you can then “pipe” the name into another 

question’s text to make your form appear more personalized 

(e.g., ”John, how do would you rate your latest customer service 

experience?”).  

Format Use the Format button to format the question. Formatting is 

covered in detail in Chapter 7. 
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Answers: 

The Answers window allows you to set and format answer options. 

 

Property Function 

Pre-defined scales Use the Pre-defined scales drop-down list to select an answer 

scale for the question’s answers. You can use this option for 

Checkbox, Option Button and Drop-Down Box question types. You 

can select a scale from the Pre-defined scales drop-down list, or 

edit an existing or create a new scale by selecting the Edit scales 

link. You may also enter a scale into the HTML Labels grid and then 

click the Save scale link to add the scale to your list of reusable 

scales. 

Default value Use the Default value box to put default text in a Textbox/Text 

Area style question. The text in the text box/text area is 

automatically be downloaded into the data set for the web form. 

This feature is often useful for hidden textbox/text area questions 

where you want to include data in your data file, but do not wish to 

display it to the respondents. If it is displayed to respondents, they 

can change the text. 

HTML Display  Use the HTML Display column to enter a list of answer choices as 

you want them to appear on the web form. This list controls the 

display of answer choices to your respondents. HTML Display text is 

limited to 10,000 characters. 

Labels Use the Labels column to enter a list of answer choices as you want 

them to appear in the resulting data file. Enter one label to 

correspond with each entry in the HTML Display column. As you 

type in the HTML Display column, the same information is 

automatically entered into the Labels column (without any special 

characters, which are not allowed). You may modify the Labels as 

desired (the Label text does not have to be the same as the HTML 

Display text). The following characters are not allowed in the Labels 

column: “'+,=(). Data labels are limited to 240 characters. For 

example, you may have answer choices (HTML Display) of Strongly 

Agree, Agree, Neutral, Disagree and Strongly Disagree. But you may 

want your data to appear as SA, A, N, D, SD, which you can enter as 

Labels in the grid. 
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Property Function 

Values Use the Values column to enter a list of numeric values associated 

with each Label. Values are used to calculate statistics and are 

exported to certain file formats, such as SPSS. As you type in the 

HTML Display column, the Values are automatically entered into the 

Values column sequentially. You may modify the Values as desired, 

but each Value must be unique. Note that the Values column is not 

visible when using the Numeric data type on the Question 

Properties|General window. In addition, values are not used as 

points awarded when grading tests (points are assigned in the 

Analysis portion of the properties window or the Grade Wizard). 

Insert a choice to be treated as 

a non-response 

The Insert a choice to be treated as a non-response property 

applies to single-selection drop-down lists only. When selected, this 

property inserts a choice that replaces a non-response. Choose text 

from the list or enter your own. If respondents leave the question 

blank, or choose a valid response, then go back and choose this 

response, the question is treated as blank. If the drop-down list is 

set as “required” this response does not fulfill the question being 

answered and respondents are notified that they have not 

answered a required question. This answer choice is not passed 

down to Remark Quick Stats as a valid answer when analyzing data. 

Access current answer’s 

properties 

Use the Access current answer’s properties link to access each 

individual answer choice’s options.  

Limit the number of answers 

allowed to 

Mark the Limit the number of answers allowed to checkbox to 

limit the number of responses allowed for a Checkbox or Drop-

Down Box that allows multiple responses. Enter the maximum 

number of responses allowed in the box. If respondents choose too 

many responses, they receive an appropriate error message when 

they submit the web form page. Note that the error message does 

not appear until the page is submitted. 

Max exceeded error message   Click the Max exceeded error message link to customize the error 

message that respondents see when they submit a web form page 

where they have selected too many answer choices for a question. 

If you do not customize the message, a default message is 

displayed.  

Randomize answer choices 

during display 

Mark the Randomize answer choices checkbox to have the answer 

choices for the question appear in a random order every time the 

web form is displayed. 
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Attributes: 

The Attributes window allows you to set more advanced settings for the question. 

 

Section Property Function 

Attributes and Display 

Settings 

Display question in 

the data grid 

Select the Display question in the data grid 

checkbox to include the question in the data grid 

when opening or downloading data. 

Note: When you have a data file open, you may 

also right click a question node and turn on or off 

Display question in grid. Upon returning to the 

Respondent grid, the data is refreshed accordingly. 

 Mark question as 

required 

Select the Mark question as required checkbox to 

require a question to be answered in order for the 

web form page to be submitted successfully. If 

respondents do not answer the required question, 

they receive a “required question missing” error 

message upon submitting the page (see below). 

Tip: If using single-selection drop-down lists, use 

the Insert a choice to be treated as a non-

response property in the Answers window. When 

selected, this property inserts a choice that replaces 

a non-response. If respondents leave the question 

blank, or choose a valid response, then go back and 

choose this response, the question is treated as 

blank. If the drop-down list is set as “required” this 

response does not fulfill the question being 

answered and respondents are notified that they 

have not answered a required question. This answer 

choice is not passed down to Remark Quick Stats as 

a valid answer when analyzing data. 

 Missing error message Click the Missing error message link to customize 

the error message that respondents see when they 

submit a web form page without responding to a 

required question. If you do not customize the 

message, a default message is displayed. 
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Section Property Function 

 Hide question from 

respondent 

Mark the Hide question from respondent 

checkbox to make a question hidden. Hidden 

questions are not visible and therefore cannot be 

answered by a respondent. However, a pre-selected 

response choice is submitted with the web form 

page. Hidden questions are useful when you want a 

piece of data to be included in your data file but 

you do not necessarily want respondents to see the 

information. For example, suppose you want 

respondents to answer the same questions about 

three different products. You could set up three 

surveys, each with a hidden question within the 

survey that identifies the product. When 

downloading the data, you are easily able to see 

which product the respondent is referencing.  

 Treat each answer 

choice as a separate 

question item 

Mark the Treat each answer choice as a separate 

question checkbox to output the responses from a 

Checkbox or Drop-Down Box (allowing multiple 

responses) to separate cells in the data grid. Each 

possible answer choice occupies a field in the data 

grid. When downloading data, the cells are filled for 

those answer choices that respondents selected.  

 Mask text input Mark the Mask text input checkbox to mask the 

text that the respondent types into a Textbox/Text 

Area question type. This feature is most useful for a 

password question on a Login page so that others 

cannot see the password that was used to gain 

entry to a web form. You can, however, use the 

mask formatting on any Textbox/Text Area style 

question to allow the entry of masked information. 

The text is masked with asterisks (*) as the 

respondent types information. 

 Column Select the Column in which you want the question. 

The number of columns available is dependent on 

the Column setting in the section to which the 

question belongs. By placing questions in columns, 

you can use more of the available viewing space of 

the web browser. Questions are positioned both 

across the page and down the page if more than 

one column is used. 
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Section Property Function 

 Answer box height When inserting a Textbox question, you can 

increase its height by adding rows, which turns it 

into a Text Area. A Text Area style question has 

multiple rows and columns to accommodate more 

text than a one-line textbox. 

 Answer box width When inserting a Textbox question, you can 

increase its width by adding columns. Note that the 

width of a textbox is the same number of characters 

respondents re able to type (e.g., a textbox with a 

width of 10 allows 10 characters). If using a Text 

Area (multiple lines), the Answer box width setting 

does not limit the number of characters that can be 

typed.  

 Answer choice 

columns 

The Answer choice columns setting allows you to 

place answer choices in multiple columns, side-by- 

side. This feature is useful if you have a large 

number of answer choices for an option button or 

checkbox style question. The answer choices are 

listed across the page in columns instead of in one 

long column going all the way down the web page. 

Behavior Hyperlink Mark the Hyperlink checkbox to have the question 

display as a hyperlink. Then type the hyperlink into 

the box using a fully qualified URL, or select a 

question or page from the list. Use caution when 

setting up questions as hyperlinks; respondents 

navigate away from the current page. However, the 

hyperlink for questions always display in a new 

browser window. 

 Associate response 

with the following 

query parameter 

Mark the Associate a response with a query 

parameter checkbox to pass a hidden value into 

the web form’s data dynamically. Enter a name for 

the query. Then when generating URLs for the web 

form, append the query parameter name and value 

to the URL that is sent to respondents.  
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Section Property Function 

Input Pattern Ensure input conforms 

to this pattern 

When using a textbox style question (single line 

only) you can force a pattern for the characters 

entered by your respondents by marking the 

checkbox for Ensure input conforms to this 

pattern. For example, if respondents are entering 

phone numbers, you may want the pattern to be 

(000) 000-0000. By default, you can choose Date, 

Phone and Social Security Number patterns. 

However, you may also create your own patterns by 

clicking the down arrow on the textbox and 

choosing Edit Input Patterns (or simply type your 

pattern in the box and click the Save icon). In the 

Input Pattern Editor box, click the New button and 

then type your pattern in the box. When entering a 

pattern, use a 0 to represent numeric characters, an 

A to represent alpha characters and an X to 

represent alphanumeric characters. For example, if 

you wanted your pattern to be a phone number 

without the parentheses, you might use: 000-000-

0000. When respondents enter their phone 

numbers, they need to format it like: 123-456-7890 

or an error occurs when they submit the page. You 

should tell respondents the pattern you are 

expecting either in your question text or in a label 

near the question. Note that if you want the literal 

characters 0, A or X to appear in your pattern, you 

need to enclose them in quotations (e.g., “X”). 

Please note that input patterns are not validated 

until the page is submitted. In addition, there is no 

pattern to require only numeric or textual 

information. You must specify a specific number of 

characters. 

 Input pattern error 

message 

If a respondent submits a page without following 

the appropriate textbox formatting the following 

error appears: “The response does not conform to 

the specified input pattern for this question.” If you 

want to customize this error, click the Input pattern 

error message link and adjust the text (includes the 

ability to format the text). 
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Analysis: 

The Analysis window allows you to set properties for grading tests and tabulating surveys. 

Property Function 

Include question in grading 

process 

Mark the Include question in grading process checkbox to indicate 

the question should be graded in Remark Quick Stats. If this option 

is not selected the question is not included in a grade operation. 

Treat as a subjective question Mark the Treat as a subjective question checkbox to include 

subjective points when grading a test. Subjective questions contain a 

point value to be added to the objective portion of the test that 

Remark Web Survey automatically calculates. The question must be 

of the numeric data type to be used as a subjective question. 

Include question in tabulation 

process 

Mark the Include question in tabulation process checkbox to 

tabulate responses from the question in Remark Quick Stats. If this 

option is not selected the question is not included in a survey 

tabulation operation. 

Points awarded for correct 

response 

Use the Points awarded for correct response item to select how 

many points to award for correct answers when grading a test. 

Points awarded for incorrect 

response 

Use the Points awarded for incorrect response item to select how 

many points to award or subtract for incorrect answers when 

grading a test. 

Points applied if question is 

skipped 

Use the Points awarded for incorrect response item to select how 

many points to award or subtract if a question is not answered when 

grading a test. 

Missing value Use the Missing value textbox to enter a value Remark Web Survey 

uses when a question is not answered or characters appear in the 

response that do not match the pre-defined scale. Missing data is 

anything that doesn’t match the Labels you defined for the question, 

including blank responses. You can set the missing value on a 

question by question basis. The default missing value is -1. Only 

numeric characters are allowed. Missing values can be reported in 

Remark Quick Stats and are exported to other applications when 

saving data. 

Mark question as the 

respondent identifier in the 

analysis 

Select the Mark question as the respondent identifier in the 

analysis checkbox to include the question’s responses as an 

identifier on various reports. For example, if you are grading student 

exams and want the students’ ID numbers or names to be on 

analysis reports, you can mark the corresponding question on the 

web form as a respondent identifier. The item must be “ungraded” in 

order to be used as a respondent identifier question.  
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Database Link:   

The Database Link window allows you to establish a link to an external database so that you can extract 

information from that database. It provides an easy way to get external data into your web form’s data for 

analysis. To use this feature, you link a question on the web form to an existing database. Once the data a 

respondent enters is found in the linked database, you can replace it with other information from that 

database (called Append fields). When the data are downloaded, Remark Web Survey looks for the data 

that was entered as the question’s response in the linked database field. Remark Web Survey then outputs 

any selected “append” fields in the data file. If the data are not present in the database field, Remark Web 

Survey fills the data cell with the response that was entered, but does not display any of the append field 

information (which comes directly from the linked database) because the initial response was not found in 

the database.  

For example, suppose you ask respondents for an identification number on a web form. In an external 

database, you have that identification number listed along with other information about each respondent 

(perhaps their name, email address or other demographic information). Using the Database Link feature, 

when the data for the web form are downloaded, Remark Web Survey looks up each identification 

number in the external database and then returns the associated demographic information from the 

database to your Remark Web Survey data file. You can have multiple Append fields if desired. 

The following table describes the database link properties: 

 

Property Function 

Enable database link Mark the Enable database link checkbox to link a question to an 

existing database. This feature allows you to add fields to the 

Remark Web Survey data by outputting information from other 

field(s) within the database. 

Database connection settings Click the Database connection settings link to set up a connection 

to the database you wish to use.  

Type Choose the type of database you wish to use from the Type drop-

down list. 

Browse Click the Open folder to select the database containing the desired 

information. 

DSN If using an ODBC connection, choose the DSN from the DSN drop-

down list. Mark whether it is Directory based or DSN based. 

Username If your database requires a login, enter the Username. 

Password If your database requires a login, enter the Password. 

Connection string Displays the connection string that is working behind the scenes to 

connect to your selected database. You do not need to edit this 

string; it is for informational purposes only. 
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Property Function 

Test Connection You may optionally click the Test Connection button to test 

whether you can connect to this database. 

Table name Use the Table name list to select the table from your database that 

contains the information you wish to lookup. 

Reference field Use the Reference field list to select the field in the connected 

database to which you want to link this question. When the data are 

downloaded, the respondents’ answers are verified against the 

values in this database field. If the response is found in the database 

field, Remark Web Survey outputs the Append value(s). If the answer 

is not found in the database field, Remark Web Survey leaves the 

Append fields blank. Mark the checkbox for Include field in data if 

you want to both lookup and output the Reference field. 

Append fields Use the Append fields list to select a field in the connected 

database to return when the Reference field is verified. To look up 

the value and then replace it with a different database field’s 

information, select the appropriate field(s) in the Append fields list. 

Place a checkmark in the fields you wish to append to the data. Use 

the Alias column to provide a field name for Remark Web Survey to 

use. If desired, mark the checkbox for Respondent ID to include the 

field’s data on select analysis reports. 

  

To use the Database Link feature, first follow the steps below to insert a question. Then click Database 

link in the Question Properties window and enter the information as outlined above.  

If you move the database to a new location or rename it, the link is broken. When this happens two things 

can occur: 

 When opening a web form with a broken database connection, Remark Web Survey detects the 

broken connection and displays a warning screen (if this setting is turned on in the Program 

Options). Click Yes to repair the connection (e.g., 

reconnect to the right database). Click No to 

leave the broken connection as is for this sesion 

and not perform any database linking at this 

time. Click No to All when using multiple 

append fields and you do not desire to utilize 

database linking at this time.  

 Under the Tools tab on the Ribbon there is a 

button called Sync with Database. When you 

set up Database Link, you tell the software 

where to find your linked database. If the database is moved or renamed, use the Sync with 

Database option to quickly relink the database to your web form. When you select this option, a 
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window appears where you can select the database to re-establish the link. This option is 

available when you are in the Data Viewer view. 

Piping Extra Fields of Data Using the Login Page 

Using the Database Linking feature, you can pull in extra information from an external database to be sent 

to your data file and/or piped throughout the web form. This feature works in conjunction with the 

password question on the Login Page. Previously you could set up database linking on the password 

question, but you could not utilize that information in answer piping throughout the web form because 

the database information was not pulled in until the data was downloaded. In version 5.1 and later, once 

you establish the database link, you can also set a field to be used for answer piping. An initial database 

lookup is performed at the time the web form is published so that the data is collected prior to the 

respondent accessing the web form. This step is necessary so that answer piping can occur. Please keep in 

mind that this feature is working off of the current copy of the database that is connected at the time the 

web form is published. If you make changes to that database after the web form is published, you could 

end up with discrepancies. When downloading data, database lookup occurs again on all the fields 

selected to return data to the data set. 

For example, suppose you are doing a course evaluation and along with each student’s ID you have 

course or instructor information in an external database. You can use the password field to validate each 

student and then return the course or instructor from the external file. You could then pipe that 

information into labels on the form to let students know which course and instructor are being evaluated. 

 

To pipe extra fields using the Login page 

 Access the password question’s properties and set up database linking as you normally would on 

any other question on your form. Note that when you first turn on database linking, you are 

automatically connected to the same database you used to import passwords, if one was used. 

You can modify these connection settings as needed without affecting your password list. The 

following table summarizes the database linking properties: 

 

Property Function 

Enable database link Mark the Enable database link checkbox to link a question 

to an existing database. This feature allows you to add fields 

to the Remark Web Survey data by outputting information 

from other field(s) within the database. 

Database connection settings Click the Database connection settings link to set up a 

connection to the database you wish to use.  

Type Choose the type of database you wish to use from the Type 

drop-down list. 

Browse Click the Open folder to select the database containing the 

desired information. 
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Property Function 

DSN If using an ODBC connection, choose the DSN from the DSN 

drop-down list. Mark whether it is Directory based or DSN 

based. 

Username If your database requires a login, enter the Username. 

Password If your database requires a login, enter the Password. 

Connection string Displays the connection string that is working behind the 

scenes to connect to your selected database. You do not 

need to edit this string; it is for informational purposes only. 

Test Connection You may optionally click the Test Connection button to test 

whether you can connect to this database. 

Table name Use the Table name list to select the table from your 

database that contains the information you wish to lookup. 

Reference field Use the Reference field list to select the field in the 

connected database to which you want to link this question. 

When the data are downloaded, the respondents’ answers are 

verified against the values in this database field. If the 

response is found in the database field, Remark Web Survey 

outputs the Append value(s). If the answer is not found in the 

database field, Remark Web Survey leaves the Append fields 

blank. Mark the checkbox for Include field in data if you 

want to both lookup and output the Reference field. 

Append fields Use the Append fields list to select a field in the connected 

database to return when the Reference field is verified. To 

look up the value and then replace it with a different 

database field’s information, select the appropriate field(s) in 

the Append fields list. Place a checkmark in the fields you 

wish to append to the data. Use the Alias column to provide 

a field name for Remark Web Survey to use. If desired, mark 

the checkbox for Respondent ID to include the field’s data 

on select analysis reports. 

 

 To utilize the new answer piping feature, place a checkbox in the Pipe column for any append 

field that you wish to utilize later in the web form for answer piping. 

 Click the OK button.  

 When you are ready to utilize the information you marked as “Pipe” go to the Insert answer pipe 

section of the label, question or answer where you want to insert answer piping. Choose the item 

from the list of available questions. Note that anything from the password question appears as 

[Question] (Password Question Pipe) in the list of choices.  
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To insert question elements 

 Select an insertion point in the tree view. You 

must be within a section to insert a question. 

 From the Ribbon, select the Insert tab and then 

click Question. The Question Properties window 

appears. 

 You must select a Question type and if using 

Checkbox, Option Button or Drop-Down Box style 

questions, you must enter the answer choices on 

the Answers window. 

 If desired, utilize the other properties within the 

Question Properties window, as described 

previously. 

 Note: When typing question text, you can insert hyperlinks by selecting text, right clicking and 

choose Insert Hyperlink from the menu.  

 Click the OK button to save the question.  

The question is added to the tree view and is visible in the HTML Preview window. 

Answer Piping  

Displaying the answer to one question in the text of another subsequent question, label or answer is 

called answer piping. For example, if you ask for the respondent’s name, you can then “pipe” the name 

into another question’s text to make your form appear more personalized (e.g., “John, how would you rate 

your latest customer service experience?”). Note that in order to use answer piping, the question from 

which you are drawing the answer must be on a previous page from the question or label where you are 

adding the answer pipe. 

 Note: Using answer piping in answer elements is covered later in this chapter. 

 

To use answer piping in a question 

 Select an insertion point in the tree view. You must be within a section to insert a question. 

 From the Ribbon, select the Insert tab and then click Question. The Question Properties window 

appears. 

 You must select a Question type and if using Checkbox, Option Button or Drop-Down Box style 

questions, you must enter the answer choices on 

the Answers window. 

 If desired, utilize the other properties within the 

Question Properties window, as described 

previously. 

 Click the Insert answer pipe link. 

 Under Source Question, choose the Question that 

contains the answer you wish to pipe into the 

current question. Remember that the source 
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question must be on a different page than the current question. You may also pipe information 

from the Login page, including Database Lookup fields, if you set that up in your Login page (see 

previous section for more details). When selecting questions, you may display the question by 

question text or field name using the radio buttons for each on the screen. The Answer Pipe 

example window shows you how the question appears in the properties window and on the 

actual web form. 

 Note: If using a Login page, you can use the Username, Name and Email fields 
from the Login page as source questions. 

 Click the OK button to return to the Question 

Properties window. You see the question text from 

the question you inserted as an answer pipe. This 

text is a placeholder for the piped answer. You may 

not change the text. However, you may format the 

text. For example, you can click within the pipe 

placeholder, turn on rich text formatting and apply 

font characteristics to the text. You may also add 

punctuation or other text around the pipe 

placeholder. If you need to delete the answer pipe, 

click anywhere inside of the pipe text and press the 

Delete key on your keyboard. To edit an existing 

answer pipe, click the placeholder text, click Insert answer pipe and then choose a new question. 

The old answer pipe question text is replaced with that of the new question. 

 Click the OK button to save the question.  

 

To use answer piping in a label 

 Select an insertion point in the tree view. You must 

be within a section to insert a label. 

 From the Ribbon, select the Insert tab and then 

click Label. The Label Properties window appears. 

 Enter and format the Label text. 

 If desired, utilize the other properties within the 

Label Properties window, as described previously. 

 Click the Insert answer pipe link. 

 Under Source Question, choose the Question that 

contains the answer you wish to pipe into the 

current label. Remember that the source question 

must be on a different page than the current label. 

You may also pipe information from the Login page, 

including Database Lookup fields, if you set that up 

in your Login page (see previous section for more 

details). The Answer Pipe example window shows 
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you how the label appears in the properties window and on the actual web form. 

 Click the OK button to return to the Label Properties window. You see the question text from the 

question you inserted as an answer pipe. This text is a placeholder for the piped answer. You may 

not change the text. However, you may format the text. For example, you can click within the pipe 

placeholder, turn on rich text formatting and apply font characteristics to the text. You may also 

add punctuation or other text around the pipe placeholder. If you need to delete the answer pipe, 

click anywhere inside of the pipe text and press the Delete key on your keyboard. To edit an 

existing answer pipe, click the placeholder text, click Insert answer pipe and then choose a new 

question. The old answer pipe question text ia replaced with that of the new question. 

 Click the OK button to save the label.  

Once the answer piping is applied to your web form, respondents answer the “source” question, and then 

when they arrive at the question or label in which you included the answer pipe, they see the answer they 

typed into the source question. 

Piping Information into Other Web Forms and URLs 

You can use an Advanced link next to the hyperlink address box, wherever hyperlinks are supported, to 

access the Advanced Hyperlink Builder. Here you can create hyperlink addresses that include answer 

pipes. This feature allows you to pipe one form’s responses into another (e.g., chain web forms together) 

or build custom URLs (web form links) using piped information from the form just submitted (with or 

without using Query Parameters).   

For example, suppose you wanted to have two web forms run in succession. You could use the Advanced 

Hyperlink Builder to take the answers from one form and, using Query Parameters, launch another form 

with pre-filled data. Suppose you collect information on a form such as name and address. In the second 

form you also want to collect that information. However, you don’t want to make respondents type the 

information again. On the second form, you could have Query Parameters set up for this information. 

Then using the advanced hyperlink options, on the first form’s web form complete page, you can set up a 

hyperlink and insert those Query Parameter values into the URL (web form link). The second form 

launches and the name and address information are automatically passed down to the second form. 

Here is another example. Suppose on your form you ask an option button question, “What is your favorite 

online retailer?” On the web form complete page, you can add a label that says, “Take me to my favorite 

retailer.” In that URL (web form link), you can pipe the answer they chose as their favorite retailer into the 

hyperlink so that the website can be launched automatically.  

 

Setting up Advanced Hyperlinks 

 Create the label, question or answer in which you want to insert the hyperlink. 

 Go to the Hyperlink area of that element (accessing hyperlink properties varies based on the 

element you are using. See your main Remark Web Survey user’s guide for general information 

about adding hyperlinks to elements). 
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 Mark the checkbox for Hyperlink. 

 Click the Advanced link. 

 In the Advanced Hyperlink Builder window, build 

your URL (web form link). Use the Insert answer pipe 

link to insert answer pipes. When building the 

hyperlink, use the “?” character to append data values. 

Use the “&” character to separate data values. For 

example, if you want to launch another Remark Web 

Survey form using Query Parameters, you would type: 

http://www.example.com/cgi-bin/rws5.pl?form=MyForm&Course=English, where MyForm is the 

name of the web survey and Course=English is the Query Parameter name and value. The “?” tells 

the software that a data values is coming. The “&” tells the software that a Query Parameter is 

coming next. In our second example from above where we insert a website hyperlink, you would 

type something similar to: “http://www.” and then insert the answer pipe, referencing the 

question where they chose their favorite online retailer. When the respondent takes the survey, 

they would see http://www.favoriteretailer.com. Note that advanced hyperlinks can only be edited 

by returning to the Advanced window. 

 Make sure you test your web form well when using this feature to ensure you have set up the 

hyperlinks correctly. 

Query Parameters 

Using Query Parameters allows you to pass hidden information into a web form. When using textbox 

questions, you can associate a Query Parameter with the textbox. When the URL to the web form is sent 

out, the Query Parameter is appended to the URL. When the web form is submitted, the value for the 

Query Parameter is sent down to the data file.  

For example, suppose you are doing course evaluations. You could set up a hidden textbox question with 

a Query Parameter called Instructor. When sending out URLs to respondents, you could append the Query 

Parameter name plus an instructor’s name to the URL. When students fill out the evaluation, the instructor 

they are evaluating is listed in the data. However, the students do not have to enter this information, thus 

reducing the chance of error (you probably do want to let them know the instructor they are evaluating 

when you send them invitations to fill out your web form). You can even take this one step further if 

students have a web portal. Students could login to the portal and have several course evaluation URLs 

listed with an instructor name. Each URL would have the instructor Query Parameter included, but the 

value would be for different instructors. Students could click each URL to rate the various instructors, but 

would not need to type in the instructor’s name each time. When you receive students’ data, you would 

automatically know which instructor was being evaluated. (In this scenario you would need to let them 

know which instructor they are evaluating in your portal.) 

This functionality is similar to using default fill values in textboxes, but allows you to change the default fill 

on the fly without changing the web form.  

The syntax for the URL when using Query Parameters is as follows: 

http://www.example.com/cgi-

bin/rws5.pl?FORM=formname&queryparametername=queryparametervalue 

In the course evaluation example above, the URL would look like the following: 

http://www.example.com/cgi-bin/rws5.pl?form=MyForm&Course=English
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http://www.example.com/cgi-bin/rws5.pl?FORM=formname&Instuctor=JohnDoe (where John Doe is the 

name of the instructor being evaluated) 

In addition, you can connect a query parameter to a database to retrieve the query parameters. This 

feature is covered below in the email instructions, after the general information about setting up query 

parameters. 

 

To use Query Parameters 

 Create a textbox style question by clicking Insert on the Ribbon and choosing Question. 

 For Question type, select Textbox/Text Area.  

 [Optional] Enter the desired Field Name. 

 [Optional] Enter the desired Question Text. 

 Click the Attributes link in the left side of the 

window. 

 In the Behavior section, mark the checkbox for 

Associate response with the following query 

parameter. 

 Enter a name for the query parameter in the 

associated textbox. We suggest keeping the name 

short as it becomes part of the URL in your web 

form link. 

 Note: The following words are reserved 
and cannot be used to name query 
parameters: FORM, UID, USER, PWD, 
PWDE, POPUPINFO, ENC. 

 Modify any other settings as desired for the question. 

 Click the OK button to save the question. 

 Once the form is published, you can to send out URLs to respondents that include the desired 

Query Parameter value. This value is included in each respondent’s data file. If you send the URLs 

out independently of Remark Web Survey, you need to manually put the query parameter value 

into each email (or merge it). If you send the URLs via Remark Web Survey’s email center, you can 

use advanced options to append the query parameter value. 

 Tip: The Email Center is covered in detail in Chapter 9. You may wish to review this 
section and gain a full understanding of the Email Center before you attempt to 
use it to send Query Parameters. 

In addition to manually inputting query parameter values, you can obtain the values from a database. The 

value of this feature is to make sending emails easier and less time consuming. In addition, the extra fields 

you use when setting up query parameters that are linked to an external database can be used as merge 

fields when creating the email invitation/reminder. 

Let’s take a look at a sample scenario. Suppose you are doing course evaluations at a university and want 

to send links to five different course evaluations to the same recipient. The course evaluation web form is 

the same in each case; only the instructor and course information changes. In your course evaluation you 
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are using Query Parameters to insert a course name and an instructor name. Previously you had to 

generate five emails, each time typing in the course name and instructor name as Query Parameter values. 

Beginning with version 5.1, if you have the course and instructor names in an external file, such as a 

database or spreadsheet, you can link to that database file. Then you tell the software which fields contain 

the course and instructor information. The students’ email field in the same external file is the key piece of 

information that tells Remark Web Survey what to send. In your external file, you need each student’s 

email listed as many times as you have courses and instructors for that student. When the emails are sent, 

Remark Web Survey automatically inserts the course name and instructor name to the URL based on each 

student’s email address. You have the choice of sending one email with all web form invitation URLs or 

separate emails, one for each web form invitation URL. If using a Login page, we recommend using one 

external file to hold both respondent passwords and Query Parameter values. 

To send emails using Query Parameters 

 When the web form is finalized, published and tested (e.g., you are ready to go live), access the 

email center from the Ribbon by selecting the Tools tab. 

 Click the down arrow on the Send Invitations button and choose Advanced. 

 The Advanced Invitation Setup window appears. 

 [Optional] If the web form is password protected and you wish to embed the password (and 

username if applicable) into the URL invitation, click the Include the web form credentials 

(username/password) in the web form link(s) 

checkbox. If the web form is not password 

protected or you do not want to embed the 

credentials, skip to step 5. 

 Mark the Include predefined Query Parameters 

in the email message checkbox.   

 [Optional] To use new database linking feature, 

mark the Dynamically retrieve the values from 

a database checkbox. This option tells the 

software that you are going to utilize an external 

database to populate your Query Parameter 

values (as opposed to typing each value 

manually).  

 If you have email addresses listed multiple times in your external database file (whether it’s from 

the Login page or a new file you will link to in the next step), determine whether you want the 

recipient to receive multiple emails or a single email.  

 Send a single email to each recipient containing all associated web form links: This 

option sends one email to every recipient. The email contains all related web links. If multiple 

people are associated to the same email address, only one email is received. 

 Send multiple emails to each recipient, one for each associated web form link: This 

option send separate emails to each recipient, each email containing only a single link. 

 Click the Next button to continue.  
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 If you are retrieving query parameters from a database, the Database Lookup Method window 

appears where you can choose how you want to 

identify respondents (if you are not using this 

method, skip to step 16): email address, 

username or password. This step is particularly 

important if respondents are listed multiple 

times in the database. In order for the correct 

web form links to be generated, you should 

validate respondents based on more than one 

criterion. For example, in our course evaluation 

sample, email addresses would be listed five 

times in our database because we are sending 

links to five course evaluations. In order to 

ensure the links go to the right course, you 

could validate respondents based on both email 

address and password. Alternatively you could validate respondents based on username and 

password. Note that the email address and username options are mutually exclusive. By validating 

on more than one item, you are helping the software build the proper web form links. 

 Click the Next button to continue. In the 

Database Connection window, you can specify a 

database that contains the Query Parameter 

values. By default, if you have not yet gone 

through this wizard and chosen another 

database, Remark Web Survey connects to your 

Login page database. To ensure accuracy we 

recommend using the same database for the 

Login page and Query Parameter values. 

However, if you wish to change the database 

connection, click the Database connection 

settings link.  

 Note: If you are unsure of the database 
being used, hover your mouse over the 
Connection state text to see the path and file name. 

 The following items can be configured: 

 

Property Function 

Type Choose the type of database you wish to use from the Type 

drop-down list. 

Browse Click the Open folder to select the database containing the 

desired information. 
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Property Function 

DSN If using an ODBC connection, choose the DSN from the DSN 

drop-down list. Mark whether it is Directory based or DSN 

based. 

Username If your database requires a login, enter the Username. 

Password If your database requires a login, enter the Password. 

Connection string Displays the connection string that is working behind the 

scenes to connect to your selected database. You do not 

need to edit this string; it is for informational purposes only. 

Test Connection You may optionally click the Test Connection button to test 

whether you can connect to this database. 

 

 If you need to modify the fields listed in the Database Connection window, choose the 

appropriate values from your external file for Table, Email field and Password field. 

 Use the Table name list to select the table from your database that contains the information 

you wish to link. You must have a valid email addresses for each recipient to use as the basis 

of this operation. 

 Choose the field containing the email addresses that correspond to your web form recipients 

under Email field. The email address is your link from respondent to Query Parameter value. 

Each email address in the external database should have a corresponding field that contains 

the Query Parameter value you want to include. Continuing with our course evaluation 

example, if each student is going to complete five course evaluations, the email address 

would be listed five times, each time corresponding to a different instructor/course 

combination. 

 Choose the field containing the respondents’ passwords under Password field. 

 Click the Next button to continue. 

 In the Query Parameters window, the table displays the Query Parameters you have defined in 

the web form. Place a checkmark in the Include column for any Query Parameters you wish to 

include when sending this email. 
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 To retrieve values from a database: For each 

Query Parameter listed, go to the Values 

(Database) column and choose the field from 

your external database that contains the value 

you wish to insert. In our course evaluation 

example, you may have fields for instructor and 

course in your database. You would choose th 

ose fields respectively as database Query 

Parameter values for the Query Parameters you 

have set up. 

 To enter values: Manually enter the desired value 

in the Parameter Value box. In our course 

evaluation example, you would enter the 

instructor’s name as the Parameter Value.  

 [Optional] If you want the Query Parameter to be encrypted (masked) mark the Encrypt the 

query parameter values within the web form link(s) checkbox. This option encrypts the value 

you insert for each Query Parameter so that respondents cannot decipher it in the web form 

invitation/reminder URL (web form link). 

 Click the Next button to continue. 

 [Optional] Use the Use Friendly Text option to 

enter a friendly URL (web form link or address) 

for the email. Query Parameter values are 

appended to the web form address. The 

addresses can get long and a bit cumbersome. 

Friendly web form addresses are more 

aesthetically pleasing to the recipient but are 

optional. When you build friendly web form 

addresses, you have the option of inserting the 

Query Parameter values into the address by 

clicking the down arrow on the Insert button. 

For example, you could use a friendly web form 

address of http://www.example.com/courses/ 

and then insert the course name. This feature 

provides a way to show recipients the Query Parameter value within the web form address. Note 

that if you have chosen to encrypt the Query Parameter values in step 15, they are still encrypted 

when using a friendly web form address (the base of the address is not encrypted; only the Query 

Parameter values). In addition, the friendly web form address doesn’t have to be a link at all; you 

can type text in this box, such as “Click here to begin your evaluation.” When the email is sent, it is 

turned into a hyperlink, pointing to your web form’s address. 

 Note: Friendly Web Form Addresses are not saved within email templates. If you 
wish to use an email template and friendly text, use the Advanced Email Wizard 
first, then apply your email template. 
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 Click the Finish button to launch the email message. At this point you can follow the general 

instructions for sending emails. The email window is covered in Chapter 9 in the main Remark 

Web Survey 5 User’s Guide.  

 Note: We strongly suggest you take advantage of the new Email Preview feature to 
ensure you have set up Query Parameters correctly. Using this feature you can 
cycle through the emails that are sent, prior to sending, to ensure the web form 
links have been properly built.  

 Tip: You could build a “cover” page with instructions for completing the form. On 
that cover page could be the hidden Query Parameter question. The value for that 
Query Parameter could then be passed to a label through Answer Piping on the 
header of every page. In the course evaluation example described previously, the 
header could display the instructor being evaluated, which would be piped from 
the Query Parameter on the first page. 

Answer Element Properties 
When you insert a question on the web form, you can set up the answer choices, which become answer 

elements in the tree view. The answer elements can be further defined through the Answer Properties 

window. You can access this window in one of three ways: 

 Double click an answer element in the tree view. 

 Right click an answer element in the tree view and select Properties from the 
menu. 

 Select an answer element in the tree view and then select Properties from the 
View tab in the Ribbon. 

The following items can be customized through the Answer Properties window: 

 

Property Function 

Field name Use the Field name to create a name for the answer, which is used 

as a column header in the data grid. Setting field names for 

individual answers is most useful when using Checkbox or Drop-

Down Box style questions that output the answers in separate data 

grid cells. This feature allows you to give each answer choice a 

unique field name for clarity and/or matching data to an existing 

external database or file. When planning to export data, be sure to 

follow your export format’s guidelines for field naming conventions. 

In addition, if you are saving data to an existing database file, be 

sure to match your field names in Remark Web Survey to those in 

the existing database. 

HTML display Use the HTML Display column to enter the text for answer choices 

as you want it to appear on the web form. This list controls the 

display of answer choices to your respondents. HTML Display text is 

limited to 10,000 characters. 
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Property Function 

Insert answer pipe Click the Insert answer pipe link to set up answer piping. Answer 

piping displays information gathered from a different question on 

the web form within the answer text. For example, if you ask 

someone who just purchased a new car the color they chose, you 

can then “pipe” the color into another question’s answer to make 

your form more personalized (e.g., ”How much did the color silver 

influence your decision to purchase this car?”).  

Enable rich text formatting Mark the Enable rich text formatting checkbox to display the 

answer text in Rich Text format. Use the box above the checkbox to 

format the text. Rich text provides more formatting options than 

plain text (e.g., font sizes, types and colors). Rich text formatting 

overrides any other formatting options. See Chapter 7 for further 

details. 

Display an associated image or 

answer illustration 

To use an image as part of your answer display to respondents, 

mark the Display an associated image or answer illustration 

checkbox. Then click the image icon next to the box and choose the 

desired image file. Supported file formats include JPG/JPEG, GIF and 

PNG. Using images as answer items is described in greater detail in  

Data label Use the Data label box to enter the answer choice as you want it to 

appear in the resulting data file. The HTML Display is what the 

respondents see when filling out the form and the Label is what 

goes into the data set behind the scenes. The following characters 

are not allowed for answer data labels: “'+,=(). Data labels are 

limited to 240 characters. 

Value Change or enter the numeric Value associated with the Label. 

Values are used to calculate statistics and are exported to certain 

file formats, such as SPSS. When you are creating questions, the 

Values are automatically entered into the Values column 

sequentially as you type in the HTML Display and Labels columns. 

You may modify the Values as desired, but each answer choice’s 

value should be unique. When grading tests, values are not used to 

calculate points earned (this is handled in the “Analysis” section of 

the question properties window). Note that the Values property is 

not visible when using the Numeric data type on the Question 

Properties|General window. 

Preselect answer choice by 

default 

Mark the Preselect answer choice by default checkbox to 

preselect the selected answer choice when the web form page is 

displayed to the respondent. Respondents can still choose another 

answer choice, but the preselected answer choice is automatically 

selected if they do not choose a different answer. 
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Property Function 

Append a textbox/text area to 

this answer 

Mark the Append a textbox/text area to this answer checkbox to 

automatically append a textbox to an answer choice. This option is 

most useful when you have a multiple choice style question that 

allows for an “other” option (e.g., select your favorite color: Red, 

Blue, Green, Other). The textbox/text area allows respondents to 

write in another response. You can have just one textbox/text area 

or multiple textboxes/text areas per question. When the data are 

collected for the question, the typed text is placed in the data cell in 

place of the word “other” (or whatever word you use to define that 

answer choice). You can also enter default fill in the appended other 

box that respondents see. They can type over this text; if they do 

not, it is passed down to your data. 

Treat appended item’s answer 

as a separate question with 

field name 

Mark the Treat appended item’s answer as a separate question 

with field name checkbox to have the “other” text entered into the 

textbox be its own data field. Without this option marked, the data 

replaces the answer choice that was defined. For example, if the last 

option button for the question is “Other”, treating the appended 

textbox as a separate question gives you one data cell with the 

word “Other” and a separate data cell with the write-in text from 

the respondent.  

Mark appended answer item as 

required 

Mark the Mark appended answer item as required checkbox to 

ensure that if respondents choose the “Other” textbox’s answer 

choice, they must also fill something in for the appended textbox. If 

they select the option for “Other” but do not put something in the 

appended textbox, they receive an appropriate error message when 

they submit the page. 

Set the maximum length of 

response characters to 

Mark the Set the maximum length of response characters to 

checkbox to limit the number of characters allowed for a 

Textbox/Text Area style question. Enter the maximum number of 

characters allowed in the box. For a textbox (single line of free text) 

respondents are not able to enter more characters than you allow. 

For a text area (multiple lines of free text), respondents receive an 

appropriate error message when they submit the web form page if 

they entered too many characters. 

Max exceeded error message Click the Max exceeded error message link to customize the error 

message that respondents see when they submit a web form page 

with either too many answer choices selected (Checkbox or Drop-

Down Box style question) or too much text entered (Text Area style 

question). If you do not customize the message, a default message 

is displayed. 
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Property Function 

NA label If your question has a “Not Applicable” (NA) answer choice and you 

do not want the NA responses to be included in the Remark Quick 

Stats statistics (e.g., means), mark the NA label checkbox for the 

appropriate answer choice.  Only one answer can be selected as NA 

per question. In the Remark Quick Stats preferences you can choose 

whether to include or exclude the NA responses.  

Hyperlink Mark the Hyperlink checkbox to have the answer display as a 

hyperlink. Then type the hyperlink into the box using a fully 

qualified URL or select a question or page from the list. Use caution 

when setting up answers as hyperlinks; respondents navigate away 

from the current page. However, the hyperlink for answer choices 

always displays in a new browser window. 

Format Use the Format button to format the style of the answer choice. 

Formatting is covered in detail in Chapter 7. 

 

To insert answer elements 

 Select an insertion point in the tree view. You must 

be on a question or answer element to insert an 

answer element. 

 From the Ribbon, select the Insert tab and then click 

Answer. The Answer Properties window appears. 

 None of the properties in the Answer Properties 

window are required. You typically want to fill in the 

HTML Display, Label and Value, but all properties 

are optional. 

 Click the OK button to save the answer.  

The answer is added to the tree view and is visible in the 

HTML Preview window. 

Using Images as Answer Elements 

As described in the previous table, you may use an image as part of the answer that you display to 

respondents. For example, suppose you want to display a product image or mathematical equation; you 

could insert an image as part of the answer choice. Images can be in the JPG/JPEG, GIF or PNG formats. 

The image can be placed to the right, left, top or bottom of the HTML Display text (if you have entered 

HTML Display text). 
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To insert images as answer elements 

 Select an insertion point in the tree view. You must be on 

a question or answer element to insert an answer 

element. 

 From the Ribbon, select the Insert tab and then click 

Answer. The Answer Properties window appears. 

 If desired, type in a Field Name and the HTML Display 

text.  

 Mark the checkbox for Display an associated image or 

answer illustration. 

 Click the image icon next to the checkbox. 

 Click the Select image hyperlink. 

 Choose the desired image. Images can be in the following 

formats: JPG/JPEG, GIF, PNG. 

 The original dimensions are displayed. If you wish to adjust 

the dimension, enter new pixel values in the Height and 

Width boxes. If you want the aspect ratio to remain the 

same between width and height, mark the Maintain aspect 

ratio checkbox. As you adjust width or height, the other 

adjusts automatically. Please note that making adjustments 

to the size within Remark Web Survey does not affect the 

original image. 

 If desired, enter alternate text in the Alternate text textbox. 

This text appears while the image is loading and when you hover the mouse over the image, and 

can be read by screen readers (this is useful if you want web forms to be Section 508 compliant 

for handicapped persons). 

 If desired, mark the checkbox for Hyperlink and then enter a hyperlink (fully qualified URL) in the 

associated textbox. A hyperlink is applied to your image, meaning that if someone clicks the 

image, they are redirected to another web page in a new browser window. Please note that it is 

possible to add hyperlinks for the image element as well as the answer element as a whole (on 

the previous screen). The hyperlink applied to the image element only takes effect when the 

image is clicked. The hyperlink applied to the answer element only takes effect when the HTML 

Display text is clicked. 

 Click the OK button to save the image element information. 

 Continue defining any other desired properties for the answer element. 

 Click the OK button to save the answer element.  

The answer is added to the tree view and is visible in the HTML Preview window. In the tree view, you see 

the name of the image file you selected. If you wish to format the position of the image (left, right, top or 

bottom of the HTML Display text), double click the answer node in the tree view and then click the 

Format button. For Image Position select Left, Right, Top or Bottom. 
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 Note: You may need to adjust the answer element’s line break property to get the 
image and HTML Display text to appear just as you wish. 

Answer Piping with Answer Elements 

Answer elements can also have answer pipes within them. Displaying the answer to one question in the 

text of another subsequent question, label or answer is called answer piping. For example, suppose you 

are surveying new car owners. You ask a question on page one about the color of the car they purchased. 

Then on page two, you ask a question about what influenced their decision to purchase the car. One of 

your answer choices could include the color of the car they purchased. You would use answer piping to 

“pipe” in the color they entered on page one of the survey. Note that in order to use answer piping, the 

question from which you are drawing the answer must be on a previous page from the answer where you 

are adding the answer pipe. You may also use answer piping as a default fill for a textbox answer. 

 

To use answer piping in an answer 

 Insert a question or individual answer element, as described in previous sections. 

 Go to the answer item to which you wish to add the answer pipe. You can get to the answer 

item’s properties either through the question properties window or the answer properties 

window: 

 

Question Properties Window Answer Properties Window 

a. Go to the Answers portion of the Properties 

window. 

b. In the answers grid, select the answer to 

which you wish to add the answer pipe. 

c. Click Access current answer’s properties. 

d. Click Insert answer pipe. 

a. Click Insert answer pipe. 

 

 Under Source Question, choose the Question that contains the answer you wish to pipe into the 

current answer. Remember that the source question 

must be on a different page than the current 

question. When selecting questions, you may display 

the question by question text or field name using the 

radio buttons for each on the screen. The Answer 

Pipe example window shows you how the answer 

appears in the properties window and on the actual 

web form. 

 Note: If using a Login page, you can use the 
Username, Name and Email fields from the 
Login page as source questions. 
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 Click the OK button to return to the Answer Properties window. You see the  question text from 

the question you inserted as an answer pipe. This 

text is a placeholder for the piped answer. You may 

not change the text. However, you may format the 

text. For example, you can click within the pipe 

placeholder, turn on rich text formatting and apply 

font characteristics to the text. You may also add 

punctuation or other text around the pipe 

placeholder. If you need to delete the answer pipe, 

click anywhere inside of the pipe text and press the 

Delete key on your keyboard. To edit an existing 

answer pipe, click the placeholder text, click Insert 

answer pipe and then choose a new question. The 

old answer pipe question text is replaced with that of the new question. 

 Click the OK button to save the answer.  

Once the answer piping is applied to your web form, respondents answer the “source” question, and then 

when they arrive at the question containing the answer in which you included the answer pipe, they see 

the answer they typed into the source question as part of the answer text. If you choose to append an 

“other” textbox to a question, you can enter default fill text (pre-defined text) in the appended textbox. 

This text is visible to the person responding to your web form. Any default fill data is passed data down to 

your data set if the respondent does not replace it. 

 

To enter default fill text 

 Insert a question with an appended other textbox.  

 Next to the item Append a textbox/text area to this 

answer with the following default value type the 

desired default fill text. 

 Click the OK button twice to save your changes. You now 

see the default fill text in the browser view. 

Question Tables 
Questions that have the same answer set and/or are of the same type (e.g., all option buttons) can be 

placed in a question table. A question table places the questions in table format as opposed to one after 

the other down the page. For a question and answer set to be the same, the number of answer choices 

must be the same, and the HTML Display choices must be identical.  

When it comes to question tables, there are two concepts: 

 Placing questions with the same answer choices in a table format 

 Placing questions with the same answer choices in multiple tables, also known as 
side-by-side tables 

These two concepts are described separately. 
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Table Formatting 
When you have questions that use the same answer scale, you may wish to place them in a table format 

instead of one by one down the web page. Only questions of the same type can be placed in a table 

format (e.g., all option buttons or all checkboxes). 

 Note: This section discusses inserting and modifying question tables, including 
question text, answer items and so forth. It does not cover the style properties that 
are available for question tables (e.g., shading rows and columns, fonts, table 
alignment, etc.). Please see Chapter 7 for detailed information about the options 
that are available when formatting question tables. 

The following example shows option button style questions in a table: 

 

 

 

 

 

 

 

 

The following 

example shows the same option button style questions, but not in a table: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The following criteria must be met in order to place questions in tables:  

 Questions must be of the same type (e.g., all option button responses) 

 Questions must have the same set of answer choices 
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 Questions may not have the option to treat each answer choice as a separate question 

enabled 

There are two ways you can place questions in a table format:  

 Placing existing questions in a table by right clicking the questions and choosing Insert into 

question table 

 Inserting a question table from the Ribbon 

 

To format existing questions 

 Select the questions you wish to place in a table. You can 

multi-select questions by holding down the Ctrl or Shift 

key as you click them in the tree view. 

 With all questions selected, right click the mouse and 

choose Place in Question Table from the menu. 

 Note: Do not release the Ctrl or Shift key until 
after you right click the mouse. 

The questions are automatically placed into a table. You may edit 

the table by clicking the Question Table node in the tree view. The 

Question Table Properties window appears.  

 

To format questions in a table using the ribbon 

When inserting a question table, you add the questions and answer choices using the Question Table 

Properties window.  

 From the Insert tab in the Ribbon, select the down arrow on the Question button and click 

Question Table. The Question Table Properties window opens. 

 Click the Insert Row button to insert a row that holds 

your question text. The Question Text Editor appears. 

 In the Question Text Editor window, type the question 

text for the question and format it as desired. Question 

text is limited to 10,000 characters. 

 Note: Answer Piping is allowed in questions 
that are placed in Question Tables using the 
Insert pipe link. It is used the same as when inserting single questions. You are not 
be able to add the piping until after you add the question (click the question text 
to return to the Question Properties window for editing).  

 Repeat steps 2 and 3 to insert more questions if desired. 
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 To insert answer items for the questions, click the Insert Answer Group Column button. The 

answer columns represent the answer choices for each question. The answer column applies to all 

questions within the table (although you can remove answer items for individual questions). If you 

are simply formatting questions with the same scale in a table, you only insert one answer 

column.  

 In the Question type drop-down box choose the type of 

question you are inserting: Textbox/Text Area, Checkbox, 

Option Button, Drop-Down Box. 

 Choose the Data type: Textual or Numeric. 

 If desired, enter a Table Header. The table header is 

placed above the answer choice labels in the table and is 

optional. Table Headers are limited to 10,000 characters. 

 Click the Answers item on the left of the Answer Group 

Properties window. 

 If using a Checkbox, Option Button or Drop-Down Box 

question type, enter the HTML Display, Labels and 

Values (or select a pre-defined list).  

 If desired, utilize any of the other properties in the 

Answer Group Properties window. 

 Click the OK button to insert the answer group.  

 Click the OK button again to insert the question table.  

The questions are automatically placed into a table. You may edit the table by clicking the Question 

Table node in the tree view. The Question Table Properties window appears. 

 Note: To format the style of the question table, click the Format button. See 
Chapter 7 for detailed information about formatting.  

Side-by-Side Tables 
Remark Web Survey provides the ability to place two or more tables of questions side-by-side. This 

feature is useful when you want to ask the same set of questions for two different purposes. For example, 

a respondent may answer the same set of questions for ranking areas of satisfaction and how important 

each area is to him or her. When adding multiple question sets using the Question Table Properties 

window, you may use two different types of answer formats. For example, you can use option buttons to 

rank satisfaction and then textboxes to allow the respondent to enter supporting comments. 

The following is an example of a side-by-side table with the question text in the middle.  

 

 

 

 

 

 



 

112 

 

 

Side-by-Side table formatting is accomplished by using the same Question Table Properties window as 

described in the previous section. When pairing questions, you enter the question text once and then add 

as many answer columns as you wish. The individual answer columns can contain different styles of 

answers (e.g., checkboxes and option buttons). 

 

To format questions in side-by-side tables 

 From the Insert tab in the Ribbon, select the down arrow on the Question button and click 

Question Table. The Question Table Properties window opens. 

 Click the Insert Row button to insert a row that holds your question.  

 In the Question Text Editor window, type the question text for the question and format it as 

desired. Question text is limited to 10,000 characters. 

 Repeats steps 2 and 3 to insert more questions if desired. 

 Click the Insert Answer Group Column button. The 

answer columns represent the answer choices for each 

question. Insert multiple answer columns to create 

more question groupings. The answer column applies 

to all questions within the table (although you can 

remove answer items from individual questions). 

 In the Question type drop-down box choose the type 

of question you are inserting: Textbox/Text Area, 

Checkbox, Option Button, Drop-Down Box. 

 Choose the Data type: Textual or Numeric. 

 If desired, enter a Table Header. The table header is 

placed above the answer choice labels in the table and is optional. Table Headers are limited to 

10,000 characters. 

 Click the Answers item on the left of the Answer Group Properties window. 

 If using a Checkbox, Option Button or Drop-Down Box question type, enter the HTML Display, 

Labels and Values (or select a pre-defined list).  

 If desired, utilize any of the other properties in the Answer Group Properties window.  

 Click the OK button to insert the answer group. 

 Repeat steps 5 – 12 to insert additional  

answer groups. Note that the same question text applies to all answer groups. 
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 Once you have created all of the answer groups, to position 

them, click the header of the answer column in the grid and 

then use the mouse to drag and move the groups 

around. The order in which you see them in this 

window is the order in which they appear on-screen. 

 To position the question text, enter the column in 

which you want the question text in the Question text 

position box. If you have two answer columns and 

want the question text to appear in the middle of them, 

enter 1 in this box. (A position of 0 indicates the 

question text is all the way to the left.) 

 Click the OK button to insert the question table.  

The questions are automatically placed into a table. You may 

edit the table by clicking the Question Table node in the tree view. The Question Table Properties 

window appears.  

 Note: Each answer group does not have to have the same number of answer 
items. Also, each question does not have to correspond to every answer group. For 
example, if you have two answer groups set up, you could have a question (or 
questions) within the table pertain to only one of the answer groups by deleting it 
from the particular answer group.  

Modifying Question Tables 
Once the table is set up, you cannot change certain features for individual questions, such as the actual 

answer choices (they must remain constant). However you can change properties such as formatting, 

whether a question is required, whether to grade or tabulate a question, etc. 

 

To modify a question table 

 Double click the table node that you wish to modify in the 

tree view. Tables are represented by the syntax Question 

Table (5) in the tree view, where the number in 

parentheses is the number of questions in the table. Use 

the Question Table Properties window to make 

modifications. 

 To modify question text, click the question’s link in the 

Question Text cells to display the Question Text 

Editor window. Question text is limited to 10,000 

characters. 

Click here to drag the 

column 
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 To modify individual answer items, click the Edit link within the answer column. Choose 

Delete to remove the answer item. Choose Import to import an existing question from the 

web form into the answer column. Note that only questions that have the same format as the 

existing answer column are available for importing (see 

Chapter 6. for further details). Choose Properties to edit 

the answer item. When accessing properties, you are 

able to modify the properties on the Attributes and 

Analysis windows only. 

 To modify an entire group of answer items, highlight the 

answer column and then click the Modify Answer 

Group Column button at the top of the window. The 

Answer Group Properties window appears, where you 

can change question types, modify answer choices, 

format text, etc. Changes made with this method affect 

the entire answer group. 

 Click the OK button when you are finished modifying the question table. 

Importing Questions into a Question Table 

When clicking the Edit link within an answer item in a question table there is an option called Import. This 

option allows you to import a question from another area of the web form into the question table. You 

can import a copy of the question or move the question from its original position to the question table. 

You have the choice of overwriting an existing question in the table or importing the question as a new 

question in the table. You may only import questions that are not currently within a question table. 

 

To import questions into a question table 

 Insert a question table or double click the table node that you wish to modify in the tree view. 

Tables are represented by the syntax Question Table (5) in the tree view, where the number in 

parentheses is the number of question rows in the table. Use the Question Table Properties 

window to make modifications. 

 Determine whether you want to overwrite an existing 

question or insert a question into the table as a new 

question. To modify an existing question, click the Edit link 

within the corresponding answer column. To add a question 

to the table, click Insert Row to insert a placeholder for the 

question you will import and then click the Edit link in the 

corresponding answer column. In either case, then choose 

Import from the Edit menu to import a question into the 

table. 

 Select a question from the drop-down list titled Question to 

import. Note that only questions with the selected answer scale (listed in the Import 

requirements section of this window) are visible in the drop-down list. 
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 If you would like to import a copy of the question and 

also leave the question in its original position, mark the 

checkbox for Import a copy of the selected question. 

 Click the Import button. 

 If you are not importing a copy of the question, a 

prompt appears confirming that you want to import the 

question and remove it from its original position. Click 

Yes to import the question or click No to return to the Question Table Properties window. 

 If you selected an existing question to overwrite with the imported question, when you click Yes 

in step 6 (or if you are importing a copy of the question), a prompt appears asking if you wish to 

overwrite the question text of the selected question. You have three options: 

 Click Yes to overwrite the existing question text in the table with that of the question you are 

importing. 

 Click No to keep the question text that is already 

in the question table, but still import the question 

(even though your answer items are the same as 

the existing question, any other attributes are be 

imported). 

 Click Cancel to cancel the import and return to the Question Table Properties window. 

 Click the OK button to complete the import and close the Question Table Properties window. 

Extracting questions from a question table 

You may extract questions from a question table, in which case they are pulled out of the table and listed 

in the tree view beneath the table. When you extract questions from a table, the questions utilize the page 

style attributes defined in the Format Options window. 

 

To extract a question from a question table 

 Expand the question table in the tree view until you can see the question text of the question(s) 

you wish to extract. 

 Select the question(s) you wish to extract. 

 Right click the mouse and then choose Extract Question 

from Table from the menu. The question(s) are removed 

from the table and added to the tree view after the 

question table. 

Hiding questions in a Question Table 

You may hide a question or questions that are placed within a 

question table. If your table only contains one answer column, 

hiding the question causes it to disappear altogether. If your table 

contains multiple answer columns and you only hide the question 

for one of those answer columns, the question still appears for the 
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other answer columns. You can also hide all questions within a table to hide the table from view 

altogether. 

 

To hide questions within a question table 

 There are two ways to access the hidden attribute for questions within a question table: 

 Option 1: 

a. Open the table’s properties by double clicking it in the tree view. 

b. Locate the question you wish to hide and click the Edit link under the answer group that 

contains the question you wish to hide. 

c. Select Properties. 

d. Select the Attributes link on the left. 

e. Mark the option for Hide question from respondent. 

f. Click the Yes button when the confirmation message appears. 

 Option 2: 

a. Expand the question table in the tree view. 

b. Expand the question or questions you wish to hide. 

c. Double click a single question to view its properties. Or, hold down the Ctrl key on the 

keyboard and select multiple questions. While still holding down Ctrl (if multiple 

questions are selected), right click and choose Properties. 

d. Select the Attributes link on the left. 

e. Mark the option for Hide question from respondent. 

 Click the OK button to return to the tree view. 

The question is now hidden in the browser view. 

Form Buttons 
The various form pages can have a combination of buttons on them depending on the purpose for the 

page. By default, each page type has certain buttons added automatically. Buttons are added to their own 

Page Buttons section to help make positioning them easier. The button section has 10 columns by default 

so that you can move the buttons around to suit your needs. You can adjust the section settings as 

desired. The functionality of each button type is described below. Each button can be titled with any text 

that you like, but some of the common uses are below. 

 Submit/Next: Submits all data on the current page. This button can be titled Submit, Next, 

Send Reminder (Session Pause pages), Login (Login pages), etc. 

 Reset: Resets all data on the current page to its original state (blank). 

 Back: Takes the respondent back to the previously loaded page. All data that was submitted 

from this page is displayed. 
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 Session Pause: Pauses the web form at the current submission point and allows the 

respondent to enter an email address to which a reminder is sent with a link back to the web 

form for completion. If using a Session Pause page, you need to place Session Pause buttons 

on at least one Standard page of your web form. 

The following table summarizes the buttons that are available and automatically added for each page 

type: 

 

Page Type Buttons Available Buttons Added by Default 

Standard Pages Submit/Next, Reset, Session 

Pause, Back 

Submit/Next, Reset 

Login Pages Login (Submit/Next), Reset Login (Submit/Next), Reset 

Web Form Complete 

Pages 

None None 

Confirmation Pages Submit/Next, Back Submit/Next, Back 

Session Pause Pages Reset, Back, Send Reminder 

(Submit/Next) 

Reset, Back, Send Reminder 

(Submit/Next) 

Server Error Pages Back Back 

Popup Info Pages None None 

 

You may customize the look of any of the buttons placed on a form. You may use standard text buttons 

or import images of your own. If you import images, they must be in the GIF, JPG or PNG formats. These 

images are buttons that you have created on your own outside of the Remark Web Survey software. 

 Tip: When creating multi-page web forms, we recommend that you put a back 
button on the pages. If the respondent attempts to use the web browser’s back 
button a page sequence error occurs. You may wish to instruct respondents to only 
use the page’s back and next buttons. 

 

To select what type of button to use 

 Insert the desired page type. 

 Expand the Section – Page Buttons node in the tree view. The default buttons are listed. 

 Double click a button to modify it. Alternatively, right click a button and choose Properties, or 

select a button and choose Properties from the View tab on the Ribbon. 
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 If using standard buttons, under Basic settings, select 

the type and accept or enter custom text for the 

button. 

 If using your own images, enter the button text first, 

and then mark the checkbox for Display button as 

image. Note: the text entered for button images 

appears when the respondent hovers the mouse over 

the button (also called Alternate text). This text is 

useful for creating Section 508 compliant forms so 

that screen readers can pick up the text for each 

button. 

 Under Button preview, click the link for Select 

image. 

 Locate the desired button image and then click the Open button. 

 If desired, use the Column setting to modify the position of the button. The number of columns 

listed here is dependent upon the number of columns in the section. The lowest column number 

places the button to the left of the screen, while the highest column number places the button to 

the right of the screen. 

 

To insert a button 

 Select a section in which to insert the button. 

 From the Ribbon, select the Insert tab and then click Button. The Button Properties window 

appears. 

 Choose the type of button and format it as desired, as outlined in the previous steps. 

 Click the OK button to save the button.  

The button is added to the tree view and is visible in the HTML Display. Buttons have their own set of 

format options in order to adjust the style. See Chapter 7 for detailed information about how to format 

buttons. 

 Tip: If you want to view properties for all button types at once, from the Ribbon, 
go to Home, click Select and then click Buttons. From here, you can choose all 
buttons or specific button types and then choose an action (such as right clicking 
and choosing Properties). 

 

 

 

 

 



 

119 

 

Headers and Footers 
You may add headers and footers to your web form that can include images, text labels, lines and 

multimedia. Headers and footers are useful for static information you want to display either at the top 

(header) or bottom (footer) of a web form. Once a header or footer is created, you can choose which 

pages you want the header and/or footer to appear on within a web form. By default, headers and footers 

are turned on for all standard pages. Therefore, if you define a header and footer, they automatically 

appear on each web form page. You can turn off the header and footer for any individual page by going 

into the page’s properties. The header and footer nodes are added to the tree view every time you create 

a new web form. To use them, add elements to the header and/or footer and then determine which pages 

include the header and footer. 

 Note: If adding multimedia files to the header or footer, the video or audio clip 
restarts every time a new web page within the web form loads. 

 

To format the header or footer 

The only item you can format on a header or footer is the number of columns. By default, they have one 

column. If you would like to adjust this setting so that you can place elements in the header or footer 

going across the page (in columns), you can access the header or footer’s properties and then change the 

column setting. 

 Access the header or footer properties by either double 

clicking the header or footer node in the tree view, right 

clicking the header or footer node in the tree view and 

then selecting Properties or selecting the header or 

footer node in the tree view and the selecting 

Properties from the View tab in the Ribbon. 

 Change the Columns setting to the desired number of 

columns (if you want more than one column). 

 Click the OK button to save the changes. You may now 

start adding elements to the header or footer. 

 

To add elements to the header or footer 

 Click the header or footer in the tree view to select it. 

 From the Ribbon, select the Insert tab and then choose the element you wish to insert: Label, 

Image, Line or Multimedia. 

 Enter or adjust the properties of the element, as described in the previous sections of this chapter. 

If desired, click the Format button to further format the element (e.g., color, positioning, etc.). 

Detailed information on Style Properties is found in Chapter 7. 

 Click the OK button to save your changes.  

The added element is added to the header or footer section of the tree view and is visible in the HTML 

Preview. 
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To display headers and footers on web form pages 

Once you have set up a header or footer, you may choose the pages on which to display the header or 

footer. By default, headers and footers are turned on for all standard web form pages. 

 Access a page’s properties by either double clicking the page node, right clicking the page node 

and selecting Properties or clicking the page node and then selecting Properties from the View 

tab in the Ribbon. 

 Note: You may place headers and footers on multiple web form pages at one time 
by either: 1) clicking each page node in the tree view while holding down the Ctrl 
key on the keyboard to select multiple pages, or 2) if you wish to select all pages of 
a certain type, click the container node in the tree. For example, if you want to turn 
on headers/footers for all standard pages, 
double click the Standard Pages node in 
the tree view. 

 Mark the checkbox for Display the web form 

header on the page to turn on page headers. Mark 

the checkbox for Display the web form footer on 

the page to turn on page footers. 

 Click the OK button to save your changes.  

The selected pages have headers and/or footers displayed 

on them in the HTML Preview. 

Editing Existing 

Elements 
There may be times when you need to modify an element that you have added to the web form. All 

elements can easily be modified. 

 

To edit an element 

 Double click the element you wish to modify in the tree view. Alternatively right click the 

element(s) you wish to modify and then select Properties, or select Properties from the View tab 

in the Ribbon to view the element’s properties window.  

 Make the desired changes. 

 Click the OK button to save the changes. 

 Note: You may select multiple elements by holding down the Ctrl key as you click 
the elements in the tree view. When selecting more than one element, the 
Properties option is only enabled if you are selecting two elements of the same 
type (e.g., two buttons or two questions). When viewing the properties, items in 
red have dissimilar information. For example, if you select a checkbox style 
question and an option button style question, the Question type property is listed 
in red. You may still adjust these disparate properties, but keep in mind that all 
selected elements are reset to the newly entered property information. The 
property for the item that was selected last is visible in the properties window.  



 

121 

 

 Tip: You can select all items of the same type by going to the Home tab on the 
Ribbon, clicking Select and then choosing the type of element you wish to select 
from the list. For example, suppose you want to add a border to all buttons on the 
web form. Click Select and then choose Buttons from the list. All buttons are be 
highlighted. You can then go to the View tab on the Ribbon and select Properties 
to adjust the buttons’ properties. 
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Chapter 6: Opening, Saving 

and Modifying Web Forms 

Overview 
The previous chapters described the various parts that make up a web form and how to insert and modify 

elements on a web form. When using the software, there are other tools that you may find useful as you 

design web forms. The topics that are covered in this chapter include: 

 Opening web forms 

 Saving web forms 

 Manipulating existing web forms 

 Spell checker 

 Converting old web forms 

Opening a Web Form 
You can open a previously created web form to make modifications or publish it to your web server, 

download data or run analysis. Only web forms saved in the Remark Web Survey format (.rwsx or .rws) can 

be opened from within Remark Web Survey. 

 

To open a web form 

 From the Design window, select the Application Button 

 and then click Open, or click , to display the 

Open window. Notice that when you click the Application 

Button, a recently used file list appears automatically (this 

list stores up to 10 recently accessed files). You may also 

select a web form from this list. 

 Note: The Open button is also available from the 
Quick Access Toolbar.  

 Select the desired web form by clicking its name. 

 Click the Open button to open and display the form. 

 Warning: You are only able to open web forms that are created in Remark Web 
Survey and therefore have a .rwsx extension. These files are only meant for use 
within Remark Web Survey. Though we do not recommend or support it, once a 
form has been created and published, you are able to make changes to the 
resulting HTML files outside of Remark Web Survey. For example, you may format 
the HTML files in an HTML editor. However, if you modify a form outside of Remark 
Web Survey, you cannot reopen the .rwsx file in Remark Web Survey without losing 
those changes. The .rwsx file is the original file you created without any of the 
changes made to the HTML files. You may not change the name of the HTML files 
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while editing it (e.g., do not change the name page_1.html to mysurvey.html). 
Changing the name causes Remark Web Survey to be unable to administer the 
form properly. Certain changes to elements on the web form can also break the 
web form’s functionality. Gravic cannot support files that have been altered 
outside of Remark Web Survey. 

Saving a Web Form 
You can save a web form as a Remark Web Survey document. Forms are saved in the .rwsx format, which 

is proprietary to the Remark Web Survey software. 

 

To save a web form 

 Select the Application Button  and then click Save, or click , to display the Save As 

window. You may also select Save As to save an existing form with a new name or to a new 

location.  

 Note: The Save button is also available from 
the Quick Access Toolbar. 

The Save As window allows you to select a form name and a 

directory to which to save the form. 

 Place the cursor in the File name box and type a 

name for the form.   

 Click the Save button to save the form. 

 Note: If you have already saved the web 
form, clicking Save automatically overwrites 
the file without prompting you. 

Once the web form is complete, you are ready to publish the 

web form to your web server. See Chapter 9 for further details. 

Moving and Rearranging Elements 
While Chapter 5 covered inserting elements into a web form, the tree view can be used to delete, copy 

and move elements.  

 

To delete an element 

 Select the node(s) representing the element(s) you wish to delete. 

 Select the Home tab in the Ribbon and then click Delete , right click the element and then 

select Delete, or press the Delete key on your keyboard. 
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To move an element using cut and paste 

You can move an element to another position on the web form in one of two ways. The first method is to 

use the Home tab in the Ribbon to cut and paste the object in a new position. 

 Select the element you would like to move. 

 Select the Home tab in the Ribbon and then click Cut (Ctrl + X), or click . 

 Select an insertion point in the tree view. 

 Select the Home tab in the Ribbon and then click Paste (Ctrl + V), or click , to paste the 

element after the currently selected element. 

 

To move an element using drag and drop 

You may use drag and drop to move an element to a new position. 

 Select the element you would like to move. 

 While holding down the left mouse button, drag the item to its new desired location. 

 When you have reached the new location, release the mouse button. The element is dropped 

after the selected element. 

 Note: You may press the Shift key while dragging the element to insert it before 
the last selected element. An arrow shows you that you are moving before the 
selected element. 

 

To copy an element using copy and paste 

You can copy one element to another location in one of two ways. The first method is to use the Home 

tab in the Ribbon to copy and paste the object in a new location. 

 Select the element you would like to copy. 

 Select the Home tab in the Ribbon and then click Copy (Ctrl + C), or click .  

 Select an insertion point in the tree view. 

 Select the Home tab in the Ribbon and then click Paste (Ctrl + V), or click  to paste the 

element after the currently selected element. 

 

To copy an element using drag and drop 

The second method of copying elements is to use drag and drop to copy the element to a new location. 

 Select the item you would like to copy. 

 Drag the item to its new desired location. 

 Press the Ctrl key when you have reached the new location (before releasing the mouse button).  

 Release the mouse button. The element is copied to the new location. 
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 Note: You may press the Shift key while dragging the element to copy it before 
the last selected element. An arrow shows you that you are copying before the 
selected element. 

Spell Checker 
Remark Web Survey includes a spell checker feature that includes customized dictionaries in multiple 

languages. The spell check searches labels, question text, answer text and table headers for misspellings. 

 

To set up the spell checker 

 Select the Application Button,  then click Web Survey Options and then click Spell Checker. 

 Under Dictionary Files, select the location 

where your dictionaries are found. (Note that 

the default dictionary is typically fine unless you 

have a specific dictionary you would like to use.) 

There is a Main dictionary and a Custom 

dictionary. Remark Web Survey first uses the 

main dictionary and then as you add custom 

spellings it creates the custom dictionary. When 

performing spell check functions, the software 

uses both dictionaries unless you mark the 

checkbox titled Suggest from main dictionary 

only.  

 In the Language box, select the language for 

your spell check dictionary files. 

 Under When correcting spelling, select the options you wish the spell checker to use: Ignore 

words in UPPERCASE, Ignore words that contain numbers, Ignore internet and file addresses, 

Check compound words, Check hyphenated words, Suggest from main dictionary only. These 

options can help you customize how the spell checker reviews your web forms. 

 

To use the spell checker 

 With a form open, select the Tools tab from the Ribbon and then click Spelling, or click . The 

spell checker window displays if an exception is found. 

 When an exception is encountered, select an option for the problem. The following options are 

available: 
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Option Description 

Ignore Once Ignore the exception this time only. 

Ignore All Ignore all occurrences of the exception. 

Add to Dictionary Add the exception to your custom dictionary. 

Change Select a word from the Suggestions list and then click 

Change to change the exception. 

Change All Select a word from the Suggestions list and then click 

Change All to change all occurrences of the exception. 

Close Cancel the spell checker. 

 

 Make a selection from the above list. Note that you may type 

directly into the Not in Dictionary box and then choose an 

option.  

 Continue making selections until you receive a message that 

the spell checker is complete. 

Converting Remark Web 

Survey 4 Forms 
Remark Web Survey 5 converts .rwsx files that were created in Remark Web Survey 4 automatically.  

 Important Note: If you are using Remark Web Survey 1.x or 2.x web forms, these 
files do not convert automatically. They need to be converted to the Remark Web 
Survey 3 or 4 format first, and then they can be opened in Remark Web Survey 5. If 
you do not have Remark Web Survey 3/4, please email your web form files (.rws 
files) to Gravic’s support team and we will convert them for you (contact 
information is on the back of this book or our website). 

When a Remark Web Survey 4 file is converted to the new version, the conversion takes place when the 

file is saved. You should make a copy of the file before converting it to the new version. Once the version 

4 .rwsx file is converted, you may not use it again in version 4 of the software. When you set up Remark 

Web Survey 5, you may decide to use a different Default forms directory for the storage of web forms on 

your website. Therefore, your converted web form and all of its files may be in a different folder. We 

recommend that you download any data that currently exists for Remark Web Survey 4 forms before the 

conversion. You can always combine this data with any new data files that are created. 

 Tip: If at all possible, you may wish to close out any web forms you are currently 
running under Remark Web Survey 4 before bringing them into Remark Web 
Survey 5. We realize that this may not be possible for ongoing web forms. In this 
case, use the instructions that follow to make the migration as smooth as possible. 
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To convert an old file to the new version 

 Select the Application Button  and then click Open, or click  from the Quick Access 

Toolbar. 

 Locate the .rwsx or .rws file you wish to open. Keep in mind that you may only convert version 3.x 

and 4.x files in this version. 

 Click the Open button to open the file. 

 Save the file in Remark Web Survey 5 by selecting the Application Button  and then clicking 

Save, or click  from the Quick Access Toolbar. Provide a File name and select a location in 

which to save the file. Do not overwrite the original file or you are not able to use it in the older 

version. 

 Click the OK button. The new file has a .rwsx extension and can only be opened in Remark Web 

Survey 5. The old file remains intact and can still be used in the previous Remark Web Survey 

version if needed. 

You may now modify the web form as desired. If you plan to combine data for the same form that was 

collected in Remark Web Survey 4 and Remark Web Survey 5, do not make any structural changes to the 

web form (e.g., add questions, delete questions, rearrange questions, etc.). When completed, publish the 

form to your website as you would any other web form (see Chapter 9). 

If the form still has data that you collected with Remark Web Survey 4, you have two options for 

combining the data (in both cases you should start a new data file once the file is converted to version 5): 

 RECOMMENDED: Download the data into Remark Web Survey 4, save it as a 
Remark (RMK) data file and then open that data file in Remark Web Survey 5. 

 Download the old data from your website using the Remark Web Survey 4 
administration script (rwsad4.pl). This provides you with a .rwd file that can be 
opened in Remark Web Survey 5. 

 Note: Remark Web Survey 5 is an upgrade to Remark Web Survey 4. While the two 
products can physically reside on the same system, Remark Web Survey 5 should 
replace Remark Web Survey 4 (e.g., it does not grant you an additional license to 
Remark Web Survey). We understand that you may need to migrate web forms 
from one version to the other over a period of time. Once all of your web forms are 
migrated to the new version, please uninstall Remark Web Survey 4 and only use 
version 5 (always back up your files before uninstalling any program). 

 

 

 

 

 

 

 

 

 



Chapter 7: Formatting and 

Style Sheets 

Overview 
Each web form that you create has its own format, also known as style; that is, its own character in terms 

of colors, fonts and other formatting attributes. Remark Web Survey allows you to customize the format 

of the elements on the web forms that you create. In addition, you can save formatting options as style 

sheets so that they can be reused. Styles allow you to customize fonts, colors, line breaks, image attributes 

and other properties throughout the web form.  

Formatting Options 
The application of styles is handled through the Style Properties window. You use this window to set 

formatting options and then apply them to the various parts of the web form. Every property listed in the 

Style Properties window has descriptive text at the bottom of the window. Click a style property to view its 

descriptive text. 

The following table shows all of the possible formatting options in the Style Properties window (listed in 

alphabetical order for each element): 

 

Element Category: Answers 

 

Style Property Description 

Alignment The Alignment style property sets whether to place the answer 

element in the left, center or right area of the section. Click in the right 

portion of the cell to access a drop-down list of choices. The 

Alignment property can only be accessed when you click Format from 

the Question Properties window (not from the Answer Properties 

window). Alignment applies to all answers within a question and 

cannot be applied to individual answers within the same question. 

Answer Box Height When inserting a Textbox question, you can increase its height by 

adding rows, which turns it into a Text Area. A Text Area style question 

has multiple rows and columns to accommodate more text than a one-

line textbox. Note that this style is also available in the Attributes 

section of the Question Properties window. 
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Style Property Description 

Answer Box Width When inserting a Textbox question, you can increase its width by 

adding columns. Note that the width of a textbox is the same number 

of characters respondents are able to type (e.g., a textbox with a width 

of 10 allows 10 characters). If using a Text Area (multiple lines), the 

Answer Box Width setting does not limit the number of characters 

that can be typed. However, if they exceed the limit you set in the 

question’s properties, respondents receive an appropriate message 

when they submit the page. Note that this style is also available in the 

Attributes section of the Question Properties window. 

Background Color The Background Color style property sets the background color for 

the element. Click in the right portion of the cell to access a drop-

down list of colors. The font remains unchanged, but the background 

of the text changes in color. 

Font The Font style property sets the font name for the element. Click in the 

right portion of the cell to access a drop-down list of fonts. 

Alternatively, type a list of fonts separated by commas. 

Note: It may be the case that the font you select here is not available 

on the respondent’s computer. Using the Remark Web Survey program 

options, you can select more than one font for your respondents. If the 

main font is not available on the respondent’s system, the backup 

fonts are used. Select the Application Button  and then choose 

Web Survey Options to choose backup fonts that display when the 

selected font is unavailable. 

Font Bold The Font Bold style property sets whether the font used for the 

answer element is in bold format. Use True to set it to bold format and 

False to remove bold formatting. 

Font Color The Font Color style property sets the color for the font used for the 

answer element. Click in the right portion of the cell to access a drop-

down list of font colors. 

Font Italic The Font Italic style property sets whether the font used for the 

answer element is in italic format. Use True to set it to italic format and 

False to remove italic formatting. 

Font Size The Font Size style property sets the size of the font used for the 

answer element. Enter a numeric value. 10 is a typical number used for 

web forms; use a higher number for larger text and a lower number for 

smaller text. 
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Style Property Description 

Font Underline The Font Underline style property sets whether the font used for the 

answer element is underlined. Use True to underline the answer 

element and False to remove underline formatting. 

Horizontal Alignment The Horizontal Alignment style property sets the horizontal 

alignment for checkbox and option button style answer elements (left, 

center, right). Tip: Use this property in table formatting when you want 

checkboxes and option buttons to be centered below the answer text. 

This property is also useful in conjunction with Image Position when 

using images as answer choices. 

Image Position The Image Position style property sets whether images used as 

answer choices should be left, right, top or bottom aligned in 

comparison to the HTML Display text. 

Indent Levels The Indent Levels style property sets the number of levels to indent 

the element. One indent level equals one HTML space. As you increase 

the indent levels, the answer element moves toward the right of the 

web form page. 

Line Breaks After The Line Breaks After style property sets the number of line breaks 

after the element. Enter a numeric value to add line breaks after the 

element. Adding line breaks creates vertical space after the last answer 

element for the question.  

Line Breaks Before 

Appended Textbox 

The Line Breaks Before Appended Textbox style property sets the 

number of line breaks between an element and an appended textbox 

(e.g., an “other” textbox). Enter a numeric value to add line breaks 

before the appended textbox. Adding line breaks creates vertical space 

before the appended textbox. Use a value of 0 to place the appended 

textbox on the same line as the answer element. 

Vertical Alignment The Vertical Alignment style property sets the answer’s alignment to 

Top, Middle or Bottom. This aligns everything within the answer 

element (e.g., HTML Display, images and the element itself, such as a 

checkbox or option button). 
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Element Category: Buttons 

 

Style Property Description 

Alignment The Alignment style property sets whether to place the button 

element in the left, center or right area of the section. Click in the right 

portion of the cell to access a drop-down list of choices. 

Border Color The Border Color style property allows you to choose a color for the 

border around the button (if one is used). Click the arrow in the right 

portion of the window to drop down a list of available colors. 

Border Style The Border Style style property allows you to create either a 3D 

border or a flat border around the button. A 3D border looks similar to 

a raised border if the border width is great enough. Please note that 

color can affect the 3D look of a border (e.g., black cannot look three-

dimensional).  

Border Width The Border Width style property places a border around the button 

and sets the thickness. Enter a numeric value; the higher the number, 

the thicker the border. Use 0 if you do not want a border. The default 

value is -1, which uses the web browser’s default setting for buttons 

(Windows XP style). 

Font The Font style property sets the font name for the text in the button 

element. Click in the right portion of the cell to access a drop-down list 

of fonts. Alternatively, type a list of fonts separated by commas. 

Note: It may be the case that the font you select here is not available 

on the respondent’s computer. Using the Remark Web Survey 

program options, you can select more than one font for your 

respondents. If the main font is not available on the respondent’s 

system, the backup fonts are used. Select the Application Button  

and then choose Web Survey Options to choose backup fonts that 

display when the selected font is unavailable. 

Font Bold The Font Bold style property sets whether the font used for the text in 

the button element is in bold format. Use True to set it to bold format 

and False to remove bold formatting. 

Font Color The Font Color style property sets the color for the font used for the 

text in the button element. Click in the right portion of the cell to 

access a drop-down list of font colors. 

Font Italic The Font Italic style property sets whether the font used for the text in 

the button element is in italic format. Use True to set it to italic format 

and False to remove italic formatting. 
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Style Property Description 

Font Size The Font Size style property sets the size of the font used for the text 

in the button element. Enter a numeric value. Use a higher number for 

larger text and a lower number for smaller text. 

Font Underline The Font Underline style property sets whether the font used for the 

text in the button element is underlined. Use True to underline the 

answer element and False to remove underline formatting. 

Height The Height style property allows you to increase or decrease the 

height of the button, creating a larger or smaller button. 

Line Breaks After The Line Breaks After property sets the number of line breaks after 

the button element. Enter a numeric value to add line breaks after the 

element. Adding line breaks creates vertical space after the button. By 

adding line breaks between buttons, you can force buttons to be on 

separate lines (e.g., place one button on the form, put a line break 

after it, then add another button; that button is on the next line). 

Please note that buttons have one line break after automatically (the 

setting reads 0 because the line break is built-in to the element). 

Width The Width style property allows you to increase or decrease the width 

(length) of the button, creating a larger or smaller button. 

 

Element Category: Images 

 

Style Property Description 

Alignment The Image Horizontal Alignment style property sets whether to align 

the image left, center or right relative to the section in which it resides. 

Border Color The Border Color style property allows you to choose a color for the 

border around the image (if one is used). Click the arrow in the right 

portion of the window to drop down a list of available colors. 

Border Style The Border Style style property allows you to create either a 3D 

border or a flat border around the image. A 3D border looks similar to 

a raised border if the border width is great enough. Please note that 

color can affect the 3D look of a border (e.g., black cannot look three 

dimensional).  

Border Width The Border Width style property places a border around the image 

and sets the thickness in pixels. Enter a numeric value; the higher the 

number, the thicker the border. Use 0 if you do not want a border. The 

default value is -1, which uses the web browser’s default setting for 

buttons (Windows XP style). 
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Style Property Description 

Height The Height style property sets the height of the image in pixels. Note 

that you can also adjust image height in the Image Properties window. 

Line Breaks After  The Line Breaks After style property sets the number of line breaks 

after the image element. Enter a numeric value to add line breaks after 

the element. Adding line breaks creates vertical space after the image. 

Please note that Images have one line break after automatically (the 

setting reads 0 because the line break is built-in to the element). 

Width The Width style property sets the width of the image in pixels. Note 

that you can also adjust the image width in the Image Properties 

window. 

 

Element Category: Labels 

 

Style Property Description 

Alignment The Alignment style property sets whether to place the label element 

in the left, center or right area of the section. Click in the right portion 

of the cell to access a drop-down list of choices. 

Background Color The Background Color style property sets the background color for the 

label element. Click in the right portion of the cell to access a drop-

down list of colors. The text font remains unchanged, but the 

background of the label changes in color. 

Font The Font style property sets the font name for the label element. Click 

in the right portion of the cell to access a drop-down list of fonts. 

Alternatively, type a list of fonts separated by commas. 

Note: It may be the case that the font you select here is not available 

on the respondent’s computer. Using the Remark Web Survey program 

options, you can select more than one font for your respondents. If the 

main font is not available on the respondent’s system, the backup fonts 

are used. Select the Application Button  and then choose Web 

Survey Options to choose backup fonts that display when the selected 

font is unavailable. 

Font Bold The Font Bold style property sets whether the font used for the label 

element is in bold format. Use True to set it to bold format and False to 

remove bold formatting. 

Font Color The Font Color style property sets the color for the font used for the 

label element. Click in the right portion of the cell to access a drop-

down list of font colors. 
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Style Property Description 

Font Italic The Font Italic style property sets whether the font used for the label 

element is in italic format. Use True to set it to italic format and False to 

remove italic formatting. 

Font Size The Font Size style property sets the size of the font used for the label 

element. Enter a numeric value. 10 is a typical number used for web 

forms; use a higher number for larger text and a lower number for 

smaller text. 

Font Underline The Font Underline style property sets whether the font used for the 

text in the label element is underlined. Use True to underline the answer 

element and False to remove underline formatting. 

Indent Levels The Indent Levels style property sets the number of levels to indent the 

element. One indent level equals one HTML space. As you increase the 

indent levels, the label element moves toward the right of the web form 

page. 

Line Breaks After The Line Breaks After style property sets the number of line breaks 

after the label element. Enter a numeric value to add line breaks after 

the element. Adding line breaks creates vertical space after the label. 

Please note that labels have one line break after automatically (the 

setting reads 0 because the line break is built-in to the element). 

 

Element Category: Lines 

 

Style Property Description 

Alignment The Alignment style property sets whether to place the line element 

in the left, center or right area of the section. Click in the right portion 

of the cell to access a drop-down list of choices. 

Color The Color style property sets the color for the line element. Click in the 

right portion of the cell to access a drop-down list of font colors. 

Height The Height style property sets the height/thickness of the line in 

pixels. 

Line Breaks After  The Line Breaks After style property sets the number of line breaks 

after the line element. Enter a numeric value to add line breaks after 

the element. Adding line breaks creates vertical space after the line. 

Please note that lines have one line break after automatically (the 

setting reads 0 because the line break is built-in to the element). 
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Style Property Description 

Width The Width style property sets the width of the line in percentages. 

100% extends the line across the entire width of the page. You may 

also enter a width in pixels (do not use the percent sign in this case). 

 

Element Category: Multimedia 

 

Style Property Description 

Alignment The Horizontal Alignment style property sets whether to align the 

multimedia element left, center or right relative to the section in which 

it resides. 

Border Color The Border Color style property allows you to choose a color for the 

border around the multimedia element (if one is used). Click the arrow 

in the right portion of the window to drop down a list of available 

colors. 

Border Width The Border Width style property places a border around the 

multimedia element and sets the thickness in pixels. Enter a numeric 

value; the higher the number, the thicker the border. Use 0 if you do 

not want a border. The default value is -1, which uses the web 

browser’s default setting for buttons (Windows XP style). 

Line Breaks After  The Line Breaks After style property sets the number of line breaks 

after the multimedia element. Enter a numeric value to add line breaks 

after the element. Adding line breaks creates vertical space after the 

image. Please note that multimedia files have one line break after 

automatically (the setting reads 0 because the line break is built-in to 

the element). 

Media Player Height The Media Player Height style property sets the height of the media 

player in pixels.  

Media Player Width The Media Player Width style property sets the width of the media 

player in pixels.  

Show Player Controls The Show Player Controls style property lets you control whether to 

display the audio/video player’s controls, such as start, stop, rewind, 

fast forward and pause. The controls may vary based on the 

audio/video player being used. If you show the controls, respondents 

can utilize them when the audio/video file loads. If you do not show 

the controls, respondents do not have the ability to manipulate the 

player (e.g., restart the audio/video clip, rewind and re-listen, etc.). 
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Style Property Description 

Show Player Status The Show Player Status style property lets you control whether to 

display the player’s status. Status messages include things such as 

“buffering media”, “loading media file” and so forth. These messages 

give an indication to the respondent as to what is happening with the 

multimedia file. 

 

Element Category: Pages 

 

Style Name Description 

Alignment The Alignment style property sets whether the page is left, center or 

right aligned. Click in the right portion of the cell to access a drop-

down list of choices. Alignment is affected by the Width setting. When 

using 100% width, it is harder to see a difference in alignment. 

However, as you shrink the width, the margins get wider and the 

alignment of the elements on the page becomes more evident. 

Background Color The Background Color style property sets the background color for 

the page. Click in the right portion of the cell to access a drop-down 

list of colors. The entire background of the web form page changes in 

color. 

Background Image  The Background Image style property puts an image in the 

background of the page. Click the ellipse (…) to select an image to use 

as the background for the entire page. 

Background Image Display The Background Image Display style property sets the position of the 

background page image: Left, Center, Right or Tile. 

Enable Background Image The Enable Background Image style property displays the 

background image for the page. After selecting a background image in 

Background Image Display, set this property to True to display the 

image. You can set this property to False for specific pages without 

having to remove the image selected for Background Image Display. 

Width The Width style property sets the width of the page in percentages. 

When using 100% the elements placed on the page extend the width 

of the entire page. 
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Element Category: Question Tables 

 

Style Name Description 

Alignment The Horizontal Alignment style property sets the alignment of the 

table relative to the section: Left, Center or Right. 

Background Color The Background Color style property sets the background color for 

the question table. Click in the right portion of the cell to access a 

drop-down list of colors. 

Background Color Enabled 

 

The Background Color Enabled style property sets whether to display 

a background color. The color is chosen either in the Background 

Color for Alternate Rows or Background Color properties. 

Background Color for 

Alternate Columns 

 

The Background Color for Alternate Columns property style sets the 

background color for alternating columns within the question table. 

Use the Background Column Color Display style property (see next 

page) to determine whether alternating columns or answer groups 

utilize the background color. Click in the right portion of the cell to 

access a drop-down list of colors. 

Background Color for 

Alternate Columns Style 

The Background Color for Alternate Columns Style property style 

sets whether to apply the background color you selected for alternate 

columns to all columns in the table or only the first column in the 

table. 

Background Color for 

Alternate Rows 

 

The Background Color for Alternate Rows style property sets the 

background color for alternating rows within the question table. Click 

in the right portion of the cell to access a drop-down list of colors. 

Background Color for 

Alternate Rows Style 

The Background Color for Alternate Rows Style property style sets 

whether to apply the background color you selected for alternate rows 

to all the rows in the table table or only the first row in the table. 

Background Color for 

Question Text Cells 

The Background Color for Question Text Cells style property sets 

the background color for the column or row that contains the question 

text. Click in the right portion of the cell to access a drop-down list of 

colors. 

Background Color Solid The Background Color is Solid style property controls whether to use 

a solid background for the entire question table. When enabled, solid 

background color is used and alternate row background color is not 

used. 
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Style Name Description 

Background Column Color 

Display 

The Background Column Color Display style property allows you to 

format the columns by Column or Answer Group. When formatted by 

Column, alternating columns have the background color applied, 

regardless of the answer group to which the question applies. When 

formatted by Answer Group, the entire group of answers has the 

background color applied. The latter feature is useful for side-by-side 

tables where more than one answer group is used with the same set of 

questions. 

Column Header Text 

Alignment 

The Column Header Text Alignment style property allows you to 

format all of the column header text in the left, center or right of the 

column. This feature is useful if you want all of the answer text, for 

example, to be centered over the columns. Once this property is set, 

you may still go into individual answer items and adjust their 

alignment. 

Display Answer Group 

Header 

The Display Answer Group Header style property controls whether 

the header entered into the answer group section of question table is 

displayed. This property is on by default. 

Display Answer Scale 

Header 

The Display Answer Scale Header style property controls whether the 

scale (e.g., Excellent to Poor ratings for option button questions) 

entered into the answer group section of question table is displayed. 

This property is on by default. 

Font The Font style property sets the font name for the question table 

element. Click in the right portion of the cell to access a drop-down list 

of fonts. Alternatively, type a list of fonts separated by commas. 

Note: It may be the case that the font you select here is not available 

on the respondent’s computer. Using the Remark Web Survey 

program options, you can select more than one font for your 

respondents. If the main font is not available on the respondent’s 

system, the backup fonts are used. Select the Application Button  

and then choose Web Survey Options to choose backup fonts that 

display when the selected font is unavailable. 

Font Bold The Font Bold style property sets whether the font used for the 

question table is in bold format. Use True to set it to bold format and 

False to remove bold formatting. 

Font Color The Font Color style property sets the color for the font used for the 

question table. Click in the right portion of the cell to access a drop-

down list of font colors. 
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Style Name Description 

Font Italic The Font Italic style property sets whether the font used for the 

question table is in italic format. Use True to set it to italic format and 

False to remove italic formatting. 

Font Size The Font Size style property sets the size of the font used for the 

question table. Enter a numeric value. 10 is a typical number used for 

web forms; use a higher number for larger text and a lower number for 

smaller text. 

Font Underline The Font Underline style property sets whether the font used for the 

text in the question table is underlined. Use True to underline the 

answer element and False to remove underline formatting. 

Indent Levels The Indent Levels style property sets the number of levels to indent 

the question table. One indent level equals one HTML space. As you 

increase the indent levels, the question table moves toward the right 

of the web form page. 

Line Breaks After Question 

Table 

The Line Breaks After Question Table style property sets how many 

line breaks to put after the entire question table. 

Question Column Width The Question Column Width style property sets the width of the 

question column within the table in terms of percentages. The 

question column utilizes the specified width, and the answer items 

evenly fill the remaining portion of the table. This feature allows your 

answer items to be evenly spaced on the page. 

Question Column Widths 

Enabled 

The Question Column Widths Enabled style property enables the use 

of custom question columns widths. Use this property in conjunction 

with Question Column Width. 

Row Header Text Alignment The Row Header Text Alignment style property sets whether to place 

the row header text in the left, center or right portion of the table 

column. Row header text is question text when a table is laid out 

“question by answer”. Row header text is answer text when a table is 

laid out “answer by question.” 

Table Borders -Color 

(External) 

The Table Borders - Color External style property allows you to 

choose a color for the external border around the table (if one is used). 

Click the arrow in the right portion of the window to drop down a list 

of available colors. 

Table Borders -Color 

(Internal) 

The Table Borders - Color Internal style property allows you to 

choose a color for the internal borders within the table (if they are 

used). Click the arrow in the right portion of the window to drop down 

a list of available colors. 
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Style Name Description 

Table Borders -External The Table Borders - External style property sets whether to use an 

outside border around the entire table of questions. The Background 

Color for Alternate Rows property controls the border color. 

Table Borders - Internal The Table Borders - Internal style property sets whether to use 

borders around each individual question within the question table. By 

using this feature, the table borders are visible. The Background Color 

for Alternate Rows property controls the border color. 

Table Borders – Width 

(External) 

The Table Borders – Width (External) style property controls the size 

of the border around the table by setting its thickness in pixels. Enter a 

numeric value; the higher the number, the thicker the border.  

Table Borders -Width 

(Internal) 

The Table Borders – Width (Internal) style property controls the size 

of the internal border used in the table by setting its thickness in 

pixels. Enter a numeric value; the higher the number, the thicker the 

border.  

Table Layout The Table Layout style property allows you to lay out the table using 

Question by answer or Answer by Question. Question by Answer puts 

the question text down the left side of the table and the answer text 

across the top. Answer by Question puts the answer text down the left 

side of the table and the question text across the top. 

Table Width The Table Width style property specifies the width of the table across 

the web form page. The default value is Auto meaning it spans the 

page. You can type a width percentage in the box or choose one from 

the drop-down list. 

Vertical Alignment The Vertical Alignment style property sets the question table row 

alignment to the top, middle or bottom of the row. Click in the right 

portion of the cell to access a drop-down list of choices. 

 

Element Category: Questions 

 

Style Name Description 

Alignment The Alignment style property sets whether to place the question 

element in the left, center or right area of the section. Click in the right 

portion of the cell to access a drop-down list of choices. 

Background Color The Background Color style property sets the background color for 

the question element. Click in the right portion of the cell to access a 

drop-down list of colors. 
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Style Name Description 

Font The Font style property sets the font name for the question element. 

Click in the right portion of the cell to access a drop-down list of fonts. 

Alternatively, type a list of fonts separated by commas. 

Note: It may be the case that the font you select here is not available 

on the respondent’s computer. Using the Remark Web Survey 

program options, you can select more than one font for your 

respondents. If the main font is not available on the respondent’s 

system, the backup fonts are used. Select the Application Button  

and then choose Web Survey Options to choose backup fonts that 

display when the selected font is unavailable. 

Font Bold The Font Bold style property sets whether the font used for the 

question element is in bold format. Use True to set it to bold format 

and False to remove bold formatting. 

Font Color The Font Color style property sets the color for the font used for the 

question element. Click in the right portion of the cell to access a 

drop-down list of font colors. 

Font Italic The Font Italic style property sets whether the font used for the 

question element is in italic format. Use True to set it to italic format 

and False to remove italic formatting. 

Font Size The Font Size style property sets the size of the font used for the 

question element. Enter a numeric value. 10 is a typical number used 

for web forms; use a higher number for larger text and a lower number 

for smaller text. 

Font Underline The Font Underline style property sets whether the font used for the 

text in the question element is underlined. Use True to underline the 

answer element and False to remove underline formatting. 

Indent Levels The Indent Levels property sets the number of levels to indent the 

question element. One indent level equals one HTML space. As you 

increase the indent levels, the question element moves toward the 

right of the web form page. 

Line Breaks After The Line Breaks After style property sets the number of line breaks 

after the question element. Enter a numeric value to add line breaks 

after the element. Adding line breaks creates vertical space after the 

question.  

Line Breaks Before 

Question’s Answers 

The Line Breaks Before Question’s Answers style property sets the 

number of line breaks between the question element and the first 

answer element. Enter a numeric value to add line breaks after the 

element. Adding line breaks creates vertical space after the question. 
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Style Name Description 

Question Answer Columns The Question Answer Columns style property sets the number of 

columns in which to place the answer elements (applies to checkbox 

and option button question types). If a question has a large number of 

answer choices, you may wish to put the answers in multiple columns. 

 

Element Category: Sections 

 

Style Property Description 

Column Border Color The Column Border Color style property allows you to choose a color 

for borders between columns within a section (if borders are used). 

Click the arrow in the right portion of the window to drop down a list 

of available colors. 

Column Border Visible The Column Border Visible style property sets whether to display a 

border between columns in a section. This property only applies to 

sections that have more than one column. Borders can act as a visual 

separator between elements in the section. Set the value to True to 

display borders and False to hide borders. 

Column Border Width The Column Border Width style property controls the size of the 

border between columns by setting its thickness in pixels. Enter a 

numeric value; the higher the number, the thicker the border. 

 

Element Category: Web Form 

 

Style Property Description 

Error Highlight Color The Error Highlight Color style property allows you to choose a color 

for error messages that are highlighted when respondents submit 

pages with missing/incorrect information (e.g., not answering a 

required question). Click the arrow in the right portion of the window 

to drop down a list of available colors. The default color is red. 

Hyperlink Color The Hyperlink Color style property sets the color to use for all 

hyperlinks on the web form. Click in the right portion of the cell to 

access a drop-down list of colors. 
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Using the Style Properties Window 
There are several ways you can format web forms. In order to understand how formatting works, you need 

to understand the web form hierarchy and how style properties are passed down to the various web form 

elements. 

When you look at a web form’s tree view, you can think of it as a hierarchy. The web form is at the top, 

followed by Pages, Sections, Questions, Labels, Images or Lines, Multimedia and Answers. In hierarchical 

context, it looks like this: 

Web Form 

 Page 

  Section 

   Questions, Images, Labels, Lines, Multimedia 

    Answers 

When using style properties, there are two basic concepts. You can either format individual elements or 

you can choose a higher point in the hierarchy and then “push” the formatting down to the lower levels. 

Think of the top level as a parent and any levels beneath it as children. When you push a style property 

down, the children inherit the option from the parents. In the Style Properties window, you have two 

choices for applying style changes: an OK button and an Apply Style button.  

The OK button can be used in two ways: It can apply changes made within the Style Properties window to 

the selected element. Or, when used at a higher level, it changes affected elements at that level or lower 

and apply to new elements that you create from that point on, if they are on existing pages.  

 

 Important Note: When using the OK button in the Style Properties window, if a 
property is changed, all elements that had the original property’s value will be 
updated with the new value. However, disparate elements will remain unchanged. 
The purpose of this rule is so that if you intentionally format an element in a 
special way, its formatting will not be overwritten accidentally.  

For example, if you select a question and change the font from black to blue and then click OK, it will 

change the selected question to blue. However, new questions that you create will still use the style from 

the next highest level (e.g., the original color). In addition, other existing questions will not be changed to 

blue. This is all true because you selected one particular element to format. Another example is to select 

all Standard Pages, go to the Questions section of the Style Properties window and change the color from 

black to blue. In this scenario, after clicking the OK button, all of the questions on the selected pages that 

are black will change from black to blue. Any new questions you insert (on any existing standard page) 

will also be blue. New questions are affected in this case because you set the font color on a page level 

and pushed it down to the questions on those pages (whereas in the previous example, you only set it for 

one question). However, if you were to add a page to the web form, questions on that page would use the 

old style (black in this case) because new pages utilize the style set at the form level. 

In contrast, the Apply Style button applies all of the settings within the Style Properties window to the 

selected element and its children (lower level elements). What you see in the Style Properties window is 

actually a Style Sheet. Therefore, using the Apply Style button takes all of those properties and applies 

them to the web form. In addition, any new elements that you create will use the updated style. 
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 Note: When using the Apply Style button, you still need to click the OK button to 
close the Style Properties window. In this circumstance, the OK button is just an 
added layer of confirmation to your changes (you can use OK or Cancel at this 
point). 

Let’s look at an example: 

Suppose you have a 5-page web form where the style defined has page background set to gray. You 

decide that you want to change all of the existing background colors on your web form pages to blue. 

The easiest way to accomplish this is to select all web pages, go to the Style Properties window and 

change the background color at the Page level. In this case you would then click the OK button to apply 

the changes to the selected pages. If you were to create a new page, however, it would be gray because 

this is what is defined at the form level. If we change the scenario slightly and say you want to change all 

of the background colors from gray to blue and have new pages be blue as well, you could go to the form 

level, click the Format button, make the change and then click Apply Style. In this case, the existing 

pages would change to blue and any new pages would also be blue because you changed the style at the 

web form level.  

In order to make the formatting as flexible as possible, you can also change individual elements without 

enforcing that change to apply to other lower level elements. Suppose you have one question that you 

want to stand out. While all the questions on the form are blue, you want this one to be red. You can go 

to the Style Properties window for that question only and change the color to red without affecting any 

other questions. Unless you go to a higher level in the tree and click the Apply Style button in the Style 

Properties window, this question will stay red. In addition, any new questions will still be the original style 

color of blue.  

In summary, here is a list of the possible ways to use the Style Properties window: 

 Select the web form element in the tree view (the top node), change the style 
properties and then click the OK button. Everything on the web form that had the 
original property value will be changed for any properties that were adjusted in the 
Style Properties window. Any style properties that were not touched will not carry 
down to the other elements on the web form. Any new items you insert will have 
the properties that you just adjusted using the Style Properties window. (Example: 
Go to Style Properties through the web form properties, change Question Color 
from Black to Blue, click the OK button. All questions on the form that were 
originally black will be blue, but any other settings that were in the Style Properties 
window that were not adjusted will not carry over to the web form. In addition, any 
questions that were not originally black will retain their color. Any new questions 
that you create will be blue.) 

 Select the web form element in the tree view (the top node), change the style 
properties and then click the Apply Style button. Everything on the web form will 
be changed based on what is in the Style Properties window, regardless of what 
was actually changed in that same window. Anything new you add to the web form 
will also use these updated properties. (Example: Go to the Style Properties 
through the web form properties, change Question Color to Blue and click the 
Apply Style button. All questions on the web form will be blue, and in addition, 
everything on the web form will utilize all properties from the Style Properties 
window.) 

 Select a higher level element, such as a page, change the style properties and 
click the OK button. The style properties that you changed will carry through to the 
selected items, and if you changed the style of elements below in the hierarchy, 
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they will change as well. Any properties in the Style Properties window that you did 
not adjust will not affect lower level items. (Example: Go to the Style Properties 
through a page properties window. Change Question Color from Black to Blue. All 
questions on the page that were originally black will be blue but any other settings 
that were in the Style Properties window that were not adjusted will not carry over 
to the web form. However, any new questions you add to this page will use the 
new Question Color (blue). 

 Select a higher level element, such as a page, change the style properties and 
click the Apply Style button. The selected item (e.g., page) and any elements 
below it will utilize all of the properties in the Style Properties window. (Example: 
Go to the Style Properties through a page properties window. Change Question 
Color from Black to Blue and then click the Apply Style button. All questions on the 
page will be blue and in addition, everything on that page will utilize all properties 
from the Style Properties window. If you had set formatting options for an 
individual element (e.g., made one question green) the options will be reset to 
those that are defined on the page level (blue, in this case). In addition, new 
questions you add will also use the Question Color defined at the page level (blue 
in this case). 

 Select an individual element, change the style properties and click the OK button. 
The style properties will only apply to the selected element. (Example: Go to the 
Style Properties through a question’s properties window. Change the Question 
Color from Black to Blue. Only that question will turn blue. Any new questions you 
add will use the Question Color defined at the next higher level (black). 

 Select an individual element, change the style properties and click the Apply Style 
button. The selected element will change and anything below that element will also 
change based on what was in the Style Properties window, regardless of what was 
actually changed. (Example: Go to the Style Properties through a question’s 
properties window. Change the Question Color from Black to Blue. Only that 
question will turn blue. Any new questions you add will use the Question Color 
defined at the web form level (black). Anything else that was in the Style Properties 
window for questions and answers will carry through to that particular question. So 
if that question’s answers happened to be green but the Style Properties window 
has answers set to black, that question’s answers will now be black. Any new 
questions and answers you add will use the Question/Answer Color defined at the 
next higher level (black), as well as the other properties. 

o Tip: Here is a good rule of thumb to remember when using styles: When 
using the OK button in the Style Properties window, if a property is 
changed, all elements that had the original property’s value will be 
updated with the new value. However, disparate elements will remain the 
same. The purpose of this rule is so that if you intentionally format an 
element in a special way, its style will not be overwritten accidentally. 
However, remember that Apply Style applies all formatting across the 
board. 
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The following sets of instructions help you apply formatting options to various parts of the web form. 

 

To apply style properties to an entire form 

 Double click the Web Form node, which is the top 

node on the form.  

 Click the Format button. 

 Make the desired changes.  

 Click the OK button to accept the changes and apply 

them to the web form. Only properties that were 

changed are applied. Or click the Apply Style button 

to apply all of the settings in the Style Properties 

window to the entire web form. 

 

To apply style properties to a web form page 

 Double click the Page node to which you want the style applied. 

 Click the Format button. 

 Make the desired changes.  

 Click the OK button to accept the changes and apply them to the selected web page. Only 

properties that were changed are applied. Or click the Apply Style button to apply all of the 

settings in the Style Properties window to the selected web page. 

To apply the same style properties to multiple pages 

 Select the pages to which you wish to apply a new style. You may select multiple pages by 

clicking page nodes while holding down the Ctrl key. Or, you may select the beginning page 

node, hold down the Shift key and then select the ending page node to select a range of pages. 

To apply a change to all standard pages, select the Standard Pages container. 

 After selecting the page elements, right click and select Properties. 

 Note: Do not release the Ctrl or Shift key until after you right click the mouse. 

 Click the Format button. 

 Make the desired changes.  

 Click the OK button to accept the changes and apply them to the selected web pages. Only 

properties that were changed are applied. Or click the Apply Style button to apply all of the 

settings in the Style Properties window to the selected web pages. 

 

To change style properties of an individual element 

 Select an individual element (button, label, line, image, multimedia, question or answer) by double 

clicking its node or by highlighting the element, right clicking and selecting Properties. 

 Click the Format button. 

 Make the desired changes.  
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 Click the OK button to accept the changes and apply them to the selected element. Only 

properties that were changed are applied. Or click the Apply Style button to apply all of the 

settings for the selected element and any elements beneath (e.g., a question and its answers) in 

the Style Properties window to the selected element. 

 

To change style properties of multiple elements 

 Select the elements you would like to change by holding down the Ctrl key and clicking an 

element to select multiple elements, or by holding down the Shift key and clicking a beginning 

and ending element to select a range of elements. 

 Note: You must select the same type of element to be able to change formatting 
options. 

 After selecting the elements, right click and select Properties. 

 Note: Do not release the Ctrl or Shift key until after you right click the mouse. 

 Click the Format button. 

 Make the desired changes.  

 Click the OK button to accept the changes and apply them to the selected elements. Only 

properties that were changed are applied. Or click the Apply Style button to apply all of the 

settings for the selected element and any elements beneath (e.g., a question and its answers) in 

the Style Properties window to the selected elements. 

Formatting and Question Tables 
Please note that many style attributes for a question table override the style attributes for individual 

questions/answers within the table. The following question properties do not have an effect on the visual 

display if the question is within a table. This is due to the fact that the properties are superseded by the 

table’s style: 

 Backcolor 

 Alignment 

 Indent Levels 

 Line Breaks After 

 Line Breaks Before Question’s Answers 

 Answer Columns 

The following answer properties do not have an effect on the visual display if the answer is within a table. 

This is due to the fact that the properties are superseded by the table’s style: 

 Backcolor 

All other style properties do have an effect on the answer choice text (e.g., Good, Poor, etc.) and main 

table headers, utilizing the formatting as defined in the first question row. 

Finally, the formatting options for the first defined answer column of a question table apply to all 

questions within the table. 
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Creating Style Sheets 
When applying styles to web forms, you can utilize a style sheet. Style sheets can be saved and applied to 

multiple web forms. The style properties are the same as those defined in the Style Properties window. To 

save time and effort, you can reuse these styles by saving them as style sheets. Then you simply apply a 

style sheet to other web forms. You can still modify individual elements of a web form after applying a 

style sheet. 

 

To create a style sheet using the Style Sheet Editor 

 From the Home tab in the Ribbon, click the Dialog Box 

Launcher  next to the word Formatting. The 

Style Sheet Editor window appears. 

 Click the New button. 

 All of the properties from the Style Properties window 

appear. Set properties as desired for each part of the 

web form. 

 Enter a name for the style sheet in the Style sheet 

name box. 

 Click the Update button to save your changes. 

 Click the Close button to close the window. The style 

sheet is now saved and can be applied to any web form in Remark Web Survey. 

 

To create a style sheet using existing formatting options 

If you have already created a web form and applied various formatting options to it, you can save those 

options as a style sheet so that you can reuse them on other web 

forms. 

 If not open already, open the web form that contains the 

formatting options you want to save as a style sheet. 

 Double click the web form name to access the Properties 

window. 

 Click the Format button. 

 On the toolbar of the Style Properties window, click the 

Save button . The Style Sheet Editor window appears.  

 Enter a name for the style in the Style sheet name box. 

 Note: If you want to update a style sheet that you 
have previously saved, begin typing the existing style 
sheet’s name in the box. Remark Web Survey looks for matches based on the 
letters you type and show you a list of possible matches for updating. 
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 Click the OK button to close the window.  

The style sheet is now saved and can be applied to any web form in Remark Web Survey. 

 

To update an existing style sheet 

 From the Home tab in the Ribbon, click the Dialog Box 

Launcher  next to the word Formatting. The 

Style Sheet Editor window appears. 

 Select the style sheet you wish to modify from the Pre-

defined sheets list.  

 All of the properties you had previously set appear. 

Modify the properties as desired. 

 Click the Update button to save your changes. 

 Click the Close button to close the window. The 

updated style sheet is now saved and can be applied to 

any web form in Remark Web Survey. 

 

To delete a style sheet 

 From the Home tab in the Ribbon, click the Dialog 

Box Launcher  next to the word Formatting. The 

Style Sheet Editor window appears. 

 Select the style sheet you wish to delete from the Pre-

defined sheets list. 

 Click the Delete button to delete the style sheet. 

 When prompted, click the Yes button to delete the 

style sheet. (If you do not wish to delete the style sheet 

at this time, click the No button to return to the Style 

Sheet Editor.) 

 Click the Close button to close the window. The style sheet is now removed from the available 

style sheets. 
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To apply a style sheet to a web form 

 From the Home tab in the Ribbon, click the down 

arrow on the Style Sheets icon. 

 Choose the desired style sheet to apply to the 

active web form. 

 When prompted, click the Yes button to apply the 

style sheet. (If you change your mind and do not 

wish to apply the style sheet, click the No button.) 

 The style sheet is applied to the entire web form. 

You may still change individual elements if desired. 

However, if you reapply the style sheet, any 

individual elements are modified to match the style 

sheet. 

 Note: Style sheets do not override rich text formatting. 

 

To share style sheets 

If you want to share your style sheet with another Remark Web Survey user, you may do so as long as you 

have multiple licenses of the software. For example, you may create a style sheet that you want to use as a 

standard for all of the web forms you create. The style sheets that you create are stored as XML files in the 

software’s installation directory. You can provide these XML files to another user and they can then apply 

the styles to forms they open in the Remark Web Survey Designer. 

 Locate the style XML files, typically stored in the Style Sheets folder of the Remark Web Survey 

installation directory (e.g., C:\Program Files (x86)\Gravic\Remark Web Survey 5\Style Sheets). 

 Copy the files to the same path on the other user’s system. 

 Open Remark Web Survey. You should see all of the styles you copied over within the Style Sheet 

Editor and via the drop-down list for the Styles icon on the Ribbon. 

Rich Text Formatting 
Rich text provides advanced formatting options for the text on your forms. Using rich text allows you to 

apply formatting to individual portions of an element. For example, you can add bold formatting to a 

single word in a label for emphasis. Or, you can change the color of a single word in a question. You may 

also enter “www” to insert a hyperlink (e.g., if you type www.gravic.com and turn on rich text formatting, 

the text becomes a hyperlink).  

When using the rich text formatting window, you may select an entire word or set of words and change its 

attributes. Or you may select a single word. You may even select a single letter to format. If you click 

within a word but do not actually select anything, the entire word becomes formatted with the selected 

rich text options.  

Note that rich text settings override any text formatting styles selected (e.g., if you have rich text 

formatting and apply a new style via the Style Properties window, the elements formatted with rich text 

do not acquire the new style settings). 
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When the rich text formatting option is turned on, some style properties are not available. When you click 

the Format button for any element that has rich text turned on, properties that can be modified while 

using rich text are available. All other properties are disabled. 

 

To use rich text formatting for questions and labels 

 Insert a question, or label element. Or, double click an 

existing question or label element. 

 In the question or label text area, type the information 

you would like displayed. 

 Mark the checkbox for Enable rich text formatting. 

 Format the text as desired using the toolbar in the rich 

text window. You may adjust font selection, font 

attributes, such as bold and italics, font color, 

background color, alignment and create bulleted lists. 

 Modify or add the rest of the element properties (if 

necessary). 

 Click the OK button to save the changes. 

 

To use rich text formatting for answers 

There are two ways to modify rich text formatting for answer elements: 

 

To use rich text via the Question Properties 

window 

To use rich text via the Answer Properties 

window 

 Insert a question element.   Insert an answer element, or double click an 

existing answer element in the tree view. 

 On the Answers screen, click in the cell 

containing the answer you wish to edit. 

 

 Click the link that reads Access current 

answer’s properties. 
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 In the Answer Properties window, you may apply rich text formatting to the HTML Display text. 

Type the information you would like displayed. 

 Mark the checkbox for Enable rich text formatting. 

 Format the text as desired using the toolbar in the rich 

text window. You may adjust font selection, font 

attributes, such as bold and italics, font color, 

background color, alignment and create bulleted lists. 

 Modify or add the rest of the element properties (if 

necessary).  

 Click the OK button to save the changes. 

 Note: It may be the case that the font you 
select here is not available on the respondent’s computer. Using the Remark Web 
Survey program options, you can select more than one font for your respondents. 
If the main font is not available on the respondent’s system, the backup fonts are 
used. Select the Application Button and then choose Web Survey Options to 
choose backup fonts that display when the selected font is unavailable. 
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Chapter 8: Using Question 

Branching  

Overview 
Remark Web Survey allows you to build branching into your web forms. Branching allows you to direct 

the respondent to another part of the web form based on how one or more questions are answered. For 

example, you might ask the following question:  

Have you recently contacted our service department? Yes or No. 

If the respondent selects “Yes” you may direct them to a series of questions about your service 

department. If the respondent selects “No” you may let them continue with the next question on the web 

form.  

Branching gives you flexibility in form design so that you can better select questions targeted to your 

respondents. At the same time, it makes the form easier to fill out because the questions are tailored to 

the respondent.  

Setting Up Branching 
In order to use branching, you must first add pages and questions to the web form. You can then add 

branching references so that if particular responses are chosen, the respondent is automatically taken to a 

specific page of the web form. 

 Caution: We strongly suggest that you first build the entire web form and then 
add branching. It is much easier to add branching once you have all of the 
questions/pages created. Note that branching is page specific, meaning that you 
can only branch to a question on a different page. If you change the web form at a 
later point, Remark Web Survey resolves the established branch patterns. However, 
for ease-of-use purposes, it is easier to create the branches with a completely built 
web form.  

Branching is set up at the page level. Once you have set up the pages on the form, you can go back 

and establish the branching patterns.  

 Caution: We strongly suggest that you make questions that are used in question 
branching “required” in the question attributes. A blank response for a question 
that triggers a branch pattern could cause unexpected results. 

 

To set up branching 

 Double click the page node to which you want to apply the branching pattern(s). 

 Click the Branching setup link to view the Branching Criteria Builder window. The Branching 

Criteria Builder window consists of the following properties: 
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Property Description 

Random Page Click the Random Page button to have the page appear in 

random page order each time it is accessed (this setting is useful 

when administering tests or trying to eliminate question bias). 

Typically you use the random option for all standard pages in the 

web form so that they all appear in a different order for each 

respondent. 

Text Click the Text button to display the question text for each 

question on the web form instead of field names (applies to the 

Question column of the branching grid). This setting depends on 

your personal preference as to how you would like the questions 

displayed. If this setting is not selected, the questions are listed in 

this window by field name. 

Field Name Click the Field Name button to display the field name for each 

question on the web form instead of question text (applies to the 

Question column of the branching grid). This setting depends on 

your personal preference as to how you would like the questions 

displayed. If this setting is not selected, the questions are listed by 

question text in this window.  

Insert Statement Click the Insert Statement button to insert a new statement 

within the branching grid. This feature is useful if you need to 

place a statement within other statements that you have already 

defined. Select an insertion point by clicking in a row first and 

when you click Insert Statement, the grid adds a row above your 

current selection point. It initially inserts the row as part of the 

selected statement. The Rule Numbers for the statements update 

themselves automatically as you begin to enter the criteria for the 

statement. You only need to use the Insert Statement function to 

add statements between other statements. If you are simply 

building a branching pattern from start to finish, use the rows of 

the branching grid in sequence on the screen. 

Delete Statement Click the Delete Statement button to remove a statement within 

the branching grid. Select a statement by clicking in a row and 

then when you click Delete Statement, the grid removes the 

selected statement(s). 

Group Statements Use the Group Statement option to group parts of the branch 

pattern (branching statements) together. This feature is useful 

when setting up multiple branch patterns on one page. It allows 

you to further customize the criteria that determine the branch 

pattern by grouping like statements together into one action. 
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Property Description 

Ungroup Statements Use the Ungroup Statements option to ungroup parts of the 

branch pattern. Ungrouping statements can be accomplished once 

you have grouped statements, as described above. You can use 

the ungroup option to make changes. 

Question Displays the questions on the entire form. Use the Question list to 

select a question to which the branch pattern applies. 

 Operator Displays the available operators for the branch pattern, which 

include = (equal to), <> (not equal to), > (greater than), < (less 

than), >= (greater than or equal to), <= (less than or equal to), 

starts with, ends with and contains. Select the item to which your 

branching pattern applies.  

Response Displays the response choices from the selected question. Select 

the Response choice that triggers the branch pattern or enter the 

appropriate text for a textbox/text area question. For example, if 

your choices are A, B, C and D and choosing C triggers the 

branching action, choose C from this list. Or, if it is a textbox style 

question, enter the text exactly as you expect your respondents to 

enter text in order to trigger the next action. 

Action Allows you to select the next action. Use Go To to set up a branch 

pattern that sends the respondent to another page on the web 

form when the particular response choice is selected. Use And to 

continue to set up branch patterns whereby the next pattern in the 

sequence must also be true in order to complete the branch. Use 

Or to continue to set up branch patterns whereby the next pattern 

in the sequence may also be true in order to complete the branch. 

Target Allows you to select the target action when using a Go To action. 

Use the Target column to select the page to which to branch 

based on the selected criteria. 

If none of the specified criteria is 

met always branch to: 

Allows you to set a page order. The default branch page is used in 

the absence of any user-defined branch patterns or if no branches 

are satisfied. Use the Next Page in Sequence option to have the 

respondent submit the web form in sequential page order when 

the branch criteria are not met.  

Reset Resets the current branch pattern, allowing you to start over. Note 

that all branching statements are removed when you click the 

Reset button. 
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Notice that there is a Criteria translation box below the branching options that displays your branch 

patterns as you build them. You cannot edit the text in this window, but you may use it to double check 

your logic when setting up your branch patterns.  

 If desired, select whether to view the questions in the Questions column of the branching grid by 

Text (question text) or Field Name.  

 In the Questions column, select the first 

question on which to base the branch pattern. 

 Note: You may resize the columns in 
this grid as you see fit. 

 In the Operator column, select the 

appropriate operator for the branch pattern 

(e.g., Q1 = Yes or Q1 <> No). 

 In the Response column, select or enter the 

question’s response on which to base the 

branch pattern. 

 In the Action column, select the next action. If 

you want to add more parameters to the 

branch pattern, select And or Or, depending 

on whether the next criterion must be true (AND) or can be true (OR) in addition to the previous 

criterion. If you want the respondent to go to a particular page based on this question and 

response, select Go To. 

 If you have selected Go To in the Action column, select a page in the Target column. If you have 

selected And or Or in the Action column, leave the Target column blank. 

 Continue to add branch statements as needed. Notice that based on the operators used and 

other criteria, the row headers in the grid update with Rule numbers. The Rule numbers provide 

you with a quick way to see patterns in your branching criteria. 

 If desired, use the Group Statements and Ungroup Statements buttons to refine the branch 

patterns. For example, if two parts of the pattern belong together, you may select them in the 

grid and then click the Group Statements button. Click and drag the row headers to select items 

to group together. When statements are grouped, Remark Web Survey evaluates them together 

before going on to the next branch sequence. 

 When you are finished building your branch pattern, go to the If none of the specified criteria is 

met always branch to setting. In the If none of the specified criteria is met always branch to 

drop-down list, select the page to which respondents should be taken in lieu of any other branch 

patterns. Select Next Page in Sequence to have the respondent go to the next page on the web 

form when the current page is submitted. Otherwise, select the appropriate page to return to the 

respondent when this page is submitted.  

 Click the OK button to save your changes. 

 Note: When using branching with hidden questions that allow multiple responses, 
you do not have a drop-down list available in the Response column. You need to 
manually enter the valid responses separated by commas and enclosed in 
parentheses. Example: 
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If your branching pattern has a Day field that equals multiple days, your branching pattern may look like 

this: 

Questions= “Day” 

Operator= “=” 

Response= “(Monday,Wednesday,Friday)” 

Note that there are no spaces between answer choices. 

You may have an unlimited number of branch patterns in your web form. Note that you receive a warning 

when attempting to publish a completed web form if the web form contains circular or broken references. 

A circular reference could put the respondent in an infinite loop when submitting the web form, indicating 

that you have not given them a way to submit the web form successfully based on their responses. 

Therefore, set up branching patterns carefully, ensuring a smooth transition from page to page regardless 

of the response chosen.  

Branching Example 
To help explain how branching works, we have included a sample below. 

Suppose you are conducting an employee survey to assess your organization. On this survey, you want to 

ask some questions that pertain to managers, directors and vice presidents only. Your form contains three 

Standard pages and one Web Form Complete page. The Standard pages are called: Page 1- Opening 

Page, Page 2- Manager Questions, Page 3- General Employee Questions. On the first Standard page, you 

ask the following question: 

What is your position: Associate, Supervisor, Manager, Director, Vice President. 

In order to direct the respondents who select Manager, Director or Vice President to a separate set of 

questions, your branching is set up like this: 

 

Question Operator Response Action Target 

What is your position? = Manager Or  

What is your position? = Director Or  

What is your position? = Vice 

President 

Go To Page 2- Manager 

Questions 

If none of the specified criteria is met always branch to: Page 3- General Employee 

Questions 

 

This setup can be interpreted as: 

If respondents select Associate OR Supervisor, they are directed to Page 3- General Employee Questions.  

If respondents select Manager OR Director OR Vice President, they are directed to Page 2- Manager 

Questions.  
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Random Page Order  
You may choose to have web form pages appear in random page order for each respondent. Random 

page order helps to eliminate the likelihood of viewing others’ responses as well as question bias based 

on the order in which questions are presented. Randomization is turned on in the Branching Criteria 

Builder window. 

 Note: When using random page order, you should not place a back button on the 
web form’s pages. 

 

To set up random page order 

 Double click the page node to which you want to apply the branching pattern(s). Remember that 

if you want all of your standard pages to appear in random order, you should apply the random 

branching pattern to all pages. You can multi-select pages by holding down the Ctrl key while 

clicking the page node in the tree view with the mouse (do not release the Ctrl key until you 

perform the next action, such as right clicking and choosing Properties). You can also select all 

standard pages by clicking the Standard Pages container node in the tree view. 

 Click the Branching setup link. 

 Click the Random Page button in the upper left hand corner of the window.  

 Click the OK button to continue. 

 Note: Random page order occurs in groups. 
For example, you could have pages 2, 3 and 
4 appear randomly for each respondent. This 
means that this group of three pages 
appears randomly each time the web form is 
accessed. Any sequential pages that you set 
to the Random setting are placed in one 
group. Therefore, you could have multiple 
groups of randomized pages. For example, 
suppose you have a 10-page web form and 
you set pages 1-3 to be random and 6-9 to 
be random. Two groups of random pages 
are created, meaning that pages 1-3 would 
always randomize, then 4-5 would always 
appear next, then 6-9 would always be randomized. 

Branching Visualizer 
Remark Web Survey includes a Branching Visualizer that displays the branching patterns you have set up 

in one concise window. This feature provides a way for you to review all of the branching you have set up 

on a web form in one place. Then you can go back to individual web form pages and make modifications 

if necessary. 
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To use the Branching Visualizer 

 Before utilizing the Branching Visualizer, set up your branching patterns, as described previously 

in this chapter. 

 From the Ribbon select the Tools tab. 

 Locate the Branching References icon and then drop-down the arrow at the bottom. 

 Click Branching Visualizer. 

 The pages of the web form are listed on the left. 

Expand any page by clicking the right arrow to the 

left of the page name.  

 Each page name is followed by Will Navigate To or 

Could Navigate To. If you see Will Navigate To, 

there is no explicit branching on the page and the 

default setting of going to the next page in sequence 

is in place. If you see Could Navigate To, it is likely 

that branching is set up on the page. 

 Each branching pattern is displayed in the right side 

of the window. When you click a page on the left, 

you see the possible pages that can be branched to on the right. To dig deeper, if you click the 

page sub nodes beneath the top level page, you see the questions and responses that trigger the 

specific branch to that page. 

 When you have finished reviewing the branching patterns, click the Close button to close the 

Branching Visualizer. 

You cannot make changes to the branching patterns in this window. If you see a problem, close the 

Branching Visualizer and then go to the page that contains the problem and make the necessary 

adjustments. You can always return to the Branching Visualizer to review the updates. 

Branching Validator 
Remark Web Survey includes a Branching Validator that checks an entire web form for invalid branching 

patterns. It looks for circular references and branches to pages or questions that do not exist. In other 

words, it looks for branching patterns that simply do not work because they are not properly set up. 

Remember that only you know the questions on your web form and how you want respondents to 

navigate the form. You are responsible for ensuring the accuracy of the branching patterns. Remark Web 

Survey ensures the functionality of the branching patterns that you have established. 

 

To use the Branching Validator 

 Before utilizing the Branching Validator, set up your branching patterns, as described previously in 

this chapter. 

 From the Ribbon select the Tools tab. 

 Click the Branching References icon. 
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 Remark Web Survey checks the entire web form for invalid branching patterns. Please note that 

for long/complex forms, this process may take a few moments. 

 If no problems are found, Remark Web Survey displays 

a message box stating that no issues were found; click 

the OK button. 

 If problems are found the Branching Issues window 

appears. This window displays any pages where 

branching problems exist, as well as the issue found 

(e.g., missing reference or circular branching). 

 You should go back to the page(s) displayed and make 

the appropriate adjustments in the Branching Criteria 

window. You may leave the Branching Issues window on the screen for reference. Note that the 

majority of branching problems result from setting up a branch pattern and then later removing a 

question or page that was part of the branch criteria. 

 Once you have made the appropriate adjustments, run the Branching Validator again to ensure 

all of your branch patterns will execute successfully. 



Chapter 9: Administering 

Web Forms 

Administering Web Forms Overview 
Remark Web Survey allows you to host the web forms that you create in the software on your own 

Windows or Linux/Unix web server. By hosting the web forms yourself, you have complete control over 

the administration of the web forms and their data. There are no limits in terms of number of web forms 

that can be published at one time or number of responses allowed (unless you define a limit in the web 

form’s properties). Administering forms is accomplished with the Perl scripts provided with the software. 

The administration script, rwsad5.pl (also known as the Remark Web Survey Control Panel), allows you 

to publish web forms and download or view the data submitted from those web forms. Each web form 

you create in Remark Web Survey is published to your web server, which can be accomplished 

automatically or manually. Automatic publishing of web forms places the entire contents of the web form 

(e.g., pages, images, etc.) in a folder on your web server. All data are collected in the same folder. The end 

result is that each individual web form has its own location on the web server for organizational purposes. 

Alternatively, manual publishing of forms requires you to go through a separate form installation process 

via the administration script.  

Once the administration script is up and running, you can begin publishing web forms. The data are 

collected via the data script (rws5.pl). Installing the scripts is covered in Chapter 2: Installing the 

Software. Your website administrator should install the scripts and verify that they are working properly. 

However, anyone with proper permissions can access the administration script to publish forms and 

download data. 

Setting Up Default Script Locations 
Remark Web Survey web forms are often created and published by different people. To streamline the 

form publishing process, you should set up the default locations for the Remark Web Survey scripts within 

the Designer component of Remark Web Survey, making it possible for people creating web forms to 

publish the forms without the intervention of the website administrator. When these options are set up 

properly in the designer portion of the software, the location of the data collection script is written to 

each HTML file you create, which allows proper web form submission. This topic is covered in greater 

detail in Chapter 2, but the basics are repeated below. 
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To enter the script URLs in the Designer Component 

 In the Remark Web Survey Designer Component, 

select the Application Button  and then click 

Web Survey Options.  

 Under Server details, enter the Admin script URL 

and the Data script URL. Both URLs must be fully 

qualified URLs (e.g., http://www.example.com/cgi-

bin/rwsad5.pl). Your website administrator, or the 

person who installed the Remark Web Survey 

Server component, should be able to provide 

these URLs to you. 

 

To set email settings in the Designer Component 

In Remark Web Survey, emails can be used for three different functions: 1) the built-in email client that is 

used to send web form invitations and reminders, 2) submission notification emails that are sent every 

time a web form is completed by a respondent, or 3) pause page reminders to resume a web form once it 

is started and stopped. You can use an SMTP server (Simple Mail Transfer Protocol) or a Sendmail server 

to send emails from Remark Web Survey. These two types of setup are simply different methods of 

sending email. Please note that the built-in email client only works with an SMTP mail server. If your web 

server is configured to use a local Sendmail server, Remark Web Survey can utilize the Sendmail server for 

sending submission emails or for sending pause page email reminders to respondents who have paused a 

web form in progress.  

Setting up and configuring email servers is independent of Remark Web Survey. Once you have 

determined the type of email method to use and verified your email server is working, you can configure 

Remark Web Survey to use it. To set up the email functionality in Remark Web Survey, you likely need the 

assistance of your web server or network administrator. This person should be able to tell you the 

information that Remark Web Survey requires, such as the names of the servers and ports that they use. 

 Continuing from Step 2 above, click the link titled Email 

settings. 

 Enter the Administrator email address. This email address 

is often the webmaster of the website, but can be any email 

address of your choosing. It should be someone who is 

familiar with Remark Web Survey and in a position to 

troubleshoot any web form issues that may arise. 

 Under Email method and settings, first set up the Web 

Server email settings. Web server email is generated for 

email messages that are transferred by the web server, such 

as form submission emails, advanced notification emails and 

pause page reminders. 

 Choose the type of email configuration you are using: SMTP 

or Sendmail. 
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 If using SMTP, enter the SMTP server and the SMTP port. The SMTP port is usually 25 but may 

vary with your email server.  

 [Optional] If authentication is required, enter the 

Username and Password. 

 If using Sendmail, enter the Server path (e.g., 

/usr/sbin/sendmail). 

 Next, set up the Local Machine email settings. The local 

machine is used for emails that are generated from the 

local computer, such as web form invitations and 

reminders. 

 Enter the SMTP server and the SMTP port. The SMTP port 

is usually 25 but may vary with your email server.  

 [Optional] If using a secure connection, mark the checkbox 

for Enable a secured (SSL) connection. 

 [Optional] If you need to use authentication, you can enter 

credentials or use those of the user. Mark the Use the default credentials of the currently 

logged in user checkbox to utilize the user’s credentials (e.g., the person logged in when sending 

the emails from the Remark Web Survey Designer component). Otherwise, continue to Step 14 to 

enter specific credentials. 

 [Optional] If authentication is required, enter the Username and Password. 

 Enter a Throttle rate or accept the default setting (500 ms). The throttle rate specifies how many 

milliseconds to wait before sending the next email in the queue. This setting helps prevent the 

email server from becoming overloaded when sending a large number of emails. 

 Click the OK button to save the options. 

 Note: Please review Chapter 2 for detailed information about requirements when 
using server authentication. 

Each new web form you create now uses these properties. If you need to change any of this information 

for an individual web form, you can do so within the web form’s properties. See Chapter 4 for further 

information about editing an individual web form’s properties. 

The Remark Web Survey Control Panel 
The Remark Web Survey Control Panel appears each time you access the administration script (rwsad5.pl). 

The Control Panel allows you to administer web forms, including managing data files, manually installing 

web forms and obtaining a quick overview of a web form’s statistics (Remark Live Stats™). You may access 

the Control Panel in one of two ways: 

 From within Remark Web Survey, select the Web tab from the Ribbon and then click Control 

Panel.  

 From a web browser, enter the URL to the administration script (e.g., 

http://www.example.com/cgi-bin/rwsad5.pl).  
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A username and password is required to gain access to the Control Panel. The default username is 

administrator and the default password is rws, but the password may have been changed during 

installation (we recommend changing the password for security reasons). The person who installed the 

Remark Web Survey Server component sets up the administrator password. There can only be one 

account named administrator that accesses the Control Panel. You may make other accounts with various 

privileges using different usernames. Each user who is able to publish forms and download data 

automatically from the Designer component needs a username and password, which is entered in the 

Admin Control Panel access area of the Designer component. Please see Chapter 2 for detailed 

information about setting up user accounts. 

Once you log in to the Control Panel, you have several options related to web form and data 

administration (these options vary based on your permission level). You may perform the following 

functions from the administration Control Panel:  

 

Tab Feature Description 

Server Setup Default form directory Specifies a default directory for storing all active 

web forms. If using the auto publish feature, each 

time you publish a web form, the form is 

automatically published to the web server and a 

new sub-directory is created in the Default form 

directory.  

If using the Create Publish Package form of 

publishing, which is a manual process, you have to 

place each installed web form and its components 

in the Default form directory. Each form has its 

own sub-directory.  

Caution: This directory should be a non-public 

directory for optimum security. The Remark Web 

Survey scripts must be able to read, write and 

delete information to and from this directory. If 

you do not set up a default form directory, the CGI 

directory is used. 

 Image script name Specifies the name of the image script used to 

handle the publishing of web form images. This 

script is supplied with Remark Web Survey and 

should be uploaded to your CGI directory. By 

default, this script is called rwsimg5.pl. However, if 

your web server uses the .cgi extension for scripts, 

you may change it to rwsimg5.cgi. Do not change 

the name of the file up to the extension. 
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Tab Feature Description 

 Enable automatic 

publishing 

Allows for automatic publishing (uploading) of 

forms directly from Remark Web Survey to the 

web server. When users click the Publish Web 

Form button in the Designer component (after 

supplying a valid Control Panel username and 

password), the forms are automatically uploaded 

to the Default form directory and installed on the 

web server. This action eliminates the necessity of 

a website administrator’s intervention to post web 

forms on your web server. If you do not enable 

automatic publishing, users have to use the Create 

Publish Package method of posting web forms. A 

webmaster (or similar) needs to place the 

published forms on the web server and install 

them via the Remark Web Survey Control Panel. 

 Enable automatic 

downloads 

Allows for automatic downloading of data directly 

into Remark Web Survey from the web server 

(after supplying a valid Control Panel username 

and password). This action brings the data directly 

into the software, where it can then be analyzed 

with Remark Quick Stats® or exported. If you do 

not allow automatic downloading of data, you 

need to download the data from the Control Panel 

in a web browser and then open it in Remark Web 

Survey. 

 Enable respondent 

logging 

Allows for a log file to be kept for each form 

submission, showing the unique ID, IP address, 

date and time of the submission, as well as 

whether it was successful. If a problem occurs, it is 

listed in the log file (e.g., the respondent could not 

login due to an invalid password). Generally 

speaking, you want to enable respondent logging 

in case a problem arises. 
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Tab Feature Description 

 Use CGI for form 

redirections 

The Use CGI for form redirections setting 

applies when you redirect a respondent in your 

Web Form Complete page. Web Form Complete 

pages can simply be links to another page. This is 

called redirection. Enable the Use CGI for form 

redirections setting to redirect the user utilizing 

the CGI’s built in redirect method. If you do not 

use this setting, Remark Web Survey uses a basic 

HTML redirection. This setting is enabled by 

default. You should only change this setting if 

redirection is not working using the default 

setting. 

 Enable data backup 

during uploads 

Use the Enable data backup during uploads 

option to automatically create a backup of the 

data file when a form is published to the web 

server and the user selects to overwrite the data. A 

file called “archivedatetime.bak” is created. If 

needed, you can rename this file with a .rwd 

extension to restore your data. Note: this setting 

is only available when publishing forms from the 

Designer component (not when deleting data via 

the Control Panel). It does not back up the log file 

or temporary files. 

 Define local IP address for 

SMTP 

Use the Define local IP address for SMTP setting 

to change the client-side IP address used by Perl 

when making a socket connection to an SMTP 

server. This feature is useful if a computer has 

multiple IP addresses so that you can ensure the 

correct one is being used. 

Web Forms  Select form Use the Select form drop-down list to select a 

currently installed web form and then choose the 

desired actions listed below. 
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Tab Feature Description 

 Install Form Use the Install form button to install web forms 

when automatic publishing is not enabled. If you 

do not publish your web form automatically, you 

must first use the Create Publish Package 

method to generate the web form, place it 

manually on your web server in the Default form 

directory and then install it via the Remark Web 

Survey Control Panel. After clicking Install Form, 

enter the form name exactly as it appears in 

Remark Web Survey (the form name is the top 

node of your web form when opened in the tree 

view of the designer) and then click the Install 

Form button. 

 Access Form Use the Access Form button to launch the live 

web form in your web browser. This feature is 

useful if you need to test a web form. Note that 

the web form displays in a new window. If you 

have pop ups blocked you may need to update 

your web browser to allow pop ups for this site. 

 View Log Click the View Log button to view the current log 

file for the selected web form. The log file holds 

information about each submission, such as the 

date, time and success or failure. 

 Download Log Click the Download Log button to download the 

current log file for the selected web form. You can 

open the resulting file in a text editor, such as 

Notepad. 

 Reset Log Click the Reset Log button to reset the log file for 

the selected web form. Resetting the log file 

removes any log file entries for web form 

submissions up to this point. Note that once you 

reset the log file you are not able to get it back.  
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Tab Feature Description 

 Remove Form Use the Remove form option to uninstall a web 

form. Select the desired web form from the drop-

down list and then click the Remove Form 

button. This action is appropriate when the web 

form is no longer active. This option does not 

physically remove the web form and its 

components from the web server unless you 

select the checkbox for Remove server files. 

However, respondents are no longer able to 

access the web form. 

 Remove server files Mark the Remove server files checkbox to 

remove all web form-related files from the web 

server (e.g., HTML files, images, data file, log file) 

when removing a web form. Note that you are not 

able to get the files back once you remove them. 

Ensure that you have downloaded your data file 

prior to removing a form and its server files. 

Data & Stats Select form Use the Select form drop-down list to select a 

currently installed web form and then choose the 

desired actions below. 

 Remark Live Stats Click the Remark Live Stats button to view 

current statistics for each question on the web 

form. The statistics are updated dynamically each 

time you click the button. You may also print the 

results. See Chapter 11 for detailed information 

about Remark Live Stats. 

 View Data Click the View Data button to view the current 

data for the selected web form.  

Note: If a question is set to Treat each answer 

choice as a separate question, the data appear 

as one question in this view. When downloaded, 

the data are output to separate data cells. 
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Tab Feature Description 

 Download Data Click the Download Data button to download the 

current data for the selected web form. The data is 

in a format called .rwd. Do not change it from this 

format. The Remark Web Survey designer is able 

to open this data file, allowing you to export it to 

another format or analyze it within the software. 

When downloading data, be sure that the file 

extension remains .rwd in your browser’s Save 

window. 

 Incomplete Data Click the Incomplete Data button to download 

any data submissions that were not completed. 

Incomplete data resides on the web server when 

someone starts to complete a web form but never 

finishes it. You may open this data into the 

Remark Web Survey Designer component and 

then determine how much of the web form must 

be completed in order to include the incomplete 

submissions in the analysis. See Chapter 10 for 

more detailed information.  

 Reset Data Click the Reset Data button to reset the data file 

for the selected web form. For example, you may 

test your web form before allowing respondents 

to submit it; you can use the Reset Data button to 

clear out your test data. Or, you can use the Reset 

Data button for cyclic web forms that you collect 

data on repeatedly. Once one term is completed, 

you can download and save the data, clear it and 

then start over again. Note that once you reset the 

data you are not able to get it back. Ensure that 

you have a local copy of the data before resetting 

the data. 
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Tab Feature Description 

Users Add User Click the Add User button to add user accounts to 

the Control Panel. The default user account is 

administrator. This account is used when 

publishing forms and downloading data. You can 

create other access accounts and set the 

permissions for those accounts. When you click 

the Add User button, enter a Username and 

Password for the new account. Then set the 

permissions:  

Administrator: User has full access to the Control 

Panel. 

Standard User: User can only view statistics and 

data, but for all installed forms. Optionally, user 

can be allowed to publish web forms 

automatically and download data from the 

Designer component. 

Restricted User: User can only view statistics and 

data for the web forms that you select. Optionally, 

user can be allowed to publish web forms 

automatically and download data from the 

Designer component for the specified web forms. 

Password  Click the Password section to change the 

password used to access the Remark Web Survey 

Control Panel. Enter the old password, the new 

password and then confirm the new password. 

Diagnostics  The Diagnostics information assists with 

troubleshooting server issues. It is primarily used 

by Gravic Support. Problems with script 

permissions are enumerated here. This area also 

shows all installed web forms, along with a test 

email button to ensure email functionality is 

working. The SMTP Test Script area is used to 

troubleshoot email issues; Gravic support can 

instruct you on how to use this section. Finally, a 

link to the Remark Web Survey test script 

(rwstest5.pl) is available for more detailed 

troubleshooting. Please install and launch this 

script in order to provide these details to Gravic 

Support when having server (script) issues. 
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Resetting the Default Administrator 

Control Panel Password 
There may be a reason you need to completely remove the stored administrator password for the Remark 

Web Survey Control Panel (e.g., the current password is lost, the person responsible for administration 

leaves and you do not know the password, etc.). The password is stored in a configuration file 

(rwsem5.cfg) that can be safely deleted if necessary.  

 Note: The password configuration file should only be deleted by the website 
administrator or another qualified individual. 

 

To delete the Administrator Control Panel password 

 Using an FTP program, logon to your web server. Or, if your web server is in-house, logon to the 

web server computer. 

 Locate the file called rwsem5.cfg in your Remark Web Survey config directory. We suggest 

backing up the file before you delete it. 

 Delete the rwsem.cfg file. This resets the administrator password to the default password, which is 

rws. The next time you access the Remark Web Survey Control Panel, you are prompted to 

change the password for the administrator account. 

Publishing Web Forms - Automatic Web 

Form Publishing 
Once you have created a web form in Remark Web Survey, you need to publish it to your web server. 

There are two ways to publish forms:  

 Automatic: Clicking the Publish Web Form button in the Remark Web Survey 
designer. 

 Manual: Clicking the drop-down arrow on the Publish Web Form button and 
choosing Create Publish Package in the Remark Web Survey designer. 

The automatic publish option makes it easier for you to move the web forms from a local system to the 

web server without the assistance of a website administrator. In order to publish web forms automatically, 

this option must be enabled in the Remark Web Survey Control Panel (see Chapter 9 for further details) 

and the user must have a Control Panel login with automatic form publishing enabled (see Chapter 2 for 

further details). In addition, the current user must have the appropriate permission level to access your 

web server. Your website administrator is responsible for setting permission levels on your web server. If 

you do not have permission to access your web server, you need to manually publish files to the web 

server. This topic is covered in Chapter 9. 

If automatic form publishing is enabled, when a user clicks Publish Web Form in the Designer component, 

the web form and all of its related files, such as images, multimedia and configuration files, are posted to 
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the web server in an individual folder. This folder is created in the Default form directory that is specified 

in the Remark Web Survey Control Panel.  

 Caution: The Default form directory should be a non-public directory for 
optimum security. The Remark Web Survey scripts must be able to read, write and 
delete information to and from this directory. 

For example, if the Default form directory is C:\Inetpub\surveys, each time a web form is published using 

the Remark Web Survey designer, a new folder is created in the C:\Inetpub\surveys folder. If a web form is 

called “satisfaction_survey” a folder called satisfaction_survey is created in the surveys folder. The 

satisfaction_survey folder contains the HTML pages of the web form, any related image files, configuration 

files and, as the web form is submitted, the data files, log files and unique IDs of each respondent. Note 

that the data script (rws5.pl) needs to be able to write data to this directory each time a web form is 

submitted. Therefore, the Default form directory should be set up with permissions that allow the data 

script to read, create, write and delete information.  

Once the publish process completes, the web form is ready to use. You do not need to install the web 

form separately. 

 

To allow automatic web form publishing (enabled by default) 

 Log in to the Remark Web Survey Control Panel in a web browser (rwsad5.pl script) using an 

account with administrator privileges. 

 If you have not yet configured a default form directory, in the box titled Default form directory, 

enter the path of the folder where you would like all web forms to be published. You have full 

control over the path you choose. It can be any location 

on your web server. 

 Caution: The Default form directory should 
be a non-public directory for optimum security. 
The Remark Web Survey scripts must be able to 
read and write information to and from this 
directory. 

 Mark the checkbox for Enable automatic publishing. 

 Click the Update button to set the configuration. You 

should receive a message indicating that the 

configuration change was successful. 

 

To publish web forms automatically 

 Create a web form in the designer portion of Remark Web Survey. 

 When completed, expand the Admin Control Panel Access bar at the bottom of the window (if it 

is not already expanded). You may view the Admin Control Panel Access bar by either clicking the 

expandable splitter, , at the bottom of the window, or by selecting the View tab from 

the Ribbon and then clicking Admin Control Panel Access. 

 Login to the Remark Web Survey Control Panel. Enter your Username and Password and then 

click the Login button. 
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 Once logged in, click the Publish Web Form button. 

 After the web form is published, a window appears showing you the URL to your web form and 

asking if you would like to view the web form in a web browser. If you click Yes, your default web 

browser opens the web form and you see the URL that your form uses. You must provide this link 

exactly as it appears in this window to the respondents who are submitting the web form (e.g., if 

you are sending an email to direct respondents to your website to submit the form, give them this 

link. Or, if you are putting a link on your website to the form, use this link). This link is in the 

format of: http://www.example.com/cgi-bin/rws5.pl?FORM=formname, where cgi-bin is the 

CGI/script directory on your website, rws5.pl is the Remark Web Survey data script and formname 

is the name of the web form being submitted. You can copy the web form URL to the Windows 

clipboard at any time by clicking the Copy Web Form URL to Clipboard link in the Web Form 

Details section of the Remark Web Survey designer. Copying the link is useful if you are adding a 

link to your web form on a page of your website or placing it in an email message. For example, 

you can open an existing website page in an HTML editor, copy the link from Remark Web Survey 

and then paste it into the appropriate location on your website page. When you upload your 

website page, the link is available for respondents to reach your form. 

 Click the Yes button to view the form online or click the No button to return to the designer.  

 Tip: If using a password protected web form, it is possible to embed the user’s 
password within the link you send out to submit your web form. Embedding the 
password allows the respondent to simply click the link and go right to the web 
form without having to enter a password. The password can still be added to the 
data file and used to track which respondents have submitted (or not submitted) 
the web form. Use the following syntax to embed the password in a link: 
http://www.example.com/cgi-bin/rws5.pl?FORM=name&PWD=password, where 
“password” is the actual password for the respondent. This syntax only applies 
when sending email outside of Remark Web Survey. If you are using the built-in 
email center see Chapter 9 to learn how to embed passwords into the URL or email 
invitation.  

Overwriting Existing Web Forms 
If a web form already exists on your web server, when you attempt to publish it again, you are prompted 

to overwrite the existing web form. You may choose to only overwrite the existing HTML pages, or you 

may also overwrite the existing data file, log file and temporary files. If you overwrite the data, log and 

temporary files, you are not able to recover log and temporary files. This action resets the data and log 

files on the web server, deleting the existing files. Note that a backup of the data file only is created if 

this setting is turned on in the Remark Web Survey Control Panel (it is on by default; see Chapter 9). The 

backup file’s syntax is “archive-datetime.bak” (e.g., archive-20144101415.bak, where “2014410” is April 10, 

2014 and “1415” is 2:15PM). Ensure that you have downloaded any data and/or log files you wish to keep 

prior to overwriting them. The temporary files include data from partially completed forms. Whenever a 

respondent accesses your web form, a UID (unique identifier) is created. This UID file tracks respondents 

so that they can pause the web form and come back to it at a later time. Once again, ensure that these 

UID files are no longer needed before selecting to overwrite the data, log and temporary files. 
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For password protected web forms, a password file is published to the web server in the Default form 

directory. This file contains the allowed passwords in an encrypted state along with the number of uses 

allowed for each password. When you publish and overwrite a web form that uses passwords, you have 

three options for handling the password file: 

 

Overwrite Option Description 

Merge existing password file 

with the latest version 

When using the merge option, the file you are publishing is the 

master. If passwords exist in that file but not on the web server, 

they are added. If passwords do not exist in the file you are 

publishing, but do exist on the web server, they are removed from 

the web server. In short, whatever exists in the file you are 

publishing is what ends up on the web server as valid passwords. 

Note that when using the merge option, the usage count for 

existing passwords is not affected. Therefore, if a password exists 

in the file you are publishing and on the web server, its usage 

count is not reset. Use this option when you want to add 

passwords to the password file on the web server but do not want 

to modify the usage count (e.g., a web form is already in progress). 

Overwrite the existing password 

file with the latest version 

When using the overwrite option, whatever is in the password file 

you are publishing is what is used on the web server. This option 

resets passwords and the usage count. Use this option when you 

want to completely update the password file on the web server 

with the current information in your .rwsx file (e.g., after testing the 

form to ensure that it works, you may wish to reset all of the 

passwords so your respondents can begin submitting the web 

form). 

Keep existing password file When using the keep option, the password file that already exists 

on the web server is used. Anything listed in the password area of 

the web form you are publishing is ignored. Use this option when 

you want to make a change to the form that does not affect the 

passwords; this method allows you to publish web form changes 

without affecting any passwords that may have already been used. 

 

Overwriting existing web forms 

 When the web form is ready to publish, expand the Admin Control Panel Access at the bottom 

of the designer window (if it is not already expanded). You may view the Admin Control Panel 

Access bar by either clicking the expandable splitter  at the bottom of the window, 

or by selecting the View tab from the Ribbon and then clicking Admin Control Panel Access. 
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 Log in to the Remark Web Survey 

Control Panel. Enter your Username 

and Password and then click the Login 

button. 

 Once logged in, click the Publish Web 

Form button. 

 When the Published Web Form Exists 

window appears, select whether to Overwrite or Cancel. Before selecting a button, choose 

whether to remove the existing data, log and temporary session files (see previous explanation of 

this option). Use extreme caution when choosing to remove these files. You are not able to get 

the log files or temporary files back. 

 [OPTIONAL] If using a password protected form, 

select how you would like to handle the password 

file, as described previously (Merge, Overwrite or 

Keep). 

 Click the Overwrite button to proceed with the 

web form upload. If you do not wish to overwrite 

the web form at this time, click the Cancel button. 

 After the web form is published, a window 

appears confirming that the web form was successfully published. Click the Yes button to view 

the web form online or the No button to go back to the designer.  

Create Publish Package - Manual Web 

Form Publishing 
If you choose not to allow automatic web form publishing all web forms have to be published (uploaded) 

manually and then installed via the Remark Web Survey Control Panel. When using the manual publish 

process, you create a publish package. This process combines all of the files needed to administer the web 

form into one folder. During the publish process, you select where that folder should be stored locally. 

You may then move the contents of the folder to the proper location on your website (e.g., via an FTP 

program or, if your web server is in-house, by copying the files to the web server).  

If you primarily design web forms but are not involved in the server side of the process, you need to get 

your website administrator involved at this point. Once the publish package is created, you can provide 

the folder that is created to the website administrator to post on the web server. It is strongly 

recommended that your website administrator reads this section of this user’s guide. 

 Note: Using the Create Publish Package feature requires that you create the 
appropriate sub-directory under the Default form directory on your web server 
specified in the Remark Web Survey Control Panel. The entire contents of the 
directory that is created during the Create Publish Package process should be 
placed in the Default form directory (e.g., copy the folder to the Default form 
directory). If the files are not placed in this directory, web form submission will not 
work correctly. Please do not rename any files in the folder or the folder itself. 
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 Tip: Remember that if you are using an FTP program to upload files to your web 
server, HTML, configuration (.cfg) and text files need to be uploaded in ASCII 
format. Images and multimedia files should be uploaded in Binary format.  

 

To use the Create Publish Package feature 

 Create a web form in the designer portion of Remark Web Survey. 

 When completed, select the Application Button , then select Publish and then click Create 

Publish Package. Alternatively, expand the Admin Control Panel Access bar at the bottom of 

the window (if it is not already expanded). You may view the Admin Control Panel Access bar by 

either clicking the expandable splitter  at the bottom of the window, or by selecting the 

View tab from the Ribbon and then clicking Admin Control Panel Access. Click the down arrow 

on the Publish Web Form button and then select Create 

Publish Package. 

 In the Browse for Folder window, choose a location in which 

to store the web form and related files. Remark Web Survey 

creates a subfolder in this folder containing the files. This 

location can be directly on your web server if you have access, 

or a temporary holding place (you can move the files to your 

web server later). 

 Click the OK button to save the files. 

 If not already completed in Step 3, move the files to the 

Default form directory on your web server (e.g., use an FTP 

program to move the files from your local system to your web 

server). See your website administrator for assistance. 

 Note: Do not change the names of the folder or files that are created by Remark 
Web Survey. 

Once you have created the publish package, you must manually install the web form before it can be 

used. 

 Note: The manual form installation process only applies to forms that are 
published using the Create Publish Package method. Automatic publishing using 
the Publish Web Form option does not require separate form installation. 

 

To install web forms 

 After placing the web form and related files on your web server in the specified Default form 

directory, access the Remark Web Survey Control Panel in a web browser (rwsad5.pl script). You 

may access the Control Panel by selecting the Web tab from the Ribbon and then choosing 

Control Panel from within Remark Web Survey, or by entering the URL of the Remark Web 

Survey administration script (rwsad5.pl) in a web browser. 

 You need to log in with an account that has administrator privileges to install web forms. Enter 

the username in the Username box and the password in the Password box and then click Login. 

 Click the Web Forms tab. 
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 Click the Install Form button.  

 In the box titled Enter form name enter the 

name of the web form that you wish to install. 

The form name must be entered exactly as it 

appears in the top node of your web form in the 

designer portion of Remark Web Survey 

(including capitalization). It is not the name of 

the .rwsx file. 

 Click the Install Form button to complete the 

web form installation. You should receive a 

message indicating that the web form was successfully installed. 

 Note: If the installation is not successful, check the name of the web form that you 
entered. Incorrectly typing the web form name is the most common cause of form 
installation errors. Remember that it must be entered exactly as it appears in the 
Remark Web Survey Designer component (not the name of the .rwsx file). 

Your web form is now ready for use. You need to provide a link to your web form in order for respondents 

to access it (typically you send an email to direct respondents to your website to submit the form or put a 

link on your website to the form). The web link should be in the following format: 

http://www.example.com/cgi-bin/rws5.pl?FORM=formname, where cgi-bin is the CGI/script directory 

on your website, rws5.pl is the Remark Web Survey data script and formname is the name of the form 

being submitted. 

 Note: You may also click the Copy Web Form URL to clipboard link, which is 
located in the bottom of the Web Form Details window, to copy the link to the 
Windows clipboard. Copying the link is useful if you are adding a link to your form 
on another page of your website or placing it in an email message. For example, 
you can open an existing website page in an HTML editor, copy the link from 
Remark Web Survey and then paste it into the appropriate location on your 
website page. When you upload your website page, the link is available for 
respondents to reach your form. 

Removing Installed Web Forms 
Web forms can be removed when they are no longer needed. Removing a web form with the Remark 

Web Survey Control Panel removes the form’s properties from the rwsad5.cfg file, making it unavailable 

on your web server. You may also optionally remove all web form related files from the web server.  

 Caution: Before removing all files, be sure you have downloaded a copy of your 
data and any other files you might need.  
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To remove forms 

 Login the Remark Web Survey Control Panel in a web browser (rwsad5.pl script). You need to log 

in with an account that has administrator 

privileges to remove web forms. 

 Click the Web Forms tab. 

 Select a form from the Form drop-down list.  

 If desired, mark the Delete Server Files 

checkbox. When selected, all files, including 

data, are removed from the web server.  

 Caution: Enabling Delete Server Files 
deletes all web form related files from 
the web server, including data files, log files and temporary session files. You are 
not able to recover these files. 

 Click the Remove Form button to remove the web form. 

 A confirmation page appears. If you are certain you want to remove the web form, click the Yes 

button to continue. The web form is permanently removed. 

Emailing Web Form Invitations 
Remark Web Survey includes an email client to allow you to send invitations and reminders to your 

respondents. This feature is most useful when using password protected web forms where you have 

entered email addresses in the password list builder. However as long as you know your respondents’ 

email addresses, you can use the built-in email client. The email client utilizes your SMTP server to send 

email. You must have an SMTP server configured outside of Remark Web Survey to use the email client. 

When you send email invitations, an email is automatically generated that contains the link to your web 

form. You then add the recipients to the message. If you are using a Login page where you have entered 

email addresses, the addresses are included in the outgoing email automatically. You may also append 

the password to the web form link so that respondents do not need to type in a password to access the 

form. You may modify the subject line and body of the email; however do not modify the link to your web 

form. If you change this link, respondents are unable to access your web form. Merge fields can be added 

to the email, such as a username and password that can be pulled from your password list. You can also 

create email templates to be reused for commonly used web forms. 

The Send Invitations function is used to invite people to submit your web form or to send reminders to 

those who have not submitted the web form. Reminders are covered in the Respondent Detection section 

of this user’s guide in Chapter 10. 

 Note: If you are using Query Parameters and want to send emails from Remark 
Web Survey, use the Advanced option on the Send Invitations button. Please see 
Chapter 5 for detailed information about using the Advanced options. Then return 
to this section for generic information about the email window. 
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To send email invitations for non-password protected web forms 

 Before attempting to send emails, ensure that your SMTP server information is set up in Remark 

Web Survey, as outlined in Chapter 2. The Local Server settings apply to email invitations. 

 Create a web form in Remark Web Survey as you normally would, publish it to your web server 

and test to make sure it works as expected. When you are ready to send invitations to your 

respondents, continue to step 3. 

 From the Tools tab of the Ribbon, select Send Invitations. The Email Message window appears. 

 Use the To section to enter email addresses of your respondents. You have two options for 

entering the email addresses: 

 Manually type in the email addresses. Separate the email addresses with a semi-
colon (;). 

 Import a list of email addresses from a database. Supported databases include 
Access, dBase, Excel, FoxPro, Paradox and ODBC. Click Database connection 
settings to set up a connection to an external database containing the desired 
email addresses.  

a) Choose the type of database you wish to use from the Type drop-down list.  

b) Click the Open folder button to select the database containing the desired information. 

c) [Optional] If you are using an ODBC connection, choose the DSN from the DSN drop-down list. 

Mark whether it is Directory based or DSN based. 

d) [Optional] If your database requires a login, enter the Username. 

e) [Optional] If your database requires a login, enter the Password. 

f) Note: The Connection String displays the connection string that is working behind the scenes to 

connect to your selected database. You do not need to edit this string; it is for informational 

purposes only. 

g) [Optional] You may optionally click the Test Connection button to test whether you can connect 

to this database. 

h) Click the OK button to return to the Respondent 

List window. 

i) Use the Table list to select the table from your 

database that contains the email addresses you 

wish to import. 

j) Use the Email field list to select the field in the 

connected database that contains the desired email 

addresses.  

k) Click the Import button. 

l) Click the OK button to the prompt that tells you 

the emails were imported successfully. 

m) Click OK to close the window. You should see all of the email addresses you imported in the To 

line of the email. 
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 The From address is filled with the web form administrator address that was entered in the web 

form’s properties. Accept the default or enter a new email address. 

 The Display name defaults to the first half of the 

From address. You may put any name you like. This 

name appears as the Sender with the 

corresponding email address (e.g., Webmaster 

(webmaster@example.com). 

 Accept or modify the Subject line of the email. 

 At this point you can either manually alter the body 

of the email or apply an email template. If you wish 

to apply an email template, click the Email 

Templates button and choose the desired 

template. Email templates are covered in detail in 

Chapter 9.  

 [Optional] Use the options on the toolbar to customize your message, if desired. You may add an 

attachment , send the email with High Importance  or format the email in 

HTML .  

 [Optional] If desired, click the Local Machine button to choose which email server to use to send 

the emails (this is uncommon). The Local Machine settings can be added at both a program level 

and a web form level. If the two server settings differ, you can use this button to choose which 

server you wish to use. If the two do not differ, the server information entered is used by default. 

 [Optional] Add merge fields to the email by clicking the Merge Field button. Merge fields allow 

you to personalize the email by adding in keywords that are merged when the email is sent. For 

non-password protected forms, the only option is the Web Form URL. If you accidentally remove 

the URL, you can use this option to add it back into the email. You can also use this option to 

position the URL in a different place within the email. Select an insertion point in the body of the 

email, click Merge Field and then choose the Web Form URL. 

 When you have the email formatted as desired, click the Send  button to send the emails. 

They are sent in a batch mode so as not to overload your email server. Respondents receive the 

email in the format that is set up in their email client. They can either click or copy the link to your 

web form that is included in the body of your email message. 

 

To send email invitations for password protected web forms 

 Before attempting to send emails, ensure that your SMTP server information is set up in Remark 

Web Survey, as outlined in Chapter 2. The Local Server settings apply to email invitations. 

 Create a web form in Remark Web Survey as you normally would, including a Login page, publish 

it to your web server and test to make sure it works as expected. If you include additional 

information in the Login page, such as names and email addresses, you are able to utilize it when 

sending emails. When you are ready to send invitations to your respondents, continue to step 3. 

You have two options for getting passwords (and usernames if in use) into your respondents’ hands: 
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 Embed them into the web form URL. Embedding the username and password into 
the web form URL means respondents are automatically logged in when they click 
the URL. The username and password information is encrypted in the URL. 

 Add Merge Fields to the body of the email that tells respondents their password 
(and username, if using one). 

You can do one or both of the above options. Even if you embed login information in the URL you may 

wish to make respondents aware of their password in case 

they need it later. 

 [Optional] If you wish to embed the password into 

the URL, from the Tools tab of the Ribbon click the 

down arrow on the Send Invitations button and 

choose Include Username/Password. You will not 

notice the username and password embedded in 

the invitation URL. However, when the emails are 

sent, this information is included in an encrypted 

format. 

 If you do not wish to include the 

username/password into the URL, from the Tools 

tab of the Ribbon click the Send Invitations button.  

The Email Message window appears. 

 Use the To section to enter email addresses of your respondents. When using a password 

protected web form if you have entered email addresses in the password list builder screen, the 

To section of the email is automatically filled with your respondents from the Password list 

builder window. 

 [Optional] If desired, you may input more email addresses by either typing them in manually 

(separated by a semi-colon (;)) or by importing the passwords from an external database. Please 

see the previous set of instructions for importing passwords (“To send email invitations for 

non-password protected web forms”). 

 The From address is filled with the web form administrator address that was entered in the web 

form’s properties. Accept the default or enter a new email address. 

 The Display name defaults to the first half of the From address. You may put any name you like. 

This name appears as the Sender with the corresponding email address (e.g., Webmaster 

(webmaster@example.com). 

 Accept or modify the Subject line of the email. 

 At this point you can either manually alter the body of the email or apply an email template. If 

you wish to apply an email template, click the Email Templates button and choose the desired 

template.  

 [Optional] Use the options on the toolbar to customize your message, if desired. You may add an 

attachment , send the email with High Importance  or format the email in 

HTML .  
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 [Optional] Click the Local Machine button to choose which email server to use to send the emails 

(this is uncommon). The Local Machine settings can be added at both a program level and a web 

form level. If the two server settings differ, you can use this button to choose which server you 

wish to use. If the two do not differ, the server information entered is  be used is used by default. 

 [Optional] Add merge fields to the email by clicking 

the Merge Field button. Merge fields allow you to 

personalize the email by adding in keywords that 

are merged when the email is sent. For password-

protected forms, you can add Web Form URL, 

Username, Password and/or Name merge fields. 

Select an insertion point in the body of the email, 

click Merge Field and then choose the desired 

merge field. To use username merge fields, you 

must have marked the checkbox to include a 

username on the Login page properties screen. To 

include a name, you must have defined names in 

the Password builder list. Note that passwords are not encrypted when inserted as merge fields 

so that respondents can see their password. 

 When you have the email formatted as desired, click the Send  button to send the emails. 

They are sent according to the throttle rate defined in the web form properties. Respondents 

receive the email in the format that is set up in their email client. They can either click or copy the 

link to your web form that is included in the body of your email message. If you chose to embed 

the password into the URL, passwords are embedded as emails are generated and sent (behind 

the scenes). 

 Tip: Respondents with a text only email client may not see actual hyperlinks in 
their email messages. When sending a hyperlink through email, it is recommended 
that you include instructions that explain to respondents that they can copy the 
link and paste it into a web browser if the hyperlink does not automatically take 
them to the web form. 

 Tip: You can use the email client to send thank you notices to respondents as well. 
If you wish to send thank you notices from Remark Web Survey, you will need to 
alter the subject and body of the email message. When the email client is launched 
using the Send Invitations button, the email is formatted as an invitation to take 
your web form. The email text can be easily modified to thank respondents for 
submitting your web form. 
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Email Preview 
An email preview option is available so you can view the emails before they are sent. When using the 

preview option, you are able to scroll through the real emails, giving you a true representation of what 

you are sending. This feature is particularly useful if you are using Merge Fields and Query Parameters. We 

strongly suggest you use this email preview to ensure your emails look as intended. 

 

To use the email preview option 

 Format your email as desired using either the 

Advanced Email Wizard or regular invitation 

window.  

 When you have the email just as you want it, click 

the Preview button in the lower right corner of 

the window. 

 Use the arrow keys in the lower left corner to 

move forward and backward through the email 

messages. These are true representations of each 

email that will be sent based on your “To” list. 

 When you are finished previewing, click the Close 

button. The email invitation window is still open, 

where you can either make modifications or click the Send button to send your email messages. 

Email Templates  
You can create and save email templates to save time when you tend to send the same information or 

reuse web forms. Once you have an email formatted the way you want it, you can save it as a 

template file. Or you can do all of the formatting within the Email Templates window. Email templates 

save the information contained in the body and subject line of the email. 

 

To create an email template 

 From the Tools tab of the Ribbon, select Send 

Invitations. The Email Message window appears. 

(We suggest you put together a real email for a 

web form as you want it to appear, and then save a 

template for it.) 

 Format the body of the email as desired. 

 Click the Email Templates button. 

 Click the Save button.  

 Enter a name for the email template in the box 

titled Email template name. If you wish to 

overwrite an existing email template, start typing the name of the exiting template and Remark 
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Web Survey attempts to auto-populate this textbox for you based on templates you have 

previously saved. 

 [Optional] Make any adjustments to the body or subject of the email (if you did not do so in Step 

2). You may also add merge fields at this step by clicking the Merge Fields button. 

 Click the Save button to save the email template. 

 

To apply an email template to an email invitation 

 Open a web form and prepare it for emailing.  

 When you are ready to send email invitations, 

from the Tools tab of the Ribbon, select Send 

Invitations. The Email Message window 

appears. 

 Click the Email Templates button. 

 Choose a template from the list. 

 Format the rest of the email, including setting up 

the To list. 

 Click the Send button to send the invitations. 

Advanced Email Tools 
When sending emails there is an option to Show Advanced Email Tools on the toolbar: . 

When this feature is turned on, three tabs at the bottom of the email appear:  

 Designer: The Designer tab shows the original email as created in the Remark Web Survey email 

client. It allows you to modify the email using the default editor and rich text toolbar options.  

 Code Editor: The Code Editor tab shows you the HTML code, allowing you to modify it. This 

option gives you more control over the look of the email. You can insert hyperlinks and other 

HTML tags to customize the email. This option is intended for advanced users who understand 

the HTML language. 

o Note: Once you modify the HTML Code using the Code Editor, you may 
not return to the Designer tab to make other changes. If you modify the 
HTML Code and then return to the Designer tab, you lose the changes you 
made in the Code Editor view (you receive a warning when switching tabs). 

 HTML Preview: The HTML Preview tab shows you what the email looks like for the 
respondent. Use this tab in conjunction with the Code Editor to preview your 
changes.  

o Note: This tab is for design purposes only and does not insert real values 
you may have set up in the Advanced Email Wizard. To preview the real 
emails that will be sent use the Email Preview. 
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To use the Advanced Email Tools 

 Within the email client, click the toolbar button for Show Advanced Email Tools: . The Code 

Editor tab appears at the bottom of the window. 

 Click the Code Editor tab. Modify the HTML as desired. Note that there is a right click menu that 

gives you the options of cut, copy, paste, delete, bold, italic, underline and insert hyperlink. 

 Note: You may still use Merge Fields when 

editing the HTML code. Place your cursor where 

you want to insert the Merge Field and then click 

the Merge Field button on the toolbar.  

 Once you have the email designed, click the 

HTML Preview tab to review your email 

message. If you need to make changes you may 

move back and forth between the Code Editor 

and HTML Preview tabs freely. 

 Note: Do not click the Designer tab. 
Switching to the Designer view reverts 
any changes you made in the Code 
Editor. You receive a warning if you click 
the Designer tab. 

 [Optional]. If desired, save the modified email as a template by clicking the down arrow on Email 

Templates and then Save. 

 When you are ready to send your email, either click Send (sends emails immediately) or Preview 

(allows you to view the emails before they are sent). 
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Chapter 10: Collecting Data 

Overview 
Once a web form is created, published and installed, you are ready to start collecting data. The data 

collection script (rws5.pl) you specified when creating the web form (see Chapter 4) handles collecting 

the submissions for you. Data can be downloaded via Remark Web Survey or via a web browser. By using 

Remark Web Survey, you can analyze the data in Remark Quick Stats or export it to another analysis 

package.  

Remark Web Survey provides a Data Viewer window for the collection of data. The Data Viewer window 

contains a spreadsheet style grid containing the downloaded data. You can open previously downloaded 

data files or download a new data file in the Data Viewer window. 

Data is stored on the web server in a proprietary format called a .rwd (Remark Web Data) file. Once data is 

downloaded, it is moved to a .rwa (Remark Web Archive) file so that later you can have options of 

downloading all data (rwa) or only new records (.rwd). You may also download incomplete form 

submissions (respondents who started to fill out the web form but never completed it). 

Downloading Data in Remark Web 

Survey  
When downloading data from within Remark Web Survey, you may take advantage of the software’s data 

export and/or analysis features. Downloading data from within the software involves logging into your 

web server, downloading the data and loading it into the Data Viewer window. 

 Note: You must have a Remark Web Survey Control Panel login that allows for 
automatic data downloads. See Chapter 2 for more information about user 
accounts. 

Before you can download data into Remark Web Survey, you must have the Enable auto downloads 

feature set in the Remark Web Survey Control Panel. (By default, this feature is turned on.)  

 

To enable auto downloads 

 Log in to the Remark Web Survey Control Panel in a web 

browser (rwsad5.pl script) using an account with 

administrator privileges. 

 Mark the checkbox for Enable automatic downloads. 

 Click the Update button. 

In order to download data directly into Remark Web Survey you 

must enter the correct administration URL in the form’s properties 

and have a Remark Web Survey Control Panel login with automatic 

data downloading enabled (see Chapter 2 for information about 

user accounts). The data download function utilizes Internet 



  

190 

 

Explorer to authenticate your login on the web server. Therefore, you must have Internet Explorer 8 or 

later installed and configured correctly if you wish to download data from within Remark Web Survey. It 

does not need to be your default web browser, but you do need to be able to connect to the Internet via 

Internet Explorer. Your network administrator should be able to assist you with this process. 

 

To download data in Remark Web Survey  

 Open the web form in Remark Web 

Survey. 

 Open the Data Viewer by either clicking 

the Data Viewer button in the status 

bar or by selecting the Home tab from 

the Ribbon and then clicking Data 

Viewer. 

You see a spreadsheet style grid with columns 

containing the field names from each of the 

questions on your form. Each page of your web 

form is separated by a dashed line. 

 There are two ways to download data: 

 Expand the Admin Control Panel 

Access bar at the bottom of the window (if it is not expanded already) by selecting the View 

tab and marking the Admin Control Panel Access checkbox. In the Admin Control Panel 

Access bar, login with your Username and Password and then click the Download Data 

button. All of the data on the web server for this web form is downloaded. In addition, if you 

click the drop-down arrow on the Download Data button, you may choose New Data Only. 

The New Data Only option only downloads new submissions since the last time data was 

downloaded for this web form. Note that you are not able to access the Download Data 

button in the Admin Control Panel Access bar until you successfully log in to the 

administration script (Control Panel). 

 

 

 

 Select the Application Button  and then click Download. All of the data on the web 

server for this web form are downloaded. If you are not currently logged into the Remark 

Web Survey Control Panel, the Admin Control Panel Access bar automatically expands at 

the bottom of the window. Enter your Username and Password, and then click the Login 

button. After logging in, go back to the Application Button and then click Download. 

 Once the data downloads, a confirmation window appears. Click the OK button. 
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 Note: If using Database Link fields, these fields 
are processed when Remark Web Survey opens 
or downloads a data file directly from the web 
server. 

Remark Web Survey logs in to your web server and retrieves the 

data. Each line in the data grid is filled with one respondent’s 

submission. Each time you download data, you receive the entire 

file if downloading all records. 

At this point, you may save the data to another format or analyze the data in Remark Quick Stats. See 

Chapter 10 for further information about data export, and the Remark Quick Stats User’s Guide PDF file, 

located by clicking Start|Programs|Remark Web Survey 5|Documentation, for further information about 

using Remark Quick Stats. 

Appending Data or Downloading New Submissions 

Only 
If you have already collected data for a web form and saved it to file, you may optionally open that data 

and then download new data submissions. Whenever you have data open in the Data Viewer grid, the 

download process prompts you to add downloaded data to the existing data set. Follow the instructions 

in the previous section to download data. After the data 

is downloaded, you receive a message asking if you wish 

to append the data to the current data set. Click the Yes 

button to add the new data to the existing records in the 

active data grid. Click the No button to download the 

data to a new Data Viewer grid. 

Alternatively, you can click the down arrow on the 

Download Data button and choose New Data Only. This option only downloads records that have not 

been downloaded since the last time you downloaded. You can then save that data to its own file or 

append it to an existing file (click the Save As toolbar button on the Data Viewer, then choose Save As 

and select the existing file). 

 Note: If you append records to an existing data set when you download data, you 
still need to save that data set locally in order to finish combining the data (e.g., 
save it as a Remark (RMK) file). You can save the combined data from the toolbar in 
the Data Viewer. 

Downloading Incomplete Data Submissions 
Remark Web Survey allows you to download partial data submissions, which occur when someone starts 

to fill in a web form but never completes it. They may have filled in a page or two and then never 

completed it, or they may have paused the web form and never returned to finish it. By default, 

incomplete submissions are not downloaded with the regular data.  

If you plan to include incomplete data submissions use caution with the Remove respondent’s incomplete 

data from the server setting. This setting removes incomplete submissions after a specified amount of 

time (days or minutes). The scripts check for incomplete submissions to remove whenever interaction with 

the data (rws5.pl) script occurs. If you remove incomplete data submissions, you are ot able to download 
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incomplete data later. Please see Chapter 4 for a complete description of removing incomplete data 

submissions. 

In order to download data directly into Remark Web Survey you must enter the correct administration 

URL in the form’s properties and have a Remark Web Survey Control Panel login with automatic data 

downloading enabled (see Chapter 2 for information about user accounts). 

 

To download incomplete data submissions 

 Open the web form in Remark Web Survey.  

 Open the Data Viewer by either clicking 

the Data Viewer button in the status bar or 

by selecting the Home tab from the Ribbon 

and then clicking Data Viewer. 

 Expand the Admin Control Panel Access 

bar at the bottom of the window (if it is not 

expanded already) by selecting the View 

tab and marking the Admin Control Panel 

Access checkbox.  

 In the Admin Control Panel Access bar, 

login with your Username and Password 

and then click the down arrow on the 

Download Data button and choose Incomplete Data. Any incomplete data submissions are 

downloaded to the data grid. 

 Click the OK button to complete the process. 

You may now save this data to its own file or an existing data file. See Chapter 10 for information about 

saving data. 

 

Completion Percentage 

When viewing incomplete data submissions, you can utilize the Completion Percentage feature to 

determine how much data must be present in order to analyze the records. The Completion Percentage is 

a slider that you can move from 0 to 100%. Remark Web Survey then analyzes each record and 

determines the percentage of data present. If the record does not meet the specified percentage, it 

highlights it in yellow. You can then determine what you want to do with this data (e.g., delete it, include it 

in analysis, etc.). In addition you can specify whether to look at all questions on the web form or only 

those that are tabulated/graded in the question properties when analyzing the Completion Percentage. 

 

To use the Completion Percentage feature 

 Open the web form in Remark Web Survey. 

 Open the Data Viewer by either clicking the Data Viewer button in the status bar or by selecting 

the Home tab from the Ribbon and then clicking Data Viewer. 
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 Expand the Admin Control Panel Access bar at the bottom of the window (if it is not expanded 

already) by selecting the View tab and marking the Admin Control Panel Access checkbox. In 

the Admin Control Panel Access bar, log in with your Username and Password and then click 

the down arrow on the Download Data button and choose Incomplete Data. Any incomplete 

data submissions are downloaded to the data grid. Alternatively, if you have already completed 

this step and have the data saved on your computer, open that data file. 

 Locate the Completion Percentage in the toolbar 

of the Data Viewer. 

 First, determine whether you want to include all 

questions or only those that are set to 

grade/tabulate (this option is set on an individual 

question basis in the Analysis portion of the 

properties window). By default, only graded/ 

tabulated questions are included. To view or change 

this setting, locate the Refresh button. Click the 

down arrow on the Refresh button and then check 

or uncheck Filter Graded/Tabulated Questions 

Only. 

 Use the slider on the Completion Percentage 

scale to move to the desired percentage of 

complete data.  

 Click the Refresh button. The data is filtered 

based on whether it meets your completion 

percentage. Any data records not meeting the 

percentage are highlighted in yellow. 

 Determine whether you want to grade/tabulate 

the filtered records. Click the down arrow on the Refresh button and then click Filtered Rows. 

You have three options from which to choose: 

 Always Exclude From Export/Analysis: 

The data are not included if you save to a file 

or run any analysis options. 

 Always Include in Export/Analysis: 

The data are included if you save to a file or 

run any analysis options. 

 Always Ask: 

You are prompted whether to include the 

filtered data when you save data or run 

analysis options. 

 You may now either save the data to a file or run an analysis option. Please see Chapter 10 for 

information about saving data and Chapter 11 for information about analyzing data. 

 Note: If desired, you can delete the data rows that do not meet your completion 
percentage. This action deletes the data locally, not on the web server. To delete 



  

194 

 

the records, highlight the entire record(s), click the Home tab on the Ribbon and 
then click Delete Grid Row. 

Incomplete data submissions can also be downloaded from the Remark Web Survey Control Panel 

(rwsad5.pl script). Please see Chapter 10 for information about downloading data through the Control 

Panel. 

Downloading Data Through a Web 

Browser 
An alternative to downloading the data directly in Remark Web Survey is to use your web browser to 

access the Remark Web Survey Control Panel and view or download the data file to a location on your 

computer. The web browser interface also gives you the option of deleting data. The Control Panel is 

accessed through the rwsad5.pl script. 

Accessing the Control Panel from a web browser can be accomplished in one of two ways: 

 In Remark Web Survey, select the Web tab from the Ribbon and then click Control 
Panel. If a web form is open, the administration script specified in the web form’s 
properties appears in your default web browser. If a web form is not open, the 
administration script specified in the program options appears in your default web 
browser. 

 Open a web browser and enter the URL for your administration script in the 
Address bar (e.g., http://www.example.com/cgi-bin/rwsad5.pl). 

Please note that there are three types of user accounts and each one has different levels of access to the 

Control Panel. Administrator accounts can download and view data from the Control Panel, but Standard 

and Restricted User accounts need explicit permissions set up in order to download data from the Control 

Panel. See Chapter 2 for detailed information about user accounts. 

 

To download the data through a web browser 

 Access the Remark Web Survey Control Panel in a web browser (rwsad5.pl script) with an 

account that has permission to download data.  

 Enter your username and password and then click the Login button. 

 Note: The default user is Administrator. The person who installed the scripts onto 
the web server may or may not have set up individual user accounts. You may need 
to ask this person for your login 
information. 

 Click the Data & Stats tab. 

 Select a web form from the Form drop-down 

list. 

 Click the button for Download Data. 

 In the File Download window, click the button 

to Save the file. This prompt may vary slightly 

from web browser to web browser.  
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 In the Save window, select a location for the file and then click the Save button. Do not change 

the file extension on the file (.rwd). Make note of 

where you are saving the file so that you can retrieve 

it later. 

The data file is now downloaded. You can open the 

downloaded file within Remark Web Survey. 

 In the Remark Web Survey designer, open the 

desired web form. 

 Open the Data Viewer window by clicking its button 

in the status bar  or by selecting the Home tab 

from the Ribbon and then clicking Data Viewer. 

 Locate the toolbar on the Data Viewer. 

 Click the Open button. (You may also click the Application Button  and choose Open to open 

a data file as long as the Data Viewer is active.) 

 Locate the .rwd file you downloaded from the Remark Web Survey Control Panel and then click 

the Open button. The data are loaded into the data grid. 

 Note: If using Database Link fields, these fields are processed when Remark Web 
Survey opens or downloads a .rwd data file. 

Downloading Incomplete Submissions via the Control 

Panel 
Remark Web Survey allows you to download partial data submissions, which occur when someone starts 

to fill in a web form but never completes it. They may have filled in a page or two and then never 

completed it, or they may have paused the web form and never returned to finish it. By default, 

incomplete submissions are not downloaded with the data.  

If you plan to include incomplete data submissions, use caution with the Remove respondent’s incomplete 

data from the server setting. This setting removes incomplete submissions after a specified amount of 

time (days or minutes). The scripts check for incomplete submissions to remove whenever interaction with 

the data (rws5.pl) script occurs. If you remove incomplete data submissions, you are not able to download 

incomplete data later. Please see Chapter 4 for a complete description of removing incomplete data 

submissions. 

Please note that there are three types of user accounts and each one has different levels of access to the 

Control Panel. Administrator accounts can download and view data from the Control Panel, but Standard 

and Restricted User accounts need explicit permissions set up in order to download data from the Control 

Panel. See Chapter 2 for detailed information about user accounts. 

 

To download incomplete data submissions via the Control Panel 

 Access the Remark Web Survey Control Panel in a web browser (rwsad5.pl script) with an 

account that has permission to download data.  
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 Enter your username and password and then click the Login button. 

 Note: The default user is Administrator. The person who installed the scripts onto 
the web server may or may not have set up individual user accounts. You may need 
to ask this person for your login information. 

 Click the Data & Stats tab. 

 Select a web form from the Form drop-down 

list. 

 Click the button for Incomplete Data. 

 In the File Download window, click the button 

to Save the file. This prompt may vary slightly 

from web browser to web browser.  

 In the Save window, select a location for the file 

and then click the Save button. Do not change 

the file extension on the file (.rwd). Make note 

of where you are saving the file so that you can 

retrieve it later. 

The data file is now downloaded. You can open the 

downloaded file within Remark Web Survey. 

 In the Remark Web Survey designer, open the desired 

web form. 

 Open the Data Viewer window by clicking its button 

in the status bar  or by selecting the Home tab 

from the Ribbon and then clicking Data Viewer. 

 Locate the toolbar on the Data Viewer:  

 .  

 Click the Open button. (You may also click the Application Button  and choose Open to open 

a data file as long as the Data Viewer is active.) 

 Locate the .rwd file you downloaded from the Remark Web Survey Control Panel and then click 

the Open button. The data are loaded into the data grid. 

When viewing incomplete data submissions, you can customize the desired completion percentage 

required to consider the data valid. Please see Chapter 10 for information about using the Completion 

Percentage feature. 
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Viewing Data Online 
At any point while a web form is installed and submissions have been submitted, you may also view the 

data online without downloading it. Viewing the data is accomplished in the Remark Web Survey Control 

Panel. 

Please note that there are three types of user accounts and each one has different levels of access to the 

Control Panel. All accounts can view data from the Control Panel, but Restricted User accounts only have 

access to specific web form data. See Chapter 2 for detailed information about user accounts. 

 

To view data from a web browser 

 Access the Remark Web Survey Control Panel in a web browser (rwsad5.pl script).  

 Enter your username and password and then click the Login button. 

 Note: The default user is Administrator. The person who installed the scripts onto 
the web server may or may not have set up individual user accounts. You may need 
to ask this person for your login information. 

 Click Data & Stats tab. 

 Select a web form from the Form drop-down list. 

 Click the button for View Data. The data appears 

on-screen. The field names are listed across the 

top and bottom of the window, and each line in 

between represents one respondent’s submitted 

data. 

 Note: If a question is set to Treat each 
answer choice as a separate question, 
the data appear as one question in this 
view. When downloaded, the data are 
output to separate data cells. 

 [Optional] Click the View More Details button to view the data in greater detail, including 

viewing the submitter’s IP address (if applicable), data submitted and time submitted.  

 When finished reviewing the data, click the Control Panel button to return to the previous screen. 

Resetting Data 
You may reset a web form’s data at any time using the Remark Web Survey Control Panel. Resetting data 

may be useful if you publish a web form and then test it internally. Once you have completed your tests, 

you can reset the data file prior to sending out invitations to your web form. 

Please note that there are three types of user accounts and each one has different levels of access to the 

Control Panel. Only administrator accounts are able to reset data through the Control Panel. See Chapter 

for detailed information about user accounts. 

 Note: Data can also be reset when publishing forms to the web server. If a web 
form already exists on the web server, a prompt appears asking if you wish to 
remove data, log and temporary session files. If you remove the data via this 
prompt, a backup copy is created.  
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To reset data from a web browser 

 Access the Remark Web Survey Control Panel in a web browser (rwsad5.pl script) using an 

account with administrator privileges.  

 Enter your username and password and then click the Login button. 

 Note: The default user is Administrator. The person who installed the scripts onto 
the web server may or may not have set up individual user accounts. You may need 
to ask this person for your login information. 

 Click Data & Stats tab. 

 Select a web form from the Form drop-down list. 

 Click the button for Reset Data. You see a 

prompt asking if you are sure you want to reset 

the data. Click OK to continue or Cancel to 

return to the Control Panel. 

 Note: Resetting data via the Control 
Panel cannot be undone! Once you reset 
the data, the data file is removed from 
the web server. 

Log Files 
In addition to data files, you can also view or download the associated log files for each web form. The log 

file tracks information about each form submission, including:  

 

Option Description 

Entry Number Displays a sequential number assigned to each log file record. 

UID Displays a unique identifier that is assigned to each respondent and is used to 

track the entry. Each respondent has a session that is tracked by this UID. The 

UID helps track whether a particular respondent has completed the web form, 

how much time he/she has to go back and complete the web form, etc. 

Action Describes the action that took place (e.g., the web form was completed, a 

password was entered, etc.). 

Access Describes whether access to the web form was permitted. 

Encrypted Password Displays the password used to access the web form, if applicable, in an 

encrypted format. 

IP Address Records the IP address of the person submitting the web form (if this option is 

enabled in the web form’s properties). 

Date Records the date of the web form submission. 

Time Records the time of the web form submission. 
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Please note that there are three types of user accounts and each one has different levels of access to the 

Control Panel. Only administrator accounts are able to view or download log files through the Control 

Panel. See Chapter 2 for detailed information about user accounts. 

 

To view or download log files from a web browser 

 Access the Remark Web Survey Control Panel in a web browser (rwsad5.pl script) using an 

account with administrator privileges.  

 Enter your username and password and then click the Login button.  

 Note: The default user is Administrator. The person who installed the scripts onto 
the web server may or may not have set up individual user accounts. You may need 
to ask this person for your login 
information. 

 Click Web Forms tab. 

 Select a web form from the Form drop-down 

list. 

 Click the button for View Log to view the log 

file on-screen. Or click the Download Log 

button to save the log file to disk as a text file. 

This file can be opened in a text editor, such as 

Notepad. Finally, you can remove the log file by 

clicking Reset Log. This deletes the log file and a new one is created when/if interaction with the 

web form occurs. 

Understanding the Data Viewer Grid 
The Remark Web Survey Data Viewer grid employs a spreadsheet style interface to display data. Each grid 

column corresponds to a question on the web form and every grid row corresponds to one submitted 

web form. The grid employs two cell types to store data: text and list. The cell type depends on the kind of 

question being used. Textbox/Text Area style questions use text (data entry) cells. Checkbox, Option 

Button and Drop-Down Box style questions use list cells. A cell changes between a textbox and list box 

depending on its question type. The Data Viewer grid is divided into sections based on the pages in the 

active web form. Each page is separated by a dashed line. 

The Data Viewer has its own toolbar for frequently used functions (continue reading this chapter for more 

detailed descriptions of the features):  
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Toolbar 

Button 

Option Description 

 

Save Saves the data. If saving for the first time, a save window appears. For 

subsequent saves, the existing file is overwritten automatically. 

 

Save As Saves the data by opening a save window. This window allows you to 

name the file, choose a location for the file and specify a file type. 

 Save All Data Saves all open data grids to a single file. All grids are closed upon 

saving and the combined file remains open. Make sure you have 

saved any individual files (if needed) prior to using Save All Data. 

 

Open Opens a data set. 

 

Print Prints the active data set. 

 

Sort 

Ascending 

Sorts the active data set in ascending order based on the column you 

have selected. 

 

Sort 

Descending 

Sorts the active data set in descending order based on the column 

you have selected. 

 Close All 

Data 

Closes all open data grids. 

 Completion 

Percentage 

Allows you to specify the percent complete desired when 

downloading incomplete data submissions. You can then choose 

filtering options based on the data records that are flagged as 

incomplete.  

 

To access the Data Viewer Grid 

 Open a web form in Remark Web Survey. 

 Open the Data Viewer by either clicking the Data Viewer button in the status bar,  or by 

selecting the Home tab from the Ribbon and then clicking Data Viewer, . 

 Note: You cannot make changes to a web form when the Data Viewer is open and 
has data in it. 

 

 

 



  

201 

 

Editing the Data Viewer Grid 
The Data Viewer grid behaves like a spreadsheet. You can cut, copy and paste selections to and from the 

grid. Additionally, you can change the contents of individual grid cells by clicking in a cell. The grid 

employs standard practices for data manipulation. All tools are available from the Home tab of the Ribbon 

or the toolbar on the Data Viewer. 

 Cut (Ctrl+X) 

 Copy (Ctrl+C) 

 Paste (Ctrl+V) 

 Delete (data or an entire row) 

 Insert 

 Sort 

 Find/Replace 

 Print 

 Automatic column widths: Resizes columns to fit the data 

 Selection: Select an individual cell by clicking in it, a row(s) by clicking its header 
(number), a column(s) by clicking its header (field name) or the entire grid by 
clicking the empty cell in the uppermost left corner of the grid. 

The Data Viewer grid allows in-cell editing by clicking within a particular cell. The grid employs two cell 

types to store data: text and list. The cell type depends on the kind of field being used. Each cell changes 

between a textbox and list box depending on its question type. Textbox/Text Area style questions are 

considered text cells. You do not have a drop-down list for these field types. All other types of questions 

are considered list fields and have a drop-down list from which you can choose correct responses based 

on the labels entered in the question’s properties.  

Respondent Detection 
Remark Web Survey has a respondent detection feature that works in conjunction with password 

protection. When you enter a list of valid passwords for a password protected web form, you can 

optionally designate a name field, username field and an email field. When you download the data for the 

web form, Remark Web Survey can search through the passwords that were submitted to see who has 

and has not filled out your web form. The full list of respondents can also be exported to a file. You can 

use this file to send email notifications to those who have not yet filled out the web form reminding them 

to do so (if you are not using Remark Web Survey’s built-in email client). 

 

To use respondent detection 

 Create a web form with a Login page (see Chapter 4 for detailed information about setting up 

Login pages). When setting up the login page, enter information into the Name, Username and/or 

Email Address columns for optimum use of this feature. 

 Publish the web form and collect responses. 

 Download or open the data file containing the responses. 
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 Select the Tools tab in the Ribbon and then click Respondent Detection, . 

 Note: If multiple data grids are open that correspond to the same web form, you 
receive a prompt to choose the data grids to include in the Respondent Detection 
process. 

 The Respondent Detection window appears. Use the View drop-down list at the bottom of the 

window to select which respondents to view: All, Detected or Missing. 

 The Detected column contains a green checkmark if a respondent has submitted the web form. 

The respondent’s name, username, password and 

email address (if these fields are being used in the 

Password list builder) are also listed. 

 The Detected column is blank if a respondent has not 

submitted the web form. The respondent’s name, 

username, password and email address (if these fields 

are being used in the Password list builder) are listed 

using a lighter (disabled) text color. You may 

optionally use Remark Web Survey’s email function to 

send emails to respondents (see step 8) or export 

a file of respondents (see step 9). 

 [OPTIONAL] Click the Email button to launch 

Remark Web Survey’s built-in email client and 

send an email message to the respondents listed 

in the grid. You should decide who you want to 

send the email to before launching the email 

client. Choose Detected, Missing or All in the 

Respondent Detection window. See next section 

for detailed information about using the email 

client. 

 [OPTIONAL] Alternatively, click the Export button 

to export the respondent list to the desired 

format. Continue with steps 10-13. 

 [OPTIONAL] Select a location in which to save the file in 

the Look in box.  

 [OPTIONAL] Enter a file name for the report in the File 

name box. 

 [OPTIONAL] Select a file format from the Save as type 

box format (available formats include those supported 

by Remark Web Survey when saving data.  

 [OPTIONAL] Click the OK button to save the file. 
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Sending Reminder Emails 
The built-in email client can be used in conjunction with Respondent Detection to send reminder emails 

to those who have not submitted your web form. When you send reminders, an email is automatically 

generated that contains the link to your web form. You then add the recipients to the message. You may 

modify the subject line and body of the email; however do not modify the link to your web form. If you 

change this link, respondents are unable to access your web form. 

 Note: You must have a functioning SMTP server set up outside of Remark Web 
Survey to send reminder emails. The server information must be set up either in 
the Remark Web Survey program options or the web form’s properties in order to 
utilize the server. See Chapter 2 for further information. 

The following set of instructions assumes that you understand the purpose of the Respondent Detection 

feature. 

 

To send email reminders 

 Select the Tools tab in the Ribbon and then click 

Respondent Detection, . 

 The Respondent Detection window appears. Use the 

View drop-down list at the bottom of the window to 

select the Missing list of respondents. 

 There are two email options available: Click the Email 

button to launch the Email Message window or click the 

down arrow on the Email button and choose Include 

Username/Passwords to embed the respondents’ 

username and password into the web form link that is sent in the reminder email. Embedding the 

username and password into the web form URL means respondents are automatically logged in 

when they click the URL (the password is encrypted in the URL). 

 Note: If you are using Query Parameters and want to send email reminders from 
Remark Web Survey, use the Advanced option on the Email button. Please see 
Chapter 5 for detailed information about using the Advanced options. Then return 
to this section for generic information about the email window. 

The Email Message window appears. 

 If you are using a password protected web form and have entered email addresses in the 

password list builder screen, the To section of the email is automatically filled with your missing 

respondents from the Password list builder window. However, you may also click the To button 

to see a list of respondents who have either submitted the web form (Detected Respondents) or 

not submitted your web form yet (Missing Respondents). You may use these lists to alter your 

To list. Use the Missing Respondents list to send reminder emails to those who have not 

submitted the web form.  

 [Optional] If desired, you may input more email addresses by either typing them in manually 

(separated by a semi-colon (;)) or by importing the passwords from an external database.   
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 The From address is filled with the web form administrator address that was entered in the web 

form’s properties. Accept the default or enter a new email address. 

 Accept or modify the Subject line of the email. 

 The Display name defaults to the first half of the From address. You may put any name you like. 

This name appears as the Sender with the corresponding email address (e.g., Webmaster 

(webmaster@example.com). 

 At this point you can either manually alter the body of the email or apply an email template. If 

you wish to apply an email template, click the Email Templates button and choose the desired 

template. Email templates are covered in detail in Chapter 9. 

 [Optional] Use the options on the toolbar to customize your message, if desired. You may add an 

attachment , send the email with High Importance  or format the email in 

HTML .  

 [Optional] If desired, click the Local Machine button to choose which email server to use to send 

the emails (this is not common). The Local Machine settings can be added at both a program level 

and a web form level. If the two server settings differ, you can use this button to choose which 

server you wish to use. If the two do not differ, the server information entered is be used by 

default. 

 [Optional] Add merge fields to the email by clicking the Merge Fields button. Merge fields allow 

you to personalize the email by adding in keywords that are merged when the email is sent. For 

password-protected forms, you can add Username, Password and/or Name merge fields. Select 

an insertion point in the body of the email, click Merge Fields and then choose the desired field. 

To use username merge fields, you must have marked the checkbox to include a username on the 

Login page properties screen. To include a name, you must have defined names in the Password 

builder list. Note that when merging passwords into the body of the email, the password is not 

encrypted so that the respondents can see their passwords. 

 When you have the email formatted as desired, click the Send  button to send the emails. 

They are sent according to the throttle rate defined in the web form properties. Respondents 

receive the email in the format that is set up in their email client. They can either click or copy the 

link to your web form that is included in the body of your email message. If you chose to embed 

the password into the URL, encrypted passwords are embedded as emails are generated and sent 

(behind the scenes). 

 Tip: Respondents with a text only email client may not see actual hyperlinks in 
their email messages. When sending a hyperlink through email, it is recommended 
that you include instructions that explain to respondents that they can copy the 
link and paste it into a web browser if the hyperlink does not automatically take 
them to the web form. 
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Saving Grid Data 
Once data are downloaded, you can save the data in the grid to dozens of different file formats.  

 Note: When working with data in Remark Web Survey, we recommend that you 
use the Remark file format (RMK). Save data to other formats when exporting for 
analysis. 

When saving data, you have the option of using Save Data or Save Data As. The Save Data option can be 

used to save a data set for the first time or to overwrite the current data set. The Save Data As option 

allows you to save the current data set with new parameters (e.g., new file name, different directory, 

different file type, etc.). The Data Viewer grid has its own toolbar that contains options for both Save and 

Save As. 

The following table lists the different save file formats, their extensions and a brief description: 

 

File Format Extension Description 

Remark RMK Remark proprietary format 

SQL Server 2000-2005 MDF Microsoft SQL Server format 

Oracle 7.4 and later *.* Oracle format 

Access 2007-2013 ACCDB Microsoft Access 2007 - 2013 format (only available if the 

Access 2007, 2010 or 2013 database engine is installed) 

Access  MDB Microsoft Access 2000-2003 format 

Access 95-97 MDB Microsoft Access 95-97 format  

Access 2.0 MDB Microsoft Access 2.0 format 

Access 1.0 MDB Microsoft Access 1.0 format  

Excel 2013 XLSX Microsoft Excel 2013 format   

Excel 2010 XLSX Microsoft Excel 2010 format   

Excel 2007 XLSX Microsoft Excel 2007 format   

Excel 97-2003 XLS Microsoft Excel 97-2003 format 

Excel 95 XLS Microsoft Excel 95 format  

Excel 4.0 XLS Microsoft Excel 4.0 format 

Excel 3.0 XLS Microsoft Excel 3.0 format  

Questionmark QSF Perception Questionmark format (save only) 

SPSS SAV SPSS format 

SPSS (Legacy) SAV SPSS legacy format 
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File Format Extension Description 

Survey Pro SRV Survey Pro standard format (Apian Software) 

Survey Pro STL STL Survey Pro STL format (Apian Software) 

CSV CSV Comma separated values 

ASCII [tabs] ASC Tab delimited ASCII 

Spreadsheet [commas] TXT Comma delimited ASCII with quotes around non-numeric 

data 

Spreadsheet [tabs] TXT Tab delimited ASCII with quotes around non-numeric data 

Survey System DAT The Survey System format (Creative Research Systems) 

dBase 5.0 DBF dBase 5.0 format 

dBase IV DBF dBase IV format 

dBase III DBF dBase III format 

Paradox 5.X DB Paradox 5.X format; existing files may only be overwritten 

(there are no append options) 

Paradox 4.X DB Paradox 4.X format; existing files may only be overwritten 

(there are no append options) 

Paradox 3.X DB Paradox 3.X format; existing files may only be overwritten 

(there are no append options) 

Lotus WK3 WK3 Lotus Works 3 format; existing files may only be 

overwritten (there are no append options) 

Lotus WK1 WK1 Lotus Works 1 format 

Lotus WJ3 WJ3 Lotus WJ3 format (Japanese) 

Lotus WJ2 WJ2 Lotus WJ2 format (Japanese) 

Lotus 1-2-3 WKS Lotus 1-2-3 format 

LXR Test MRG LXR Test format 

Report RPT Fixed format ASCII, cell text padded or truncated to 

specified record length 

Data Interchange Format DIF Standard format using file header and data section 

XML XML Extensible Markup Language format 

HTML HTM Hypertext Markup Language  

ODBC *.* Open Database Connectivity  

Custom  ASC, TXT Custom Text format 
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File Format Extension Description 

Database Update XLS, XLSX, 

MDB, 

ACCDB 

Updates an existing database with new data (e.g., adds 

missing information, overwrites existing information). 

ODBC Database Update *.* Updates an existing ODBC database with new data (e.g., 

adds missing information, overwrites existing information). 

 

To save grid data 

 Locate the toolbar on the Data Viewer: 

. 

 There are three options when saving data: 

 Click the Save Data button if saving the data set for the first time or to 
overwrite the data. 

 Click the Save Data As button to save the data with new parameters. 

 Click the Save All Data  button to save all open data grids corresponding to 
the active web form to a single data file. This feature is useful if you have saved 
data files individually and now want to combine them into one overall (complete) 
data file. 

 Note: When using the Save All Data files, the individual data grids are closed and 
only the combined data file is visible in the Data Viewer. If you made changes to 
your individual data files and 
want them to be saved, save the 
individual files first. Then use 
the Save All Data option. (Note: 
A warning regarding this 
information appears when you 
click Save All Data.) 

If saving for the first time or using Save Data As or Save All Data, the Save Data window opens, allowing 

you to choose a file name, a file type, the directory in which you would like the file saved and Advanced 

saving options, if applicable. 

 Select the desired directory location using the 

Look in drop down box. 

 Enter a name in the box titled File name. 

 Select the desired output format in the box titled 

Save as type. 

 If saving to a database type that supports internal 

table names, enter a table name in the box titled 

Table name. 

 Note: Each database format has different 
table name limitations. Refer to your 
database documentation for information 
on table name limitations. 
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 When exporting, you can save the column headers for certain formats by selecting the Save 

headers checkbox. The Save headers checkbox only displays when appropriate. The SPSS file 

format also allows you to save decimal places. Enter a value in the Decimal places box (you may 

save up to 4 decimal places). 

Advanced Saving Options 
When saving data to database formats, you have the option of setting advanced parameters. The 

advanced window shows you each question and pertinent information about its field type. You can then 

choose options about the question that you want included in your database. This feature can be useful if 

you are saving to a database format that has specific requirements. You can temporarily override the .rwsx 

form settings by using the advanced parameters. 

 Note: Setting parameters in the advanced saving window does not make any 
changes to the web survey file (.rwsx). 

The following advanced features are available (depending upon the selected format): 

 

Option Description 

Include Mark the Include checkbox to include the question in the database. 

Name Use the Name column to enter a new field name to be used in the exported 

database, if desired. Changing the field name in this window does not affect the field 

name in the web form file. 

Data Type Use the Data Type column to change the data type for this question. 

Size Use the Size column to specify a field size for the data for this question. Do not 

specify a size that is smaller than what is in your data. 

 

To use advanced saving options 

 Locate the toolbar on the Data Viewer: 

. 

 Click the Save Data button if saving the data set for the first time, click the Save Data As 

button to save the data with new parameters or click the Save All Data button to save 

all open data grids corresponding to the active web form to one file. 

If saving for the first time, using Save Data As or using Save All Data, the Save Data window opens, 

allowing you to choose a file name, a file type, the directory in which you would like the file saved and 

Advanced saving options. 

 Select the desired directory location using the Look in drop down box. 

 Enter a name in the box titled File name. 

 Select the desired database format in the box titled Save as type. 
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 If saving to a database type that supports internal table names, enter a table name in the box 

titled Table name. 

 Note: Each database format has different table name limitations. Refer to your 
database documentation for information on table name limitations. 

 Click the Advanced button. 

 [OPTIONAL] If you have previously saved a definition file 

for this data set, click the Load button to locate the 

appropriate INI file containing your settings. Otherwise, 

continue to Step 9 to build a new data file. 

 Make any desired changes in the Include, Name, Data 

Type or Size columns, as described previously. 

 [OPTIONAL] If desired, click the Save button to save the 

settings to a configuration file (.ini file). You can then 

open this configuration file for future save operations 

with this same web form. This feature can save time when 

saving future data sets. 

 Click the OK button to save the changes. 

 In the Save Data window, click the OK button to save the data. 

Custom Format 
The Custom format allows you to create a customized text file. This format is useful for exporting data 

into a database or other program that has very specific requirements. The format can also be used to 

break apart rows of data into multiple records. For example, if you are processing an attendance sheet 

containing records for multiple students in a single row, you can use the Custom format to separate the 

data into one record for each student. 

 

To use the Custom format 

1. Locate the toolbar on the Data Viewer: 

. 

2. Click the Save Data button if saving the data set for the first time, click the Save Data As 

button to save the data with new parameters or click the Save All Data button to save 

all open data grids corresponding to the active web form to one file. 

3. Select the desired folder location using the Look in drop down box. 

4. Enter a name in the box titled File name. 

5. Select the Custom (*.ASC, *.TXT) format in the box titled Save as type. 

6. Click the OK button. 
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7. If you have used the Custom format previously and have a saved configuration file that applies to 

this data set, click the ellipsis (...) button to locate the configuration file. Otherwise, continue to 

the next step 

8. Select the options you wish to use to customize your data set. Each option is described here: 

  

Option Description 

Start export at row Enter the row number that you want to use as the first record in the exported data 

file. All rows from this point forward are included in the data file. Enter 0 to include 

region (field) names as the first record. 

File Type Delimited: Fields are separated by a delimiter, such as a comma or tab. 

Fixed-Width: Fields are aligned at fixed character spaces. 

Record Delimiter Sets the delimiter to be used to separate records: Carriage Return/Line Feed, 

Carriage Return, Line Feed or any other string. 

Column Delimiter Select the character to use to separate the columns in the data file: Comma, Tab, 

Semi-colon, Space or any other string. 

Text Qualifier Select the character to use to qualify text. Textual responses are encapsulated within 

these characters. Options include: None, double quote ("), single quote ('). 

Multiple Response 

Qualifier 

Select the character to use qualify multiple responses. Reponses are encapsulated 

within these characters. Options include: Parenthesis (( )), Curly Braces ({ }), Square 

Braces ([ ]), Angle Brackets (< >) or any other single character. 

Multiple Response 

Delimiter 

Select the character to use to separate multiple responses. Options include Comma 

(,), Hyphen (“), Colon (:), Semi-colon (;), Space or any other single character. 

Fixed Width Files Only: 

Automatically 

format questions 

that allow multiple 

responses 

Mark the Automatically format questions that allow multiple responses checkbox to 

automatically set formatting for questions that allow more than one answer choice 

(e.g., (1,2,3) becomes 123). Note that Remark looks at the longest answer choice and 

any answer choices that are shorter have padding added to them to make them the 

same length. For example, if the answers are 5, 10 and 3, it would look like 5 103. 

One space of padding is added after the 5 because 10 is the longest answer choice 

with two characters. This setting only applies to Fixed Width files. 

Field Size The maximum number of characters allowed in the field. 

Start Position The position, in characters, where the field begins. For example, if your field sizes are 

25, the first field starts at position 1 and the second field starts at position 26 (25 

characters later). This field is for reference only and cannot be changed. 

Pad Character Enter the character to use to pad the field (typically a space character). 
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Option Description 

Pad On Select whether to pad the field on the left or right of the text that resides in the field. 

 

8. Click the Next button to go to the next step. 

9. Use this step if you need to break your data apart into multiple records. This option is useful for 

things like attendance forms, session evaluations and any other forms that evaluate more than 

one person on a single form. If you do not need to break apart data, simply click the Finish 

button (step 14). 

10. Choose how many records you want in your data set. For example, if you are processing an 

attendance sheet and there are 20 students per form (row of data), you would enter 20. Click the 

Update button. The number of desired records are created on the right side of the window. 

11. You have three options for formatting the file: 

 Add to Every Record: Choose this option to add a question (or questions) to every record in the 

data set. In our attendance example, this might be a class name or teacher name (something that 

is static for everyone). 

 Add to Selected Records: Use this option to add questions to only the records you have selected 

on the right side of the window. This option lets you fine tune what goes into each record. 

 Split Among Records: Use this option to select questions and then have them equally split 

across all records. In our attendance example, this would be the questions that are used to track 

attendance (e.g., days of the week). For example, suppose you have students listed down the left 

side of the form and options for Monday-Friday for each student. If a student is in attendance, the 

corresponding bubble is filled. If the student is absent, the bubble is left blank (this is a Boolean 

region). You can split the students among all the records. Then split each day among all the 

records. See screen shot at right. If your data was not split, you might have something like this: 

 

Notice how the students and attendance are listed in one long row. 

However, if you split your data, you have this: 

 

 

 

 

 

 

 



  

212 

 

Notice how each student is now occupying one record of data, along with his/her attendance. 

12. Using the above descriptions, parse your data as needed.  

13. Use the Preview button to preview how your data will look once exported. 

14. When finished, click the Finish button. 

15. When the Save Configuration window appears, click the Yes button to save your settings to a 

file that you can use later when saving data. If you do not wish to save this configuration file, click 

the No button. If you are not saving the configuration file for later use, the data file is saved when 

you click the No button. Continue with the next steps if you are saving the configuration file. 

Otherwise you are finished saving your data. 

 [Optional] If saving the configuration file, in the Save Text Export Configuration As box, 

select a location in which to save the configuration file in the Save in box. 

 Enter a name for the file in the File name box. 

 Leave the Save as type box set to Text Export Configuration Files (*.tec). 

 Click the Save button to save the TEC file and create the data file. 

  

The data is saved according to your specifications and you can reuse the TEC file in the future. The 

resulting text file can be taken to the application of your choice. 

Database Update Format 
The database update format allows you to update an existing database based on the data in the Remark 

Web Survey data grid (Access or Excel). The data are matched to the existing database by the field names 

and a mapping process. When saving to this format, you map the fields in the Remark Web Survey data to 

the fields in the existing database. You also choose a question to be the record identifier. If data exists in 

the database it is updated with what is in Remark Web Survey. For example, if you were conducting a 

course evaluation and asked for the students’ ID number in the web survey, you could use the student ID 

as the record ID to update an external database using the Database Update format. During the save 

process, Remark Web Survey attempts to find the Student ID in the database and then updates the data 

fields associated with that student. If the student ID is not found, you have the option of adding the 

record to the external database. 

To use the Database Update format 

 Locate the toolbar on the Data Viewer: 

. 

 Click the Save Data button if saving the data set for the first time, click the Save Data As 

button to save the data with new parameters or the Save All Data button to save all 

open data grids corresponding to the active template to a single data file. 

If saving for the first time or using Save Data As, the Save Data window opens, allowing you to choose a 

file name, a file type, the directory in which you would like the file saved and Advanced saving options if 

applicable. 
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 Select the desired directory location using the Look in drop down box. 

 Select a file to update, which fills the File name box. 

 Select the Database Update (*.ACCDB, *.MDB, *. XLSX, *.XLS) format in the box titled Save as type. 

 Click the OK button. A wizard opens to walk you through the next few steps. 

 If you have used the Database Update format previously and have a saved configuration file that 

applies to this data set, click the Load… button to locate the configuration file. Otherwise, go on 

to step 8. 

 Note: You are prompted to save a configuration file with your settings after saving 
the data. 

 In the Update Options area, select the number of records contained in each row of the data set 

(e.g., if multiple respondents’ answers are on a single form, you would have more than one record 

per data row). If each record in the data set corresponds to one respondent’s submission, use 1 

for the value. 

 In the Update Options area, mark the Add database records for missing record identifiers 

checkbox if you would like to create new records in the 

database when an identifier is not found. 

 In the Field Mapping area, map the fields from Remark 

Web Survey to the fields in the external database. The 

database fields are listed in the first column and the 

Remark Web Survey fields (questions) are listed in the 

second column, called Grid Column. Use the down arrow 

in the Grid Column section to choose the appropriate 

field to map to the corresponding database field. 

 Choose a field or fields to use as an identifier by marking 

the appropriate checkbox next to the field name. The 

identifier fields are used to match data from Remark Web 

Survey to the external database. If a match is not found, 

the data is not added to the database and you receive a message. You may select more than one 

field to use as the identifier, in which case the data from all identifier fields must be a match for 

the record to be updated in the external database. 

 Click the OK button to save the data.  

 Note: The ODBC Database Update format works just as described above, but you 
can save to a database using an ODBC connection. 
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Opening Data 
Remark Web Survey can open data saved in dozens of different file formats. The following table lists the 

different file formats Remark Web Survey can open, their extensions and a brief description: 

 

File Format Extension Description 

Remark RMK Remark proprietary format 

Web Survey RWD Remark Web Survey proprietary format (the data that 

resides on the web server) 

SQL Server 2000-2005 MDF Microsoft SQL Server format 

Oracle 7.4 & later *.* Oracle format 

Access 2007-2013 ACCDB Microsoft Access 2007-2013 format (only available if the 

Access 2007 or greater database engine is installed) 

Access  MDB Microsoft Access 2000-2003 format 

Access 95-97 MDB Microsoft Access 95-97 format  

Access 2.0 MDB Microsoft Access 2.0 format 

Access 1.0 MDB Microsoft Access 1.0 format  

Excel 2013 XLSX Microsoft Excel 2013 format  

Excel 2010 XLSX Microsoft Excel 2010 format  

Excel 2007 XLSX Microsoft Excel 2007 format  

Excel 97-2003 XLS Microsoft Excel 97-2003 format 

Excel 95 XLS Microsoft Excel 95 format  

Excel 4.0 XLS Microsoft Excel 4.0 format 

Excel 3.0 XLS Microsoft Excel 3.0 format  

SPSS SAV SPSS format 

SPSS legacy SAV SPSS legacy format 

Survey Pro SRV Survey Pro standard format (Apian Software) 

CSV CSV Comma separated values 

ASCII [tabs] ASC Tab delimited ASCII 

Spreadsheet [commas] TXT Comma delimited ASCII with quotes around non-numeric 

data 

Spreadsheet [tabs] TXT Tab delimited ASCII with quotes around non-numeric data 
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File Format Extension Description 

dBase 5.0 DBF dBase 5.0 format 

dBase IV DBF dBase IV format 

dBase III DBF dBase III format 

Paradox 5.X DB Paradox 5.X format  

Paradox 4.X DB Paradox 4.X format 

Paradox 3.X DB Paradox 3.X format 

Lotus WK4 WK4 Lotus Works 4 format (open only) 

Lotus WK3 WK3 Lotus Works 3 format 

Lotus WK1 WK1 Lotus Works 1 format 

Lotus WJ3 WJ3 Lotus WJ3 format (Japanese) 

Lotus WJ2 WJ2 Lotus WJ2 format (Japanese) 

Lotus 1-2-3 WKS Lotus 1-2-3 format 

LXR Test MRG LXR Test format 

Report RPT Fixed format ASCII, cell text padded or truncated to 

specified record length 

Data Interchange Format DIF Standard format using file header and data section 

XML XML Extensible Markup Language format 

HTML HTM Hypertext Markup Language  

ODBC *.* Open Database Connectivity  

Cuom  ASC, TXT Custom Text format 

 

To open grid data 

 Open a Remark Web Survey web form. 

 Open the Data Viewer by either clicking the Data Viewer button in the status bar  or by 

selecting the Home tab in the Ribbon and then clicking Data Viewer. 

 Locate the toolbar in the Data Viewer: 

. 

 Click the Open Data button . 

 Note: When the Data Viewer is displayed, clicking the Application button and 
then selecting Open displays the Open Data window. 
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 Select the folder containing the data file from the 

Look in drop-down list. 

 Select a file from the list. 

 If opening a database type that supports internal 

table names, click a table name in the box titled 

Table name. 

 Caution: When opening a database file type, 
Remark Web Survey attempts to match grid 
column headers to the database's field 
names. If any column headers can't be 
matched, an error occurs. Grid column 
headers do not need to appear in the same 
order as the database fields. 

 Click the OK button to open the data file. 

 Note: The data contained in the file must correspond to the current web form or 
an error may occur. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 11: Data Analysis 

Overview 
There are two types of data analysis tools within Remark Web Survey: Remark Quick Stats® and Remark 

Live Stats™. Remark Quick Stats is used when downloading data in Remark Web Survey and Remark Live 

Stats is used to view results on the web. 

Remark Quick Stats 
Remark Quick Stats is an analysis package that ships with the Remark Web Survey software. Remark Quick 

Stats allows you to tabulate surveys and grade tests right in the software. An overview of Remark Quick 

Stats is provided here; a complete user’s guide is installed in PDF format with the software and can be 

found by clicking Start|Programs|Remark Web Survey 5|Documentation|Remark Quick Stats User’s 

Guide.  

Depending on the report selected, Remark Quick Stats can include the following statistics: 

Survey Statistics include: 

 For each item Remark Quick Stats calculates: Mean, Variance, Standard Deviation, 
Standard Error, Min, Max, Range, Median, Skewness, Kurtosis, T-Value, Percentiles, 
Confidence Intervals  

 For each answer choice Remark Quick Stats calculates: Frequencies, Percentages, 
Valid Percent  

 A Response Report displays the responses for any particular question on one, easy 
to read, report (primarily used for open ended questions) 

 Crosstabs  

 A Group Report displaying means for question groupings  

Test Statistics include: 

 Advanced Grade steps you through the process of setting up an answer key, grade scale, 

questions points, learning objectives, benchmark scores and other grading information for your 

test  

 For each item Remark Quick Stats calculates: Mean, Variance, Standard Deviation, Standard Error, 

Min, Max, Range, Median, Skewness, Kurtosis, T-Value, Percentiles, Confidence Intervals, P-values, 

Point Biserial Correlation  

 For each answer choice Remark Quick Stats calculates: Frequencies, Percentages, Point Biserial  

 For each student Remark Quick Stats calculates: Total score, Raw score, Grade, Dev. IQ, Number 

correct, incorrect, unanswered  

 For the test Remark Quick Stats calculates: Number of graded tests and items, Max, Min, Median, 

Range, Percentile scores, Mean, Variance, Standard Deviation, Confidence Intervals (1,5,95,99%), 

KR 20, KR21, Coefficient (Cronbach) Alpha  

 A Grade Report displays each student’s results on the test  

 A Group Report displays grades for specific subsets of your data  
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A variety of graph types are also included (all of which can be copied and printed):  

 Pie   

 Bar   

 Horizontal Bar  

 Line  

 Area  

 Point  

 Polar  

 Fast Line  

Tabulating Surveys with Remark Quick Stats 
Surveys can be tabulated in two ways: Quick Survey and Advanced Survey. Quick Survey uses the 

parameters specified in the form’s question and answer properties, such as which questions to tabulate, 

and then launches Remark Quick Stats. Advanced Survey allows you to customize the tabulation process 

by choosing which questions to include, assigning numeric values to answer items, assigning benchmarks, 

adding question text, specifying question groups and more.  

 

To access survey tabulation features 

 Open a web form and then download data or open an existing data file. 

 Select the Tools tab in the Ribbon, and then click Quick Survey or Advanced Survey. 

Remark Quick Stats opens allowing you to configure and display reports. Please consult the Remark Quick 

Stats user’s guide PDF for further details about using Remark Quick Stats. 

 Tip: The survey screens and functions are described in complete detail in the 
Remark Quick Stats User’s Guide PDF file. Access the file by clicking 
Start|Programs|Remark Web Survey 5|Documentation.  

 

Grading Tests with Remark Quick Stats 
Tests can be graded in two ways: Quick Grade and Advanced Grade. Quick Grade uses the parameters 

specified in the web form, such as which questions to grade and their point values. In addition, Quick 

Grade uses the first row of data in the Data Viewer grid as the answer key; therefore, you should insert 

your answer key before your test data if you plan to use Quick Grade. Advanced Grade allows you to 

customize the grading process by choosing which questions to include, assigning point values, setting 

benchmarks, adding question text, specifying learning objectives and more.  

 

To access test grading features 

 Open a web form and then download data or open an existing data file. 

 Select the Tools tab from the Ribbon, and then click Quick Grade or Advanced Grade. 
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Remark Quick Stats opens allowing you to configure and display reports. Please consult the Remark Quick 

Stats user’s guide PDF for further details about using Remark Quick Stats. 

 Tip: The grading screens and functions are described in complete detail in the 
Remark Quick Stats User’s Guide PDF file. Access the file by clicking 
Start|Programs|Remark Web Survey 5|Documentation.  

Using Remark Live Stats 
The Remark Live Stats® feature is accessed via the Remark Web Survey Control Panel (rwsad5.pl script). It 

provides an item analysis, response report and duration report using any data collected for a particular 

web form. It is a great way to get a quick feel for the data for a live form without having to download the 

entire data set. User accounts can be set up to only access the Remark Live Stats information. 

 

To use Remark Live Stats 

 Access the Remark Web Survey Control Panel in a web browser (rwsad5.pl script).  

 Enter your username and password and then click the Login button. 

 Note: The default user is Administrator. The person who installed the scripts onto 
the web server may or may not have set up individual user accounts. You may need 
to ask this person for your login 
information. 

 Click the Data & Stats tab. 

 Select a web form from the Form drop-down list. 

 Click the button for Live Stats. The Item 

Analysis report appears by default. However, you 

may choose a Response Report or a Duration 

Report: 

 Item Analysis Report: The Item Analysis report 

displays each option button, checkbox or 

drop-down box question on the web form and then calculates the number of detected and 

missing responses, along with the responses chosen and their corresponding percents. A bar 

chart of the frequency also displays. If a response has not yet been chosen, it does not display 

on the report. 

 Response Report: The Response Report displays information from all textbox/text area 

questions on the web forms. These are typically open-ended questions. 
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 Duration Report: The Duration Report shows 

the number of responses that fall into a 

specific time (duration) interval (e.g., how 

many responses took 0-30 minutes to 

complete the web form). Select an interval, in 

minutes, in the Interval box. The total 

number of detected responses displays along 

with the average time per response for the 

form. A breakdown of each interval based 

upon the interval length defined and the 

number of those responses that fell into that 

interval is displayed, along with a bar chart of 

the frequency (based on the number that fell 

into the selected interval compared to the 

number of responses). 

 To run a report, choose the option 

button of the desired report and then 

click the Generate Report button. 

 If desired, print the report by clicking 

the Print Version button at the 

bottom of the window. A printer 

friendly report appears. Use the 

browser’s Print button to print the 

report. After printing, click the OK 

button to return to the Remark Live 

Stats page. 

 Note: This page is best printed when the option within your web browser is set to 
"Print background colors and images." The setting name may vary depending on 
your web browser. 

 When finished viewing the report, click the Control Panel button to return to the previous screen. 

Configuring Remark Live Stats Only Accounts 
Remark Web Survey 5 allows you to set up three different Server component account types: 

 Administrator: This account has full control over the Server component (can change settings, 

publish forms, download data, view logs, view statistics, edit users, etc.). The default account is the 

Administrator account and there can only be one account named Administrator. You may, 

however, create different user accounts with administrator privileges.  

 Standard User: This account only allows the user to view Remark Live Stats and web form data 

when they login to the Remark Web Survey Control Panel (rwsad5.pl script). In addition you can 

choose whether to allow automatic form publishing and data downloading from the Designer 

component for this account. If automatic form publishing and data downloading are enabled, 

they can use these features for any web form within the Designer component. In addition, if 

automatic data downloading is enabled, the user is able to download data from the Control Panel. 
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 Restricted User: This account only allows the user to view Remark Live Stats information and web 

form data for specific forms when they login to the Remark Web Survey Control Panel (rwsad5.pl 

script). In addition you can choose whether to allow automatic form publishing and data 

downloading from the Designer component for the specified forms for this account. If automatic 

form publishing is enabled, the user can publish any web form from the Designer component. If 

automatic data downloading is enabled, the user can only download data from the Designer 

component for the forms specified in their user account. The user can also download data from 

the Control Panel for the specified forms. Note that after a new web form is published, an 

administrator needs to add that web form to the list of available web forms for the restricted user. 

Standard and Restricted User accounts only have access to data and Remark Live Stats; they do not see 

the other options available in the Remark Web Survey Control Panel. 

 

To set up a Remark Live Stats user 

 Log in to the Remark Web Survey Control Panel (rwsad5.pl) using an account with administrator 

privileges through a web browser. 

 Select the Users tab. 

 Click the Add User button. 

 Enter the desired Username and Password for the 

new user. Determine the level of permissions you want 

to grant to the user (see description above): Standard 

User or Restricted User. 

 If setting up a Standard or Restricted User, choose 

the web forms to which the user has access. 

 Once you choose a permission level, determine 

whether you want the user to be able to automatically 

publish web forms and download data from the 

Designer component. Mark the Enable automatic 

publishing from the Designer component and/or 

Enable automatic data downloading from the Designer component checkboxes to grant 

these permissions. If users do not have these permissions, they have to rely on another user to 

publish web forms and download data. 

 Note: Restricted Users can publish any web form, but can only download data for 
those forms that are specified. 

 Click the OK button to add the new user. 

When the new user logs in, s/he has access to the Remark Live Stats area and data for all forms if the user 

is a Standard user or for only the specific forms allowed if the user is a Restricted user. 
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Chapter 12: Remark Web 

Survey Program Options 
You can customize Remark Web Survey so that the software runs in the most efficient manner appropriate 

to your tasks. Use the Program Options to customize default program settings. By choosing the default 

settings that you most commonly use, you can save a considerable amount of time when creating new 

web forms. Remember that the changes you make in the program options affect every new web form that 

you create from that moment forward. Changes made in the program options do not affect previously 

created web forms. 

 Tip: The following sections describe how to set global options in the software. The 
features mentioned are described in detail in previous chapters in this user’s guide. 
If you need more detail about a particular feature, please go to the proper location 
in this user’s guide by consulting the index. 

Accessing the Program Options  
You can modify settings that control how the software looks and operates. Use the program options to 

perform software customization. Once you input program settings, they remain in place until you change 

them again. 

 

To display the program options  

 Select the Application Button  and then click Web Survey Options. 

The Remark Web Survey Options window appears. Continue to the next sections to learn more about the 

available options. 

Server Details 
The Server details area of the General section 

allows you to set up details related to interaction 

with the Remark Web Survey Server component. 

We strongly recommend that you enter this 

information in the software upon installation. Much 

of the information is needed in the web forms that 

you create. By placing it in the program options, 

your resulting web forms automatically have the 

correct server information. The following options 

can be set: 

 Note: When configuring email options, you can use an SMTP server or the 
Sendmail protocol to send emails from Remark Web Survey. Emails can be used for 
three different functions in Remark Web Survey: 1) the built-in email client that is 
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used to send web form invitations and reminders (SMTP only), 2) submission 
notification emails that are sent every time a web form is completed by a 
respondent, or 3) pause page reminders to resume a web form once it is started 
and stopped. The email server is set up and configured outside of Remark Web 
Survey. Once you have determined the type of email method to use and verified it 
is working, you can configure Remark Web Survey to use it. 

 

Option Function 

Admin script URL The URL (path) to the Remark Web Survey Administration Script 

(rwsad5.pl). This script is posted on the web server and is necessary 

for web form administration. Your webmaster or whoever installed 

the scripts should be able to provide this URL to you. This entry must 

be a fully qualified URL (e.g., http://www.example.com/cgi-

bin/rwsad5.pl). 

Data script URL The URL (path) to the Remark Web Survey Data Script (rws5.pl). This 

script is posted on the web server and is necessary for web form 

data collection. Your webmaster or whoever installed the scripts 

should be able to provide this URL to you. This entry must be a fully 

qualified URL (e.g., http://www.example.com/cgi-bin/rws5.pl). 

Email settings Click the Email settings link to enter email settings for form 

submission notifications and use of the built-in email client. 

Admin email address Enter the web form administrator email address (e.g., 

webmaster@example.com). This email address is provided to 

respondents when they encounter problems submitting a survey. 

Use SMTP method to 

transport email messages 

(Web Server tab) 

The Web Server settings are used to set up email transfers that 

originate on the web server, such as pause page reminder emails 

and respondent submission emails. Mark the Use SMTP method to 

transport email messages option to use Simple Mail Transport 

Protocol for sending notification emails. You need to have a valid 

SMTP server set up outside of Remark Web Survey. 

SMTP Server Enter the SMTP server address (e.g., mail.example.com). 

SMTP Port Enter the SMTP port that email transfers use (typically port 25). 

Username If using authentication, enter a valid username. 

Password If using authentication, enter a valid password for the username 

specified. 

Use Sendmail method to 

transfer email messages (Web 

Server tab) 

Mark the Use Sendmail method to transfer email messages 

option to use Sendmail for sending notification emails. Sendmail 

is an open source email transfer agent. You need to have Sendmail 

set up outside of Remark Web Survey. 
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Option Function 

Server path Enter the Sendmail Server path (e.g., /usr/sbin/sendmail)  

Use SMTP method to 

transport email messages 

(Local Machine tab) 

The Local Machine settings are used to set up email transfers that 

originate from the Remark Web Survey software, such as email 

invitations and reminders. Sendmail is not available for Local 

Machine settings. Mark the Use SMTP method to transport email 

messages option to use Simple Mail Transport Protocol (SMTP) for 

sending notification emails. You need to have a valid SMTP server 

set up outside of Remark Web Survey. Once the SMTP server is 

functioning, the SMTP server information can be set up ahead of 

time in the Remark Web Survey program options by your website 

administrator (see Chapter 2 for further details). Please note that 

your website administrator can advise you on what email method 

you are to use and the proper settings. 

SMTP Server Enter the SMTP server address (e.g., mail.example.com). 

SMTP Port Enter the SMTP port that email transfers use (typically port 25). 

Enable a secured (SSL) 

connection 

Mark the Enable a secured (SSL) connection checkbox to transmit 

information over Secure Sockets Layer (SSL), which provides security 

and data integrity for communications. 

Use the default credentials of 

the currently logged in user 

If you need to use authentication, you can enter credentials or use 

those of the user. Mark the Use the default credentials of the 

currently logged in user checkbox to utilize the user’s credentials 

(e.g., the person logged in when sending the emails from the 

Remark Web Survey Designer component). Otherwise, continue 

below to enter specific credentials. 

Username If using authentication, enter a valid Username. 

Password If using authentication, enter a valid Password for the username 

specified. 

Throttle Rate The Throttle rate adds a delay while sending emails. The default 

setting is 500ms, meaning that one email is sent every 500 ms (in 

other words, two emails are sent per second). Throttling emails 

keeps the SMTP server from being overloaded when sending large 

numbers of emails. 

Timeout This setting allows you to control how long to keep the SMTP 

session open. You should use the default setting (300,000 

milliseconds) unless you receive a timeout error when sending 

emails from within Remark Web Survey. 
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HTML Display 
The HTML display area allows you to set the default Display language to use for web forms. The 

language selected here is specified in the HTML source code of web forms that you create (this is called a 

“lang” tag in HTML). Please note that whether the language’s characters display correctly is dependent 

upon the character set specified on the respondents’ computer. 

The Backup fonts area allows you to select fonts 

to use on the web form when respondents do not 

have the fonts you have selected for a web form 

on their computer. For example, you may apply 

rich text formatting to questions on your web form 

in a font that a respondent does not have on his or 

her computer. If the computer cannot find the font 

you specified, it uses the Backup fonts specified in 

the software’s program options. By default, 

Verdana and Arial are selected; these fonts are 

common to most systems. Using two or more 

fonts provides a greater likelihood of finding a font 

that the respondent has on his or her system, which gives you some level of control over the look and feel 

of your web form. 

New Web Form 

Window 
Remark Web Survey displays a New Web Form 

window by default each time you begin a new web 

form. On the New Web Form window, you can 

specify a web form name, special pages desired, etc. 

(see Chapter 3 for complete details for using the 

New Web Form window). Essentially it creates the 

shell of the web form so that you can then start 

adding other elements. The New Web Form window can be hidden if desired. If you wish to show the New 

Web Form window (it is shown by default), place a checkmark in the Show new web form window when 

creating a new web form checkbox. If you do not use this feature, when beginning new web forms, the 

web form is created with one standard page and a web form complete page by default.  
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Welcome Window 
Remark Web Survey displays a welcome window by 

default each time you start the software. The 

welcome window provides shortcuts to begin a new 

web form, open an existing web form or convert a 

Remark Office OMR or Remark Classic OMR 

template file. The welcome window can be hidden if 

desired. If you wish to show the welcome window (it 

is shown by default), place a checkmark in the Show 

the welcome window at startup checkbox. 

Analyze Database Connections 
Remark Web Survey has a Database Link feature 

that allows you to connect a question to an external 

database in order to look up and add information 

from the database to a web form’s data (see 

Chapter 5 for a description of Database Linking). In 

order to use this feature, the connection to the 

database must remain constant. If the database is 

moved or renamed after the connection is 

established, the feature no longer works. Remark 

Web Survey can automatically check the database 

connection for any web form using this feature each 

time the web form is opened. If the connection is 

broken, a warning message appears and you have 

the option to update the connection. If you wish to have the database connections analyzed (it is on by 

default), place a checkmark in the Analyze database connections when opening web forms checkbox. 
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Include Web Form 

When Publishing 
When you publish a web form to the server, Remark 

Web Survey provides the option to publish the .rwsx 

file to the server. This file is only used in the Designer 

application. However, publishing a copy to the server 

provides you with a backup file in case the one on 

your computer is accidentally lost. We recommend 

having this option set (it is on by default). 

Application Font 
The Application Font button allows you to select 

the type of font used throughout Remark Web 

Survey Designer component windows. Click the 

Application Font button to choose a font for your 

program. This font does not affect the actual web 

forms that are produced. Please note that selecting 

very large sized fonts may adversely affect how text 

is displayed in Remark Web Survey windows. 

Defaults 
The Defaults area allows you to specify default error 

message text for the various errors that can occur 

when respondents are taking a web form. By defining 

default text in the program options, all web forms that 

you create utilize the text. You may still customize an 

individual web form by selecting an element and 

customizing its properties or by customizing a Server 

Error page within a web form. The following error 

messages can be customized: 
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Error Message Purpose 

Invalid Password message Customize the error message that appears when a respondent uses 

an invalid password to access a web form. 

Password expired message Customize the error message that appears when a respondent uses 

an expired password to access a web form. 

Web form unavailable message Customize the error message that appears when a respondent 

attempts to access a web form outside of its availability window.  

Maximum submission capacity 

message 

Customize the error message that appears when a respondent 

attempts to access a web form that has already reached the 

maximum number of submissions. 

File access error message Customize the error message that appears when a respondent tries 

to access web form pages to which they do not have access. 

Required response missing 

message 

Customize the error message that appears when a respondent fails 

to answer a question set with the required attribute. 

Maximum response length 

exceeded message 

Customize the error message that appears when a respondent 

enters too much text in a text area. 

Maximum responses exceeded 

message 

Customize the error message that appears when a respondent 

chooses more responses than are allowed for a checkbox or drop-

down box question. 

Input pattern error Customize the error message that appears when a respondent 

enters text into a textbox that does not match the input pattern you 

have applied to the textbox. 

 

Under Defaults, there are also three miscellaneous items you can customize: 

 

Error Message Purpose 

Maximum grid cell length Use the Maximum grid cell length property to enter the maximum 

amount of characters that can be contained in a single grid cell. 

This setting applies to the Data Viewer grid, branching grid, 

advanced notification grid, login page password criteria builder and 

the grids used to store answer information when setting up 

questions. The default value is 3000. Increase the value if you 

encounter difficulties storing text or executing complex question 

branching. 
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Error Message Purpose 

Missing value Use the Missing value property to change the number associated 

with missing values in your data. Missing values are any data that 

are not valid (e.g., data exists in a cell that does not match what was 

defined for the question, or when a question is unanswered). The 

missing value is used in Remark Quick Stats and when exporting 

data to the SPSS file format. The default missing value is -1, which 

you can adjust to a different number if desired. 

Treat each answer choice as a 

separate question 

Use the Treat each answer choice as a separate question to turn 

on this property by default whenever you create a checkbox or 

drop-down list style question that allows multiple responses. Each 

answer choice is treated as a unique question, occupying its own 

cell in the Data Viewer grid. You may still change the property on 

the fly for certain questions as you build web forms. 

Spell Checker 
The Spell Checker area allows you to specify spell checker options. Under Dictionary Files, you can select 

the location where your dictionaries are found. There is a Main dictionary and a Custom dictionary. 

Remark Web Survey first uses the main dictionary and then as you add custom spellings it creates the 

custom dictionary. When performing spell check 

functions, the software uses both dictionaries unless 

you mark the checkbox titled Suggest from main 

dictionary only. In the Language box, you can 

select the language for your spell check dictionary 

files. The When correcting spelling area allows 

you to select the options you wish the spell checker 

to use: Ignore words in UPPERCASE, Ignore 

words that contain numbers, Ignore internet and 

file addresses, Check compound words, Check 

hyphenated words, Suggest from main 

dictionary only. These options can help you 

customize how the spell checker reviews your web 

forms. 
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Resources 
The Resources area allows you to reach Gravic, Inc. 

online and view information about the software. 

The following options are available:  

 

 

 

Option Description 

Go to Gravic Online Click the Go Online button to go to the Gravic website, where you 

can find product and support information.  

Edit Remark Web Survey 

Authentication 

Click the Edit Authentication button to enter a new serial number 

and authentication code for the software. This feature is typically used 

to upgrade to a new version of the software or unlock features. It 

should only be used when directed by Gravic personnel. 

Copyrights Click the Copyrights button to view copyright and legal information 

pertaining to Remark Web Survey. 

About Remark Web Survey Click the About button to view information about Remark Web 

Survey. This area also shows the current version level of the software. 

Documentation 
The Documentation area gives you quick access to 

Remark Web Survey’s supporting documentation. 

You can access the Remark Web Survey User’s 

Guide, Remark Quick Stats User’s Guide and the 

Remark Web Survey Tutorial by clicking the 

appropriate link in this window. Please note that 

documentation is in PDF format; you need a PDF 

reader in order to use these links. 
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Appendix A: Remark Office 

OMR/Remark Classic OMR 

Overview 
Remark Web Survey can be used as a standalone web form tool or in conjunction with Remark Office 

OMR and Remark Classic OMR. Remark Office OMR and Remark Classic OMR are forms processing 

applications that collect information from paper-based forms and convert it to data that can be analyzed 

within the software or exported to another program for analysis. These software packages use template 

files that define the areas of a paper form to be recognized and the output to be generated. The software 

then uses a scanner to collect the data from the forms. Once the data are collected, Remark Office OMR 

and Remark Classic OMR are used to tabulate or grade the data, or the data can be saved in a format 

compatible with virtually any spreadsheet, database or survey design package for further analysis.  

The following chapter is designed to help Remark Office OMR and Remark Classic OMR users understand 

how Remark Web Survey can interact with their existing Remark Office OMR or Remark Classic OMR 

software. Topics that are covered include: 

 Converting Remark Office OMR and Remark Classic OMR templates into Remark Web Survey 

documents. 

 Combining data collected in Remark Web Survey with data collected in Remark Office OMR and 

Remark Classic OMR for analysis. 

Converting Templates 
Existing Remark Office OMR (version 7 and higher) and Remark Classic OMR (version 3 and higher) 

templates can be converted into web-based forms for publishing on a web server. The benefit of 

converting a template to a web form is that you can collect the same data as on the paper-based form 

over the web. In other words, you have two different mechanisms for collecting the same data. When a 

template is converted, the original template can still be used in Remark Office OMR or Remark Classic 

OMR. The data collected in Remark Web Survey can then be combined with data gathered in Remark 

Office OMR or Remark Classic OMR for complete analysis. It is recommended that the templates you 

convert make use of question text. This question text becomes the question text in your web form. If there 

is no question text in the template that is converted, you need to enter it in the web form. 

 

To convert a template 

 Open Remark Web Survey. 

 Select the Application Button and then click Convert to display the Open window.  
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 Note: When you first start Remark Web 
Survey, if you are showing the Welcome 
dialog, you may choose the option on this 
screen for Convert a Remark Office or 
Classic Template to open a template file. 

 Select a Remark Office OMR (.omr) or Remark 

Classic OMR (.rco) template and then click the 

Open button. 

The template is displayed as a Remark Web Survey web 

form. You may now modify the look of the web form as 

desired. If you plan to combine web data with data 

collected from the paper forms, do not change the structure 

of the form (e.g., add questions, remove questions, reorder questions, etc.). If the web form does not 

match the paper form’s template, the data will not match.  

When converting templates, the web form name is based on the template name. The Admin and Data 

Script URLs are entered on the web form properties based on those entries in the Remark Web Survey 

program options (see Chapter 12 for more information).  

 Caution: When modifying converted templates, adding or deleting questions will 
result in importing data problems when combining the data with data from Remark 
Office OMR or Remark Classic OMR. The data collected in Remark Web Survey will 
not match the data that were collected in the other packages. If you plan to use the 
data from both programs together, only make basic formatting modifications to 
the converted web survey. 

Data Collection and Analysis 
The Remark Web Survey Server component is used to collect data from web forms. For forms that have 

been converted from Remark Office OMR or Remark Classic OMR templates, the data collected in Remark 

Web Survey can be combined with data that was collected in the paper scanning Remark software.  

Remark Quick Stats is essentially the same in all of the Remark products. Therefore, you can combine data 

collected from the various Remark products in any one of those products. For the purposes of this user’s 

guide, we outline how to analyze the data in Remark Web Survey. 

Once the data has been collected in both programs, you may open it in Remark Web Survey. We 

recommend saving data to the Remark (.rmk) format in both programs to ensure compatibility. Note that 

this format saves the data in the order in which the fields (questions) are defined. If you remove, add or 

rearrange questions, it causes incompatibility in your data sets. 

 

To tabulate or grade data from both programs  

 If not already running, start Remark Web Survey. 

 Open the desired web form.   

 Switch to the Data Viewer and open the data file that was saved in Remark Web Survey. Or, 

download the data from your web server. 
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 Open the data file(s) that was saved previously in Remark Office OMR or Remark Classic OMR. A 

second grid opens. (Note: You may also choose to append it to the existing data grid when 

prompted.) 

 Select the Tools tab in the Ribbon and then choose the desired operation: Advanced Survey or 

Advanced Grade. Alternatively, if you chose to combine your data sets into one when the prompt 

appeared to append, you can use Easy Survey or Easy Grade. 

 In the Analyze Data window, mark the checkboxes for any open data grids that you wish to 

include in the operation. 

 Click the OK button to run the report. 

Depending on the analysis function chosen, either the Grade or Survey Wizard appears. See the Remark 

Quick Stats User’s Guide PDF file, located in Start|Programs|Remark Web Survey 5|Documentation, for 

further information about using Remark Quick Stats. 

Special Note for “Other” Textboxes 
If you have questions in your Remark Office OMR or Remark Classic OMR template that have textboxes 

appended to them, you need to append a textbox in Remark Web Survey to accommodate the textbox. 

When using the appended textbox, be sure to mark the checkbox for Treat appended item’s answer as 

a separate item with field name. For example, if you have a multiple choice style question with the last 

option as “other” you may have a textbox where they can enter information in as their “other” response. In 

Remark Office OMR and Remark Classic OMR, you would have two separate regions/fields. Remark Web 

Survey, on the other hand, offers the appended textbox to handle this situation. With the appended 

textbox, you have the choice of outputting the write-in responses in the same data cell as the multiple-

choice responses or treating them as separate items. If you do not use the option to treat the appended 

textbox as a separate item, it is considered one field and your data would not match that which was 

collected in Remark Office OMR or Remark Classic OMR. If using this type of field setup, use the 

appended textbox for the “other” textbox in Remark Web Survey but remember to mark Treat appended 

item’s answer as a separate item with field name. This method gives you two fields in Remark Web 

Survey to match the two fields you have defined in Remark Office OMR or Remark Classic OMR. 
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Appendix B: Extended 

Glossary/Feature List 
Remark Web Survey is rich with features; some of which you may use often and some that you may only 

need on occasion. The purpose of this extended glossary is to provide you with a listing of the software’s 

features, a short description of the feature and the chapter where you can find more detailed information 

about the feature. For a complete listing of terms, please see the Glossary or Index. 

 

Feature Explanation 

Admin Control Panel 

Access 

The Admin Control Panel Access bar allows you to login to the 

administration script (rwsad5.pl) and publish web forms and 

download data. Details are found in Chapter 3. 

Answer Piping Answer piping allows you to “pipe” information from one question’s 

answer to the text of another question, answer or a label on a web 

form. For example, if you have a question on the web form that asks 

for the respondent’s name, you can then “pipe” that name into 

another question. Details are found in Chapter 5.  

Auto Downloading 

Data 

Auto data download allows you to download data from the web 

server without the assistance of a website administrator. You must 

first enable auto data downloads in the Remark Web Survey Control 

Panel (auto data downloads are enabled by default) and have a 

login that allows for data downloading. Then, you may open the 

web form in the Remark Web Survey designer, click the 

Application Button and then select Download. You are prompted 

to log in to your web server and then the data are automatically 

downloaded into the Data Viewer. If you use the Download button 

in the Admin Control Panel Access bar, you may choose to 

download all records or only download the new records since the 

last download. Data can then be exported or analyzed by Remark 

Quick Stats. Details are found in Chapter 10. 
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Feature Explanation 

Auto Form Publishing Auto form publishing allows you to publish forms and related files 

(e.g., images) to your web server without the assistance of a website 

administrator. You must first enable auto publishing in the Remark 

Web Survey Control Panel, (auto publishing is enabled by default) 

and set up a user account that allows automatic form publishing. 

You must also enter the address of the administration script 

(rwsad5.pl) in the program options (click the Application Button 

and then choose Web Survey Options). As each web form is 

created, you then select the Application Button and click Publish 

to send the form to the web server. Each web form has its own 

folder on the web server, which contains the form pages, images, 

data file, log file, configuration files, password information (if 

applicable) and each respondent’s tracking ID. You can specify the 

location to store these individual folders in the Remark Web Survey 

Control Panel. Details are found in Chapter 9. 

Branching/Skip 

Patterns 

Branching, also known as skip patterns, allows you to set up a form 

that jumps to various pages based on a how a question or 

questions are answered. For example, responding with a Yes to a 

question can send the respondent to one page. Responding with a 

No to the same question, can send the respondent to a different 

page. This type of setup makes it easier for the respondent to fill 

out a web form because he or she does not have to answer 

unnecessary questions. Details in Chapter 8. 

Button Text and 

Images 

The buttons used on a page- Submit, Reset, Back and Pause- can 

be customized. You can either enter your own text for the button, 

or you can import an image to use as the button. If you want to use 

an image, you must first create the image outside of Remark Web 

Survey. You can also customize the positioning (right, center or left) 

and order of these buttons on the page. Details are found in 

Chapter 5. 

Database Link Database Link allows you to link a question on a web form to an 

external database. You can then lookup one piece of information 

and report another piece of information from the same database. 

For example, suppose you have a database of student names and 

ID numbers. The students could enter their student ID numbers on 

the web form they submit. You could then lookup that student ID 

number and output the student’s name (in addition to the ID 

number) when the data are downloaded. Details are found in 

Chapter 5. 
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Feature Explanation 

Data Export Once form submissions are downloaded from the web server, the 

resulting data file can be exported to most common file formats, 

including Access, Excel, SPSS, ASCII and others. This feature allows 

you to analyze your data in most popular analysis packages. Details 

are found in Chapter 10. 

Email Client Remark Web Survey includes an email client that you can use to 

send web form invitations and reminders. It includes the ability to 

create and save email templates and the ability to import email 

addresses.  The email client can work in conjunction with the 

Respondent ID feature, which tracks who has completed a web 

form (password-protected web forms only). Details are found in 

Chapter 9. 

Email Notifications Email notification allows you to specify an email address or 

addresses to which each form submission is sent. The email 

recipient receives one email per respondent, which contains that 

respondent’s answers to the questions on the web form. You can 

also set up advanced options that allow you to send emails to the 

respondent or emails to specific email addresses based on how 

questions are answered. Details are found in Chapter 4. 

Form Scheduling  

 

You can schedule a window when a web form is active. 

Respondents are only able to access the web form during this 

timeframe. Details are found in Chapter 4. 

Headers and Footers You can add headers and footers to web form pages. Define the 

header and footer once, and then apply them to the desired web 

pages. Details are found in Chapter 5. 
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Feature Explanation 

Links- Providing Web 

Form Access 

For each web form that you create in Remark Web 

Survey, you must provide your respondents with a link that they can 

use to access the form. You may wish to send respondents an email 

message with the link, or perhaps you will put the link on your 

website for them to click. In either case, the link you provide has a 

very specific format: http://www.example.com/CGI 

directory/rws5.pl?FORM=formname. In this example, CGI directory 

is the name of your CGI directory (e.g., cgi-bin, scripts), rws5.pl is 

the name of the Remark Web Survey data collection script and 

formname is the name of the web form to be submitted (the form 

name can be found on the top node of your web form in Remark 

Web Survey). If you use the auto publish feature to move web 

forms to your website, this link is provided to you automatically 

upon successful publishing. You can copy any web form’s link by 

selecting Copy Web Form URL to clipboard in the Web Form 

Details area of the Remark Web Survey designer. This action places 

the link on the Windows clipboard, which you may then paste to an 

email, web page, web browser, etc. Details are found in Chapter 9. 

Links- Embedded 

Passwords 

In addition to the information above, you may also embed the 

password to access the web form in the link you provide to a 

respondent. In this case, use the same syntax as above, but add the 

following to the end of the link: &PWD=password, where 

“password” is the respondent’s password. Example: 

http://www.example.com/cgi-

bin/rws5.pl?FORM=formname&PWD=password. When the 

respondent clicks the link, they are automatically logged into the 

web form. Passwords can also be embedded into the link that is 

generated by the built-in email client. Details are found in Chapter 

9. 

Mobile Device Support Allows you to preview a web form on a mobile device so that you 

can ensure browser compatibility. The mobile device must have a 

web browser capable of viewing and submitting web forms. Details 

are found in Chapter 3. 
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Feature Explanation 

Multimedia Multimedia includes video and audio files that you wish 

respondents to view while submitting your web form. For example, 

suppose you are conducting a survey about a possible new product 

and want to show respondents a potential advertisement for the 

new product and then ask questions about it. Respondents can play 

the video clip (or audio clip) directly from the web form. Supported 

multimedia formats include: Moving Picture Experts Group (mpeg, 

mpg, mp3), Audio Video Interleave (avi), QuickTime (mov), 

Waveform (wav), Real Audio (ram, rm). Details are found in Chapter 

5. 

Password Protection Password protection allows you to require respondents to enter a 

valid password before they can access your web form. Applying 

passwords to a web form is accomplished using a Login page. 

Passwords can be manually entered into Remark Web Survey or 

they can be imported from a database. You may also use the 

password list to include names and email addresses to track which 

respondents have submitted a web form. Missing or detected 

respondents can be sent to the built-in email client or exported to a 

file, which you could then use to contact those respondents via 

email (e.g., to send reminders or thank you notices). Details are 

found in Chapter 4. 

Popup Info Page A Popup Info page type can be used to display non-submission 

information. You can link to the popup info page to show 

respondents more information about the web form’s questions. 

Details are found in Chapter 4. 

Progress Bars A progress bar shows respondents how much progress they have 

made on a multi-page web form and how much is still left to fill 

out. Details are found in Chapter 4.  

Query Parameters Using Query Parameters allows you to pass hidden information into 

a web form. When using hidden textbox questions, you can 

associate a Query Parameter with the textbox. When the URL to the 

web form is sent out, the Query Parameter is appended to the URL. 

When the web form is submitted, the value for the Query Parameter 

is sent down to the data file. Details are found in Chapter 5. 

Random Answer Order Random answer order allows you to present the answers to 

questions in random order. Each respondent sees the answers in a 

different order (on a per question basis). This feature is especially 

useful when administering tests to cut down on the possibility of 

cheating or to eliminate survey bias. Details are found in Chapter 5. 
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Feature Explanation 

Random Page Order Random page order allows you to present a multi-page web form 

in random order. Each respondent  sees the pages in a different 

order. This feature is especially useful when administering tests to 

cut down on the possibility of cheating or to eliminate survey bias. 

Details are found in Chapter 8. 

Reloading Pages Remark Web Survey allows you to use forward and back options on 

web forms. You can add a Back button to multi-page forms so that 

respondents can go back and change their responses. Respondents 

should not use the browser’s back button, as this can cause page 

sequencing errors. It is a good practice to place Back buttons on 

multi-page forms and advise respondents to use the web form’s 

back and next buttons instead of the browser’s buttons. Details are 

found in Chapter 5. 

Response 

Confirmation Pages 

A Response Confirmation page displays all of the respondent’s 

answers to each question on the web form. The Response 

Confirmation page appears as the last page before the respondent 

submits the web form. It allows the respondent to review his or her 

responses and then go back and make changes if necessary. You 

can either provide a Back button on the Response Confirmation 

page or respondents can click a link next to any question on the 

Response Confirmation page to navigate back to questions they 

wish to change. Details are found in Chapter 4. 

Respondent Capping  You can cap the number of respondents who can access a web 

form. Once the maximum is reached, respondents are no longer be 

able to access the web form. Details are found in Chapter 4. 

Respondent Detection Respondent detection works in conjunction with password 

protection. When you enter a list of valid passwords for a 

password-protected web form, you can optionally designate a 

name field and an email field. When you download the data for the 

form, Remark Web Survey can search through the passwords that 

were submitted to see who has and has not filled out the web form. 

The names and email addresses of those who have either filled out 

or not filled out the web form can then be sent to the built-in email 

client or exported to a file. You can then use this file to send email 

notifications to those who have not yet submitted the form 

reminding them to do so. Details are found in Chapter 10. 
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Feature Explanation 

Rich Text Formatting Rich text formatting gives you greater flexibility in how text is 

formatted. Rich text allows you to format the font attributes of 

individual characters as opposed to an entire label or question’s 

text. It also allows you to add bullets to your text. Details are found 

in Chapter 7. 

Section 508 

Compliance 

Remark Web Survey can produce Section 508 compliant forms. 

Section 508 of the Rehabilitation Act of 1973, as amended (29 

U.S.C. 794d), requires that when Federal agencies develop, procure, 

maintain or use electronic and information technology, Federal 

employees with disabilities must have access to and use of 

information and data that is comparable to the access and use by 

Federal employees who are not individuals with disabilities, unless 

an undue burden would be imposed on the agency. Section 508 

also requires that individuals with disabilities who are members of 

the public seeking information or services from a Federal agency 

have access to and use of information and data that is comparable 

to that provided to the public who are not individuals with 

disabilities, unless an undue burden would be imposed on the 

agency. When creating web forms, Section 508 requires the use of 

ALT tags for images in order to be compliant. Remark Web Survey 

supports this ALT tag usage through a property called Alternate 

Text, which you see any time you insert an image. The use of style 

sheets also assists with the creation of Section 508 compliant forms. 

Sendmail Support Remark Web Survey supports the Sendmail email method, which is 

an open source mail transfer agent. Details are found in Chapter 2. 

Session Pause Pages Session Pause pages allow respondents to pause a web form and 

then resume where they left off. Session Pause pages are especially 

useful for long web forms where respondents may not have enough 

time in one sitting to complete the web form. When respondents 

pause the form, they can either receive an email message with a link 

back to the web form or bookmark the page in a web browser. They 

can then continue the form submission at a later date. When they 

resume their submission, they are at the same place they left off, 

with all previous information already filled in. You can also set the 

length of time allowed to complete the web form. Note that you 

should advise respondents of this timeframe when you set up your 

Session Pause page. Details are found in Chapter 4. 
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Feature Explanation 

Session Timeouts Session timeouts can be used in conjunction with password-

protected web forms. If you enable session timeouts, the 

respondent is logged out of the web form if idle for a specified 

amount of time. Session timeouts coincide with page submissions. 

If a session timeout is set to 10 minutes, the respondent has 10 

minutes in between page submissions to complete the page. For 

example, if the respondent submits page 1 of the web form and 10 

minutes go by without submitting page 2, the respondent’s web 

form times out. They are required to log in again, at which time 

their previously submitted data is reloaded. The purpose of a 

session timeout is to minimize the possibility of an unauthorized 

person gaining access to the web form. Details are found in Chapter 

4. 

SMTP Authentication  Remark Web Survey supports the MD5, login and plain forms of 

SMTP authentication. Details are found in Chapter 4. 

Spell Checker The Spell Checker allows you to check an entire web form for 

spelling errors. Dictionaries can be customized by language and 

you can add your own words to the existing dictionary. Details are 

found in Chapter 6. 

Styles Styles allow you to add aesthetic formatting to your web forms. You 

can create styles any way you wish. When you create a style, you set 

font types, sizes and colors, background colors, line colors, question 

table formatting and more. You can set these attributes for all of 

the elements on your forms (text labels, questions, answers, etc.). 

Using styles helps you match web forms to the general format of 

your website. By saving styles, you can quickly apply commonly 

used formatting to web forms. Details are found in Chapter 7. 

Web Form Complete 

Pages  

A Web Form Complete page is a success URL or “thank you” page 

that appears when a respondent submits a web form. It lets 

respondents know that they have finished filling out the web form. 

The web form complete page can contain images and labels. You 

can also add hyperlinks to redirect the respondent to another page 

on your website or a new website. Details are found in Chapter 4. 

Web Server  A computer that maintains web information and returns requested 

files or documents to web browsers. You must have access to a web 

server to use Remark Web Survey. The web server holds the Remark 

Web Survey scripts, which are used for web form administration.  
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